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1 Introduction 

Thank you for choosing Netavis Observer 5.1 as the management software for your video monitoring 
system. As you use it, you will find that Observer not only enables you to view live images and record 
them, but also provides a full-scale platform for the intelligent utilization of your video data. 

This User Manual guides you through the functionality of Netavis Observer 5.1. 

If you have questions that are not answered in the Observer documentation set, please contact your 

Netavis partner, or else get in touch with us via the usual channels. 

We wish you a great experience with Netavis Observer 5.1. 

Your Netavis Team. 

1.1 The Observer documentation set 

These documents are available: 

• Netavis Observer User Manual: It describes how to configure and use the Observer client. 

• Netavis Observer Supported Video Sources: It provides detailed information on the IP camera 
models supported by Observer. 

• Netavis Observer Server Installation and Administration: It describes how to install and manage 

an Observer system. 

• Netavis Observer Server, Client and Storage Compatibility and Requirements: It explains the 

hardware and software requirements for Observer systems. 

• Netavis Observer Server Customizing: It provides an overview on how to customize various 

aspects of an Observer server. 

• Netavis Observer SNAP XML Interface: It describes the Simple Netavis Access Protocol (SNAP) 
that allows bidirectional communication between an Observer server and third party 

applications. 

• Netavis Observer SNAP URL: It describes the SNAP URL API which is a simple and effective way 

for Observer to interface with third party applications. 

These documents are available online as PDFs directly on each Observer server via the standard web 

interface and also from each client via the Help - All Documentation menu. 

1.2 What is new with this release 

The changes of a release are documented in the Release Notes, which you can find on the standard 

web interface of each Observer server and also under the following direct link: 

http://<your-server>/relnotes 

or on the public demo server 

showroom.netavis.net/relnotes 

There you also find the release information of previous releases. 

https://showroom.netavis.net/relnotes
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Additionally, the new features of releases are also documented on www.netavis.net. 

1.3 Observer data security 

Observer has been designed to provide the highest level of robustness and data security. The following 

aspects of the Observer system document that: 

• All video and configuration data on an Observer server are stored in separate file system 

partitions, protected by multiple levels of security. 

• Optionally the video data can be stored using 128 bit AES encryption (since Observer 4.0) 

• Optionally HTTPS can be used for streaming video data between cameras and servers (since 

Observer 4.0). 

• Optionally HTTPS can be used for streaming video data between server and clients (since 
Observer 4.2). 

• In any case, the authentication data (user names and passwords) transferred between clients 

and servers are encrypted by MD5 strong encryption. 

Please note: Encryption and decryption can mean higher CPU overhead at the server and/or the 
client. Also doing something with the contents of an encrypted stream means decryption and 

therefore higher CPU overhead. For example, doing video analytics with an encrypted video stream 
means that is has to be decrypted at the server before processing. Likewise, storing an unencrypted 

stream in an encrypted video database means that it has to be encrypted at the server before storing. 
Likewise, displaying an encrypted video stream at the client means more CPU overhead at the client 

because it has to be decrypted. 
On the other hand, simply storing an already encrypted video stream coming from the camera does 
not need more CPU at the server than storing an unencrypted video stream. 

1.4 Video streaming methods and compression 

Observer supports video streaming in several standards: 

• Motion JPEG (often also referred to as MJPEG) 

• MPEG-4 streaming 

• H.264 streaming (also known as MPEG-4/AVC) 

• H.265 streaming (also known as HEVC) 

• MxPEG streaming (this is a streaming standard specially developed by www.mobotix.com for 

their IP cameras) 

The big difference between the various streaming methods is the way how the image data are 
compressed and transferred. The selected streaming method has great influence on: 

• the bandwidth needed for transmission between cameras and server but also between servers 

and clients, 

• the CPU load at the server and the client induced by compression and decompression, and 

• the storage requirements for recording 

For low-bandwidth client-server connections Observer offers the unique Transcoding feature (see 2.6 
Observer Transcoding for low-bandwidth client-server connections (ABS) on page 27). 

https://www.netavis.net/
http://www.mobotix.com/
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1.4.1 Multi streaming (multiple parallel video streams from the camera) 

Some cameras are capable of providing multiple parallel video streams to Observer. This can be 

helpful, for example, when online viewing and recording is to be done in different formats (e.g. 
different sizes and frame rates) or for optimizing iCat video analytics performance (see 15.2.1 
Considerations for setting up a system with iCat on page 144). 

Usually MJPEG cameras can deliver several MJPEG streams while MPEG cameras (MPEG-4, H.264, 
H.265, and MxPEG) usually can deliver only 1 or 2 MPEG streams and some camera types can deliver 
several MJPEG streams in addition to the MPEG stream(s). 

However there are a few important restrictions with multi streaming: 

• Some cameras have performance limitations in providing multiple streams depending on the 
streaming format, resolution, and frame rate. We found out that some cameras just stop 

streaming when the streaming processors of the camera get overloaded by certain resolution 

and frame rates settings. Please refer to the camera data sheet and documentation. 

• In the current version Observer supports 1 format setting for MPEG streams (MPEG-4, H.264, 

H.265, and MxPEG) and multiple format settings for MJPEG streams. 

Please note: Please refer to camera data sheet and documentation for camera limitations. Also the 
document Netavis Observer Supported Video Sources may provide further details on camera 
restrictions. 

1.4.2 Motion JPEG 

A network camera captures individual images and compresses them into a JPEG format. The network 

camera can capture and compress, for example, 30 such individual images per second (30 fps), and 
then make them available as a continuous flow of images over a network to an Observer server which 

then distributes it to Observer clients and / or stores it in the camera archive. At a frame rate of about 

16 fps and above, the viewer will perceive full motion video. 

As each individual image is a complete JPEG compressed image, they will all have the same 

guaranteed quality, determined by the compression level as defined for the network camera or 
network video server. 

Example of a sequence of three complete JPEG images: 

 

1.4.3 MPEG (MPEG-4, H.264, H.265, and MxPEG) 

Some of the best-known audio and video streaming techniques are defined by the so called MPEG 

consortium (Moving Pictures Expert Group). Under the MPEG umbrella several streaming methods are 
available like MPEG-4, H.264, H.265, and MxPEG (strictly taken, MxPEG is not part of the standards 

defined by the MPEG group but is a proprietary standard by the company Mobotix. However, because 
of reasons of simplicity we refer to MxPEG also as an MPEG format). MPEG-4 and H.264 are well known 
and widely supported MPEG streaming standards. 

Simply described, MPEG’s basic principle is to compare two compressed images to be transmitted 
over the network, and using the first compressed image as a reference image (called an I-frame), only 
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sending the parts of following images (B- and P-frames) that differ from the reference image. A viewing 

client will then reconstruct all images based on the reference image and the “difference data”. 

At the cost of higher complexity, the result of applying MPEG video compression is that the amount of 
data transmitted across the network is less than that of Motion JPEG. This is illustrated below where 
only information about the differences in the second and third frames is transmitted 

 

H.264 and MxPEG all work very similar to MPEG-4 whereby H.264, for example, needs only about 60% 
of the bandwidth of MPEG-4 for roughly the same video quality. However, this efficiency does not 
come for free. Encoding and decoding H.264 needs more CPU power than MPEG-4. A general rule is 

that the higher the compression factor the heavier the CPU burden (in the server and in the clients). 
Therefore there is always a tradeoff between bandwidth utilization and CPU power needed. 

1.4.4 Advantages and disadvantages of Motion JPEG and MPEG (MPEG-4, H.264, H.265, and 
MxPEG) 

Due to its simplicity, Motion JPEG (MJPEG) is a good choice for use in many applications. JPEG is a 
widely available standard in many systems often by default. It is a simple compression/decompression 

technique, which means the cost, in both system time and money, for encoding and decoding is kept 
low. The time aspect means that there is limited delay between image capturing in a camera, 
encoding, transferring over the network, decoding, and finally displaying at the viewing station. In 

other words, MJPEG provides low latency due to its simplicity (image compression and complete 

individual images), and for this reason it is also well suited for when image processing is to be 

performed, for example video motion detection or object tracking. 

MJPEG gives a guaranteed image quality regardless of movement or complexity of the image scenes. It 

still offers the flexibility to select either high image quality (low compression) or lower image quality 
(high compression) with the benefit of lower image file sizes, thus lower bit-rate and bandwidth usage. 
At the same time the frame rate can be easily controlled, providing a means to limit bandwidth usage 

by reducing the frame rate, but still with a guaranteed image quality. 

Since MJPEG does not make use of a video compression technique, it generates a relatively large 

amount of image data that is sent across the network. For this reason, at a given image compression 
level (defining the image quality of the I-frame and JPEG image respectively), the network bandwidth 
is less for MPEG compared to MJPEG, except at very low frame rates. 

Another difference is that most MJPEG IP cameras can produce multiple simultaneous streams and in 
different qualities (image sizes and compression quality) while most MPEG cameras can produce only 

one stream in one quality. Therefore the same stream will be used in live viewing and recording. 

This summarizes the benefit of MPEG: the ability to give a relatively high image quality at a lower bit-

rate (bandwidth usage). This can be especially important if the available network bandwidth is limited, 

or if video is to be stored (recorded) at a high frame rate and there are storage space restraints. The 
lower bandwidth demands come at the cost of higher complexity in encoding and decoding, which in 
turn contributes to a higher latency when compared to MJPEG. 

The graph below shows in principle how bandwidth use between MJPEG and MPEG compares at a 
given image scene with motion. As can be seen, at very low frame rates, where MPEG compression 

cannot make use of similarities between neighboring frames to a high degree, and due to the 
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overhead generated by the MPEG streaming format, the bandwidth consumption is actually higher 

than MJPEG. 

 

1.4.5 JPEG image sizes and storage requirements 

The image (recording) quality and image size affects the required storage per image (frame). Likewise 
does the frame rate impact the recording storage and also the network bandwidth. 

Observer supports all image sizes that a camera offers. The following are some values for typical 
JPEG images:  

 

JPEG Image size Image quality Storage per image 

approximately 

Small 

176x144 QCIF PAL 
176x120 QCIF NTSC 
160x120 QQVGA 

Low 3 KB 

Medium 5 KB 

High 8 KB 

Medium 
352x288 CIF PAL 

352x240 CIF NTSC  
320x240 QVGA 

Low 8 KB 

Medium 13 KB 

High 20 KB 

Large* 

704x576 4CIF PAL 
704x480 4CIF NTSC 
640x480 VGA 

Low 20 KB 

Medium 34 KB 

High 52 KB 

 

* For mega-pixel cameras the image size will be much bigger than shown in the table. 



Netavis Observer 5.1 User Manual (February 2021) 

Page 11 of 214 

2 Observer clients on multiple platforms 

2.1 Introduction to Observer clients 

Once you have successfully installed Observer on your server, authorized users can access the server 
via an Observer client. 

Normally the Observer client runs on a PC separate from the server, however in a client-on-server 
installation the client runs directly on the server (see the document Netavis Observer Server Installation 
and Administration for further information on how to create and run a client-on-server installation). 

Clients for various platforms 

You can choose among these Observer clients, operating systems and platforms: 

 

Observer client OS and platform Supported functionality 

Locally installed desktop client Microsoft Windows 10 All 

Linux, Unix (also client on server 
CoS) 

No audio, Layout Navigation, and 
PTZ-Joysticks 

Mobile Client many smartphone platforms and 
OSes 

Live viewing and archive 
playback 

 

Note: The Mac OS X operating system hasn’t been supported since Observer 4.0. 

Please be aware that some functions like Layout Navigation and running SAFE export files are only 

available on the MS Windows platform. 

This chapter describes how to start the Observer client on a desktop PC. If you want to run Observer on 
a mobile device please refer to 2.5 Mobile Observer clients on page 21. 

The minimum screen resolution for running the Observer client is 1024x768 pixels. 

Licensing issues 

The available functionality of your Observer installation is defined by the license file. The document 
Netavis Observer Server Installation and Administration describes how licensing works and how to 

obtain a license string. If you have a temporary demo license, a License dialog appears at every login 

indicating that there is no permanent license. At this dialog just press the Continue button to operate 
Observer in the demo mode. 

See 11.1 Server system information and restarting on page 107 for how to display the current license of 

your server. 
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2.1.1 Advanced client technology 

The Observer uses advanced technologies to ease the operation of clients on MS Windows platforms: 

• Lazy-loading client technology: Observer clients (both browser-based and locally installed) 
only load the needed application components from the server on demand, when they are 

needed. This saves time at startup and also bandwidth. It also eases the management and 
upgrading of clients. Libraries for one version are downloaded only once and are then stored 
locally on the client machine. The path is <user’s home directory>\netavisLibs\<version> (e.g. 
C:\Documents and Settings\user\netavisLibs\4.4.5.158.634). 

• Automatic client upgrading: Whenever the Observer server is upgraded to a new version, the 
clients are automatically upgraded too. This is happening transparently to the user. The same 
client will still be able to work with older server versions (see next point). Since release 1.9 the 
client application has to be installed only once and every further Observer version will be 
seamlessly accessible, without having to manually upgrade the client. 

• Different versions between servers and clients: Since release 1.9 Observer clients can 

connect to servers running different versions (release 1.9 or newer) without the need to install 

clients matching the servers’ versions. 

As a summary, Observer clients... 

• …download libraries (for one version) only once 

• …share the same libraries for both browser-based (applet) and installed client application 

• …can connect to servers having different versions 

• …automatically upgrade themselves when the server has a new version 

2.2 Working with the installed Observer client 

The most common way to use the Netavis Observer client is to install it locally on your machine. Some 
functions are only available in the installed client (see 2.1 Introduction to Observer clients on page 11 

for details). 

2.2.1 Installing the Observer client 

To install the client locally on your PC, please follow these steps: 

1. On the Observer Start page click on the link Download Observer client installer (Windows 

only). 

2. Save the client installer executable at an arbitrary location. 

3. Execute the just downloaded client installer (setup.exe). 

4. Follow the steps of the setup program (standard Windows installation). 

2.2.2 Starting the installed Observer client 

Once the setup finished you can start the client locally from your Windows Start menu (or also from a 
desktop icon if you selected so at installation). The Starter window appears: 
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Working with sessions 

The Starter allows you to manage sessions. In a session you can define the server address, which 

Observer application to start and the user/password details. Thus, you can store and run different 
sessions easily. 

The Session editor is opened when you press Add new or Modify and allows you to define the 
session details: 

 

Element Description 

Session name Name under which the session is stored. 

Application You can either choose Observer Client or Layout Navigation 

Tool (for further details on the Layout Navigation Tool please refer 
to 14 Working with Layout Navigation on page 128). The selected 

application will start when you press OK. 

Previous Connections Offers you the list of previously active sessions. 

Hostname or IP address Enter the name or IP address of the server you want to connect to. 

Use secure connection Select this checkbox if you want to use an encrypted connection 
between the client and the server (TLS HTTPS). 

Please be aware that an encrypted connection needs more CPU 

resources on the server and on the client. See also 1.3 Observer data 

security on page 7. 

Username Enter the login name of the user. 

Password Enter the password for the user. 

Remember password Select the checkbox if you want the password to be remembered 

for the next start of the application. 

Alternative Session Here you can select another session out of the already defined 
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Element Description 

session that should be started automatically when the server of this 
session is not accessible. 

Show message if 
alternative session started 

Select this checkbox if a message should be shown when the 
alternative session is started. 

Download client without 

asking 
Select this checkbox if you want updated versions of the client to be 
downloaded automatically. 

Note: Enabling this option is particularly recommended for systems 
without a mouse and keyboard. 

Reconnect count 
Here you can set how many times the client will try to reconnect to 

a server which it has lost its connection to. 

Note: This does not handle situations in which no connection is 

available upon the initial start of the client. 

 

Starting the Observer client 

Pressing Start in the Starter will open the client window and connect you to the Observer server. 
When the client is started, the Starter window will be hidden and in the task bar you will see its icon. 

You can access the Starter by clicking its icon. There you can open the Starter dialog again and also 

force an exit of the client application. 

 

When you start the client the first time after a new installation some additional client application 
components need to be installed (this is needed only once per client). You will be asked: 

 

Normally you want choose to install the program components from Server over network. However, 
if you have a very slow network connection between the client and the server you might want to 
choose installation from Local media. When you choose this option you will be asked to locate the 

directory ClientInstaller of the Observer installation CD. Once you choose the correct location and 
push OK, the components will be installed. 

Note: If you enable the Download client without asking option you won't be presented with this 
dialogue. 
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If you do not yet have a permanent license for Observer, a License dialog appears. To continue 

without a permanent license just press Continue. In this case the full functionality may not be 
available. See also 2.1 Introduction to Observer clients on page 11 for further details about licensing. 

Note: As of Netavis Observer 5.1 the default passwords for the pre-configured users have to be 
changed upon the first login. 

Starting multiple sessions of the Observer client 

It is also possible to start multiple sessions of the Observer client with a single shortcut. To do so you 
need to right-click on an existing shortcut to the Observer client and open its Properties. In the 

Target field you can then add the names of the saved sessions which you would like to be started 
upon clicking on the shortcut (e.g. "C:\Program Files\NETAVIS Observer\na.bat" 

"4.5.2 NCS" "4.5.2 NUS" will open the two saved sessions called "4.5.2 NCS" and "4.5.2 

NUS"): 

 

Using a different directory for the installed client application components 

Per default, the downloaded client application components will be installed in the directory 

%USERPROFILE%\netavisLibs (e.g. C:\Documents and 

Settings\user\netavisLibs). You can change this directory by setting the environment 

variable NETAVIS_DIRECTORY. The directory must exist prior to starting the Observer client. If the 

variable does not exist, the client components will be installed in the standard directory. 

Here is how you can set an environment variable in Windows 7: 

1. Right click on the Computer icon in your Explorer or on your Desktop and choose Properties. 
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2. In the System window click on Advanced system settings in the left pane. 

3. In the System Properties window select Advanced tab and click on the button Environment 
Variables at the bottom of the dialog. 

4. In the Environment Variables window you will notice two tables User variables for the current 

user and System variables for all users. 

5. To add a new User variable click on New… button. In the New User Variable dialog box enter 
the variable name NETAVIS_DIRECTORY and the location of the directory and then click OK. 

The default location would be %USERPROFILE%\netavisLibs. 

6. Click OK in the Environment Variables dialog window and close the other dialogs as well. 

Working with sessions of pre-4.0 servers 

The Starter also allows you to also manage sessions with Observer servers running releases older 
than 4.0. Just select the checkbox Show settings for pre-4.0 releases to show the additional 

settings. 

Description of elements: 

 

Element Description 

Window width, height Define the size of the client window in pixels. 

Upper left corner X, Y Define the location of the upper left corner of the client window in 

pixels. This setting can be changed, e.g., for multi-screen setups. 

Initial monitor view name Is optional and defines the initial Online monitor view. 

Window decoration visible Defines whether the windows decoration border is visible. 

Tool control bar visible Defines whether the tool control bar at the right side of the window 
is visible. This bar allows switching between Online Monitor, Archive 
Player, Event Management and Administration. 

Event bar visible Defines whether the event bar at the bottom of the window is 

visible. 

Online monitor control bar 

visible 
Defines whether the  menu and the history buttons for Online 

monitor control are visible. 

Overlay painting enabled When this is selected and the hardware supports it the Online 
monitor uses the hardware overlay technique for displaying flicker-
free MPEG streams. This can also boost the client performance and 

relieve the main CPU. 

In multi-screen operation, overlay painting of MPEG video streams 
may result in pink colored view ports if the client is not running on 
the primary screen of Windows. Then you should turn off this 
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Element Description 

feature. 

 

2.3 Client multi-window and multi-screen operation 

Observer supports multi-window and multi-screen operation. With clients workstations that have 
multiple screens connected you can position windows on different screens. 

Here is an example of a client setup with 3 screens: 

 

The window contents and positions are automatically stored per user and between sessions. This 

means when a user has multiple windows positioned on 3 screens and he exits and then logs in again, 

all the windows on the 3 screens will automatically be restored. 

Please note: There can only be one Archive player and this is located in the main window. 

2.3.1 Creating a new window 

In the main application window select New window from the Windows menu. 

The window title and the contents of the window can be adapted in the Client preferences (see 2.4 

Client preferences on page 19 for more details). 

2.3.2 Modifying window layouts 

You can modify the layout of a window by rearranging its components. Once you have defined in the 

Client preferences dialog what components are to be shown in a window you can customize the 
layout. Select the menu Windows->Enable layout customization. For the Event list and the Camera 
tree you can now define: 

• Where they are located inside the window: Just click on the title bar of the Event list or the 
Camera tree and drag it to a different location. For example, when the Online monitor and the 

Event list are enabled, then you can drag the Event list from the default position at the right 
border of the window to the bottom of the window. 
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• Whether they are floating (open when needed or there are new entries and collapsed or hidden 

otherwise) or pinned (always shown): You can change the state of the Event list or the Camera 
tree by pinning  or unpinning  it in the title bar. 

Whether the Event list or the Camera tree should fill the whole window: You can maximize the 

component by pushing the maximize button . When a component is maximized, it will 
occupy the whole space of the window and will automatically resize when you resize the 

window. Thus you can create a window that contains only an Event list. 

After you are done with the modifications deselect Windows->Enable layout customization. 

The default location for the Event list is the right window border and for the Camera tree (that usually 

only pops up when needed) it is the left window border. 

Note: Only the Event list and the Camera tree can be dragged. The other components in the window 
will then change their size accordingly. 

2.3.3 Positioning a window on a specific screen 

Positioning a window on a specific screen is very easy: Use the mouse to drag the window to the 

desired screen and drop it there. You can also maximize the window on the screen. 

When a window is configured to be in full screen mode (and therefore drag and drop is not possible) 

there is a Send to screen option in the context menu (accessible via a right mouse button click). 

 

Note: See 2.4 Client preferences on page 19 for information on how to enable full screen mode for a 
window. 

All the window states will be remembered between sessions. This happens on a per-user basis, which 

means when the user logs in on a different client workstation the same window setup as on the first 
client workstation will be shown. 

2.3.4 Deleting a window 

In the main application window select Delete window... from the Windows menu. A Delete 
window dialog will open, offering you the list of windows available for deletion. 
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2.4 Client preferences 

The Observer client offers many configuration options which can be adjusted via the Client 
preferences accessible via the Observer menu or the right mouse click menu in the main 

application window. 

Note: Depending on the authorization that your Observer administrator has assigned to you, some of 

the client components could be disabled (menu shown in grey color). If you need more authorization, 
please contact your local Observer administrator. 

 

2.4.1 Window preferences 

Here you can set some general configuration options for each individual window: 

• The Window title is shown in a window's title bar. Note that the number in brackets after the 
window title in the left-hand menu is the ID of the window. That is important as only the main 
application window designated by (1) can contain the Archive player. Similarly the Display 
menu bar, Display status bar, and Display toolbar options are also only available for the 

main application window. 

• The Full screen (requires restart) option is available for every window. In full screen mode a 
window is shown without a title bar or the Windows task bar and fills the whole screen. 
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2.4.2 Defining which components to display in a window 

For each window you can define any combination of components and component-specific 

configurations to be displayed: 

• Online monitor: You can choose to Display Online monitor and Show main controls (the 
View control menu, Next and Previous buttons, View selector, and Round tour selector). For that 

Online monitor's empty view ports you can configure whether the Add camera button should 

Show on mouse over or else only be accessible via the right mouse click menu. The 

Preferred monitor for large view on double click option can only be set for one window 
and defines in which one big views of cameras are shown after a double click. 

• Archive player: You can choose to Display archive player. 

• Event list: You can choose to Display event list, Display titlebar, Hide acknowledged 
events, Show hidden event list on new events and Scroll to reveal new events. 

Additionally you can configure which columns to show in the event list: ID, Time, Details, 

Camera ID, Camera, Priority, Icon, Server, and ACK state. 

• Camera tree: You can choose to Display camera tree always and Display titlebar. 

Note: Normally it is not necessary to always display the camera tree since it is displayed on-

demand. Also note that as of NetavisObserver 4.6.2 the state of the camera tree (which groups 
are and are not expanded) is stored per user. 

2.4.3 General preferences 

The configuration options set here apply to all Observer client windows: 

• General: You can enable the Camera status display (see 4.4 Checking the camera status on 

page 41 for details). 

• Event list: You can enable/disable the Play event sound option and configure the Maximal 

event count shown in the event list. It is also possible to configure the Default event video 
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export duration (how many seconds of the recording before and after the event should be 

exported) and Override default archive playback duration (how many seconds of the 
recording before and after the event should be shown per default in the archive player). This 
last option overrides other pre- and post-event recording options which may have been set up 

for specific events. 

• Streaming: To ensure smooth video and audio playback you can configure the length of the 
local Live video cache (with and without audio) in milliseconds. In case of connectivity issues 

it is advisable to raise the Live video cache (no audio) value above the default of 200ms. 

• Debug: You can enable different debug options and Show Log Debug.  

Note: These debug options are only needed for advanced error diagnosis. 

2.5 Mobile Observer clients 

You can also access an Observer server from mobile devices such as smartphones and tablets. As of 
Netavis Observer version 4.8.0 the previously provided Client for iPad and Client for Smartphone 
& Tablet are deprecated and no longer supported. The new Mobile Client provides cross-platform 

support for all supported browsers and platforms. Please refer to the NETAVIS Observer Server, Client 

and Storage Compatibility and Requirements document for details on compatibility. 

Note: These mobile clients do not support the full functionality of desktop clients (see 2.1 Introduction 
to Observer clients on page 11 for more details). When using the Mobile Client the videostreams of 

cameras, which do not provide a MJPEG stream to the Netavis Observer server, have to be transcoded 
on the server which requires additional CPU power. 

This chapter describes how to use these mobile Observer clients. 

2.5.1 Mobile Client 

The Mobile Client can be run directly in a web browser on a smartphone, tablet or PC and does not 
require any installation: 

1. Start a web browser. 

2. Enter the address of your Observer server followed by /mobile (e.g. <Observer-IP>/mobile) and 
login. Both http and https are supported by the Mobile Client. 

3. If you have previously configured a view you will see it after logging in. Else you will be presented 

with an empty view. Click on the menu button  and select View Config to create a view. 
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4. By clicking on the menu button again you can choose between different options: 

• Leave view config: Leave the view configuration 

• Save: Saves the current view configuration. 

• Create new view: Allows you to create a new view and configure it with a Name (with up 
to 20 characters), the desired number of view ports (max. 3x2) and the default fit mode 

(Letterbox, Stretch or Crop). 

• View properties: Allows you to change the currently selected view. 

• Delete current view: Deletes the current view. 

• Logout: Logs out of the Mobile Client. 

5. To add a camera to a view port select it in the camera tree on the left-hand side and drag it into 

the desired view port. You can also search for cameras using the search box at the top. 

Note: A preview of the camera image is only visible in the view configuration if the camera is 
configured to provide a MJPEG stream to the NetavisObserver server. In the actual view however 
the camera's stream will be shown regardless of the its codec. 

6. Once you have added a camera you can change its view configuration by double-tapping on it. 
Changing its size allows you to have a camera fill multiple view ports. It is also possible to 
overwrite the view's fit mode with a camera specific one. 

7. To remove a camera from a view port you can either select and drag it back to the camera tree or 
select Remove camera from the camera configuration. 

8. After selecting Leave view config you will see the configured view: 
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9. To switch between different views, you can either swipe left / right on touch-enabled devices or 
use the View menuin the top-right corner or move between views with the Backward or 

Forward buttons. 

10. By tapping on a camera in a view it will be opened in a large view. 

11. In a camera's large view you can select to play back archive recordings by tapping on the Archive 

button:  

12. The playback can be started and stopped by clicking on the video and the usual playback buttons 
are available at the bottom. Additionally, there is a shortcut menu on the right which allows you to 

select the playback of different intervals, including a custom one where you can enter a specific 

timeframe for playback. 

13. You can return to the large live view or to the view by clicking on the Back button:  

14. To add the Mobile Client as a shortcut on your mobile device follow these steps: 

• Android / Chrome: 

• Open the Mobile Client in the Safari app 

• Open Chrome's menu 

• Press the Add to Home Screen button 

• Enter a name for the shortcut and then press Add 

• The shortcut then appears on your home screen: 
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• iOS / Safari: 

• Open the Mobile Client in the Safari app 

• Open Safari's Share menu and choose Add to Home screen 

• Enter a name for the shortcut and then press Add 

• The shortcut then appears on your home screen and can be used like with any other 
app 

15. On PCs the Mobile Client also offers keyboard shortcuts for often used functions: 

• Application-wide: 

• ENTER: Confirm action or dialogue 

• ESC: Dismiss popup 

Note: Leads to a stop of the Mobile Client in Internet Explorer! 

• q: logout 

• Main view: 

• e: jump to view configuration 

• left-arrow: jump to previous view 

• right-arrow: jump to next view 

• Live/Archive view: 

• left-arrow: jump to live view 

• right-arrow: jump to archive view 

• View configuration: 

• p: Show view properties 

• n: Create new view 

• DELETE: Delete view 

• l: Select letterbox in view / camera properties 

• s: Select stretch in view / camera properties 
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• c: Select crop in view / camera properties 

2.5.2 Client for iPad (deprecated) 

To get the Netavis Client for iPad follow these steps: 

1. Follow this link or go to the iTunes Store and search for "NETAVIS". 

2. Install the Observer app on your iPad. 

To use the app: 

1. Start the Netavis Client for iPad. 

2. Connect to an Observer server and login. 

3. If you have previously configured a view port layout you will see it and be able to tap on a camera 
for a full screen view and access to its archive: 

 

Else you first have to tap Add layout, select the desired layout and then add cameras to the 
individual view ports. It is possible to add multiple layouts and switch between them using the 
arrow buttons or dropdown menu in the middle of the navigation bar: 

https://itunes.apple.com/us/app/netavis-client-for-ipad/id496176184?mt=8
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4. When you are finished using it, it is recommended to log out of the Netavis Client for iPad via the 

Logout button on the overview screen (although there is an automatic logout after 10 seconds). 

2.5.3 Client for Smartphone & Tablet (deprecated) 

The Client for Smartphone & Tablet can be run directly in a smartphone or tablet web browser and 

does not require an installation: 

1. Start a web browser on your smartphone or tablet. 

2. Enter the address of your Observer server followed by /browserclient (e.g. <Observer-

IP>/browserclient) and login. Both http and https are supported by the Client for Smartphone 
& Tablet. 

3. When you get the camera tree tap/click on camera groups to expand them and then on a camera 

to show its live stream: 
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4. You can choose whether to watch the live-stream in a Small, Medium or Large resolution and 
which Letterbox mode should be used. 

Please note: Changing the resolution only works for cameras where multiple MJPEG streams are 

supported. Please see the Netavis Observer Supported Video Sources document for further 

information. 

5. When you are finished using it, it is recommended to log out of the Client for Smartphone & Tablet 

via the Logout button (although there is an automatic logout after 10 seconds). 

2.6 Observer Transcoding for low-bandwidth client-server connections (ABS) 

The unique Observer Transcoding technology (also called ABS for adaptive balanced streaming) 
reduces the necessary bandwidth for video streams to a fraction of the usual values. Especially high-

resolution cameras can thus be streamed from server to clients over low-bandwidth wide area 

network (WAN) connections without loss of quality. Therefore even high-resolution cameras can be 
operated over very low bandwidth connections that would normally prevent their operation. The 

technology works for all cameras, streaming resolutions, and formats (including MPEG-4, H.264, H.265, 
and MxPEG). 

Additional CPU resources are needed at the server and at the client for transcoding streams. 

Transcoding can be set up in the server level by limiting bandwidth for live video and recording 
playback streams as well as for recording exports (see 11.2 Setting Observer server parameters on page 

109). 

Note: ABS-Transcoding is only available in the Netavis Observer client and is not supported by the 
Mobile Client, Layout Navigation or other tools. 
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Hints: Although transcoding works with all streaming formats, the best results and least CPU 

overhead are possible with MJPEG streaming. Also the transcoding bandwidth limit must be chosen 
carefully. 

Therefore we suggest: 
• MJPEG streaming format. 
• Limit the transcoding bandwidth to app. 70% of the available server-client connection 
bandwidth. 

For connections, like Internet connections, with heavily varying bandwidth it is much better to use a 
lower limit than a higher limit. With low limits of 256 kbit/s or 128 kbit/s very good results are possible. 
Some customers have even used 56 kbit/s or 30 kbit/s with transcoding. As mentioned above the 
limits are defined in 11.2 Setting Observer server parameters on page 109. 

2.7 Exiting the client 

The Observer client can be closed by choosing Exit from the Observer menu at the main application 
window. You will be asked whether you really want to exit. 

If the menu bar is hidden, you can exit the client via the right mouse button menu. 
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3 Guidelines for setting up a new system with Observer 

This section guides you how to best set up a new system with Observer. It shows which steps are 
needed in which order and gives you some hints on how to configure cameras and users. 

For a simple system with 1 server take these steps: 

1. Set up cameras 

2. Set up users 

3. Set up views 

For a bigger system with connected servers take these steps: 

1. Set up servers 

2. Set up cameras 

3. Set up users 

4. Set up views 

Please note: All of these steps should be taken by the administrator user (usually login admin). 

Here we describe the steps for one server (for the setup of connected servers please see 12 Working 
with interconnected Observer servers on page 117): 

3.1 Guidelines for setting up cameras 

Usually, a system consists of several cameras of the same type with similar settings. Bigger systems 
may have many cameras of the same type and several different types. Therefore, Observer offers you 

the possibility to duplicate cameras in order to facilitate the setup. 

Take these steps for setting up cameras: 

1. Define camera groups. We found that a good grouping criterion is the location of the camera. 
Another grouping criterion could be access rights for various user groups. See 4.6 Working with 

camera groups on page 42 for details. 

2. For each of the cameras that are of the same type and have a similar setting for recording and 
possibly motion detection create a camera that serves as a blueprint for other cameras and can be 
duplicated later. 
Define also the recording settings for this camera. For motion detection (MD) take useful default 

values that can be tuned later on (please note that first you have to create the MD definition and 
then you set up the scheduling/recording for the MD setting). 
Since most video analytics settings are different between cameras, it does not make a lot of sense 

to create default values for video analytics at this point in time. One exception could be that you 
may want to set up the same object tracking regions for several cameras. 

For further details please refer to 4.2 Adding a new camera and basic configuration on page 31 and 
8 Working with motion detection on page 86. 

3. Now duplicate (clone) the cameras and, if necessary, move them to different camera groups. 

After that you can fine tune the camera setup and define special settings like video analytics for 
various purposes (see 15 Video analytics with iCat on page 142). 
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3.2 Guidelines for setting up users 

Usually a bigger system will allow several users to login with different privileges and rights. Therefore it 
can be useful to group several users with similar tasks and rights in so called user groups in Observer. 

Take these steps for setting up users and groups: 

1. Create user groups for the various roles and privileges (examples are: security personnel, view only 
users, administrators). For each users group define the system wide privileges. See 5 Managing 
users on page 44. 

2. In the users groups create the users you need. Please note that by default the users will inherit the 

privileges from the group they belong to. 

3. Set the camera access rights per user. 

3.3 Guidelines for setting up views 

Observer allows you create several views for showing cameras in various configurations and sizes. 
Therefore it makes sense to create various views for different surveillance purposes. Since the views 
are configured per user, we suggest that the administrator creates the standard set of views and then 

copies the views to the various users. 

Take these steps for setting up views: 

1. Create the various views needed by most users. See 6.1 Creating a new view on page 54. 

2. Copy the views to the various users. See 6.8 Copying views between users on page 62. 

Later on you can create further views and copy them again. 
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4 Setting up cameras 

Netavis Observer allows any authorized user to set up cameras in the system. 

4.1 Preparations 

Before you begin to set up a new camera in Observer, be sure to have the following information 
available: 

• Your camera model, its IP address, and its login information 

• Whether your camera type is supported by Observer? 

Please consult the document Netavis Observer Supported Video Sources. 

• Are there available licenses for setting up additional cameras? 

4.2 Adding a new camera and basic configuration 

As of Netavis Observer 5.0 the Camera Wizard is the only way to add and manage cameras and it 

guides you through the configuration process. It is opened once a camera management option is 
selected in the Camera admin menu. On top of the usual manual configuration options, it provides: 

• automatic camera discovery within an IP address range 

• duplicating an existing camera and just modifying some parameters (see 4.2.2 Duplicating an 

existing camera on page 40) 

• generating Excel template worksheets where cameras can be pre-configured (and subsequently 
imported into Netavis Observer) 

• importing camera configurations from an Excel worksheet 

• exporting the current camera tree into an Excel worksheet for documentation purposes 

Hint: With Netavis Observer 5.1 the previously available Camera admin pages ("Default settings" and 

"Scheduling") have been replaced by the newly designed camera properties page, an enhanced 
camera wizard (details below), and Schedule Admin (see 21 Schedule Admin on page 187 for details). 

4.2.1 Adding a camera from scratch 

1. Choose Camera admin from the System administration menu. This opens the Camera 

admin dialog. 

2. Select the camera group to which you want to add the new camera (later on you can move the 
camera in the camera tree to a different group) and choose Add new camera from the context-

menu: 
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3. On this screen you can choose whether to manually Add cameras, use the Discovery, and/or 
Import cameras from an Excel file. 

a. To manually add cameras, press Add to add a new camera entry and then skip to the next 
step. 

b. To use the automatic camera Discovery, you are presented with a separate window where 

you can define the IP range for the automatic camera discovery. Discovered cameras are 
shown in the table below whereby the system also tries to assign the most appropriate 

camera type to it (e.g. if a camera is discovered as an ONVIF device and a device of vendor 
X the vendor X type will be used). They can then be added to the system by selecting them 
and pressing Add selected. Then continue with the next step. 

 

Note: Whether a camera can be found via the automatic camera discovery depends on 
many factors such as the camera model, camera configuration, network configuration, etc. If 

you cannot find a camera via the discovery, please try to add it manually. Also, note that 
cameras which are already configured in the system's camera tree or devices with more than 

one IP address are not shown in the table and will be counted in the Already in tree 
(rejected) field. 

c. To import cameras from an Excel file, press Import, select the prepared Excel file, and then 
continue with the next step. 
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Note: If a camera is listed multiple times in the Excel file then it will also be imported 

multiple times. However, if the Excel file contains a camera which is already configured on 
the system then it will not be imported again. Also note that import from an Excel file is only 

intended to be used for initial system setup and not for exporting an existing camera tree, 
modifying the configuration in Excel, and then re-importing the cameras. 

4. Regardless of how you added the cameras in the previous step, you now have to complete and 

verify their configuration. The first screen shows the cameras' Basic Data which can be sorted in 
ascending or descending order for every column by pressing on the column name. To make bulk 
modifications on this and any other pages select the desired cameras while keeping the CTRL key 
pressed and then click on Edit in the column that you want to modify (e.g. Type). You can also 

copy or remove an existing line by clicking on the Copy and Remove icons respectively. 

Additionally, cells marked in red indicate that part of the configuration is missing. Press Next 
when you are done with this part of the configuration to move to the next page. 

 

For the Basic Data fields labeled in bold are mandatory whereas all others are optional: 

 

Field label Description 

Name Enter the name that you want to give your camera. This is the name 
by which you will select or display this camera (e.g., "camera 

entrance"). 

Group Select the group to which this camera should be added. 

Hint: It is also possible to select camera groups from other 
connected Netavis Observer systems. This allows you to add 
cameras from a NUS to a connected NCS. 

IP address Specify the IP address or network name of your camera or video 
server. If you supply a network name, you must have access to a 

domain name server (DNS) that resolves the name to an IP address. 
Even dynamic DNS names (like dyndns) can be used. This field is 

not needed for analog cameras connected directly via a video 
capture card (NDS). 
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Field label Description 

Admin name If the camera needs authentication for administration, then enter 
the user name of the camera administrator here. 

Note: Required for ONVIF Profile S cameras. 

Admin password Enter the password of the administrator account of the camera (up 
to 32 characters). 

Note: Required for ONVIF Profile S cameras. 

HTTPS If the camera supports encrypted streaming using HTTPS this 
setting will be enabled. It defines whether streaming from the 

camera is encrypted using HTTPS. Please note that encryption 
needs significantly more CPU resources on the server than 
unencrypted communication (see also 1.3 Observer data security on 
page 7). 

Streaming mode This option is only enabled if the camera type is set to ONVIF - 

Profile S. Per default it is set to Auto but it can also be set to No 
tunneling, Multicast, RTSP tunneling or HTTP tunneling. 

Type Specify the camera type by selecting it from the camera pop-up 

menu. 

Important: If you want to connect an analog camera via a video 

server then select the type of the video server from the menu. If you 
connect an analog camera to a video capture card directly in the 

Observer server, then select NDS (Observer Digitizer Server) as your 
camera type. 

Time zone Select the time zone of your camera's location (e.g., CET for a 
camera installed in Vienna). 

Aspect ratio This setting is only enabled for certain IP cameras that are shipped 
with different aspect ratios (like PAL or NTSC). For cameras that are 

delivered in one standard only, the correct value is set 

automatically and cannot be changed. Please select the correct 
value for your camera. If you select a value that does not fit your 

camera, then the image might be distorted. Please refer also to 1.4.5 
JPEG image sizes and storage requirements on page 10. 

 

5. If you have configured any of the cameras in the previous step to be of the Type Axis - Generic, 
Hikvision - Generic, ONVIF - Profile S or VNS - Generic, then the system will now fetch the 
cameras' capabilities which may take some time. 
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6. If any of the added cameras have more than one channel (previously referred to as Camera-

server port) or more than one view (e.g., 360° cameras often offer multiple views such as an 
overview, panoramic views, individual views for 90° perspectives, etc.) the next page allows you 
to configure them: 

 

Field label Description 

Name Here you can change the previously entered name of the camera's 

channels or views. 

Group Here you can change the previously selected group to which the 
camera's channel or view should be added. 

Comment Here you can add comments to the channel or view (up to 250 

characters). 

Hint: To also show the comments in the camera tree press the 

Comment button next to the camera search field. 

Channel Here you can select a specific channel provided by the camera. 

View Here you can select a specific view provided by the camera. 

 

Note: As of Netavis Observer 5.1 multi-channel cameras only require a single camera license. 

7. On the next page you can configure the Further camera settings: 

 

Field label Description 

Comment  Here you can add comments to the camera (up to 250 characters). 

Hint: To also show the comments in the camera tree press the 
Comment button next to the camera search field. 

Responsible  Here you can add the person responsible for the data processing 
required for GDPR documentation (up to 60 characters). 

Application  Here you can add the data processing application required for 
GDPR documentation (up to 60 characters). 

Use camera settings This checkbox is automatically set depending on the selected 
camera driver and its corresponding configuration. 
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Field label Description 

Audio to camera When marked, Observer will allow Audio to the camera and will 
offer a button for that in the Online Monitor. Of course, this feature 
only works if you have a working microphone connected to the PC 

where you run your client on and your camera has a loudspeaker 
function. 

Audio from camera When marked, Observer will allow Audio from the camera to your 

client (in the Online Monitor and for recordings). Of course, this 
feature only works if you have a working loudspeaker connected to 
the PC where you run your client on. Please note that platform 
restrictions may apply for this streaming mode (please refer to 2.1 
Introduction to Observer clients on page 11).  

Audio from and to share 
single button 

If this checkbox is marked, then there is only one button in the 
Online Monitor that switches MPEG and Audio on and off. If this 
checkbox is not marked, then you will find 3 buttons for the three 
functions. See also 6.9 Working with MPEG cameras and audio () on 

page 63. 

Anonymize (distort) audio In some cases laws do not allow the transmission or recording of 
people's voices. The criterion often is whether one can recognize a 

person by listening to its voice. Therefore Observer allows 
anonymizing the audio stream by distorting it. If this checkbox is 

marked then the live and recorded audio will be anonymized 
(distorted). 

 

8. On the next page you can configure the cameras' Stream profile settings which were 

introduced in Netavis Observer 5.1. You can use the Add-button to configure additional stream 
profiles for any cameras: 

 

Field label Description 

Profile name 
Enter the desired name of the stream profile and press ENTER to 
confirm it. 

Codec 
Select the desired codec of the stream profile whereby the possible 
values depend on the camera model. 

Resolution Select the desired image resolution of the stream profile whereby 
the possible values depend on the camera model. 

The higher the image resolution, the more bandwidth will be used 

for transmission and the more space for recording will be needed. 

Frame rate Select the desired frame rate of the stream profile whereby the 
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Field label Description 

possible values depend on the camera model. 

 The higher the frame rate, the more bandwidth will be used for 
transmission and the more space for recording will be needed. 

Quality Defines the image quality of the stream profile. The possible values 
are High, Medium, and Low quality. 

The higher the quality, the more bandwidth will be used for 
transmission and the bigger the space requirements for recording 
will be (see also 1.4 Video streaming methods and compression on 

page 7). 

Bandwidth (BW) limit 
This setting limits the maximum bandwidth in kilobits per second 

for the transmission of streams between the camera and the server. 
As a consequence, also the bandwidth between the server and the 

clients is thus limited and also the required storage in the archive is 
influenced (limited). If this value is zero, then the bandwidth is not 
limited. 

This actually is a setting in the camera. The camera always 
optimizes for the desired image quality and will sacrifice frame rate 

in favor of quality in the case, the bandwidth would exceed the 
supplied limit. 

GOP size For MPEG streams defines the how many frames are sent and 

stored in a GOP (group of pictures). One GOP is an integral data 

packet that is transmitted and recorded. Our default value is 10, 

which means that there is 1 reference frame (I frame) and 9 

difference frames (P frames). A bigger GOP size means a higher 
compression rate but also a somewhat lower quality and a bigger 
delay between a real scene and its viewed images (which is 

relevant, e.g. for live viewing in the Online Monitor). We think that a 

GOP size of 10 is optimal for most case, which, dependent on 
camera model, covers a time between 0.5 ~ 1 sec. 

Note: With high bandwidth video streams (e.g. high resolution, high 

stream complexity) setting a large GOP size can have detrimental 
effects on the system performance and stability. 

RTSP port If you want to use the generic RTSP driver to get a stream from a 

camera - which requires selecting "Generic RTSP" as the camera's 
Type - then you have to enter the RTSP port of the camera into this 
field (if it is left empty then the default port 554 is used) and the 
specific URL into the field next to it (see below). The IP address, 

username, and password of the camera admin are used from the 

corresponding configuration made on the earlier Basic Data page. 
The stream configuration (stream resolution, fps, etc.) has to be 
done in the camera itself! 
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Field label Description 

RTSP URL If you want to use the generic RTSP driver to get a stream from a 
camera - which requires selecting "Generic RTSP" as the camera's 
Type - then you have to enter the RTSP URL of the camera into this 

field. The IP address, username, and password of the camera admin 
are used from the corresponding configuration made on the earlier 

Basic Data page. The stream configuration (stream resolution, fps, 
etc.) has to be done in the camera itself! 

 

9. On the next page you can configure the cameras' Archive settings: 

 

Field label Description 

Recording hours Fill in the recording period for this camera. This value defines how 
long Netavis Observer will keep recordings. Recordings that are 
older than the recording hours will be automatically deleted by 

Netavis Observer. 

Note: As of Netavis Observer 5.1 the default recording period is 72 

hours / 3 days (whereas it had previously been 720 hours / 30 days)! 

Priority over other cameras 
(if storage space is short) 

This option gives this camera priority over other cameras if the 
available storage space is too small for all requested recordings of 

all cameras (for further details see 7.1.4 Operation of the Observer 
dynamic storage management on page 72). 

Recording period is 

measured from...  
This option defines what the requested recording period refers to: 
either Recording period is measured from now as calendar 

days or Recording period is measured from youngest 

recording as calendar days. 

There can be quite a difference between these two choices, e.g., a 

motion detection-based recording that only triggers recordings 
once every few weeks. 

 

10. On the next page you can configure the cameras' Schedule settings whereby you can use the 

Add-button to configure additional schedules for the cameras: 

 

Field label Description 

Type Select the type of schedule: Continuous recording, Video 
analysis (iCat), Camera MD (FTP), PTZ route or Event-
triggered recording 

Scheduling Select the default 24/7 schedule or a previously defined custom 
schedule (see 21 Schedule Admin on page 187 for details). 



Netavis Observer 5.1 User Manual (February 2021) 

Page 39 of 214 

Field label Description 

Enable Set whether the schedule should be enabled or disabled. 

Streaming profile Select one of the previously defined streaming profiles. 

Save Audio Set whether the audio should be saved or not. 

Frame rate Taken from the selected streaming profile. 

Pre-event recording (sec) Definition of the pre-event recording period in seconds (only 
available for Video analysis (iCat) and Event-triggered recording 

schedules). 

Post-event recording (sec) Definition of the post-event recording period in seconds (only 

available for Video analysis (iCat) and Event-triggered recording 

schedules). 

Assigned iCat definitions Confirm the assigned iCat definitions to this schedule via the 

Assigned iCat definitions. Per default all available iCat definitions 

for this camera are assigned. If you do not want that you can 
remove them now by deselecting the definition(s) that you do not 
want included in this interval. 

Store / display / propagate 
event 

Set whether the events generated by this schedule should be stored 
in the system's database, displayed to the user in the event list, and 

propagated to connected Netavis Observer systems. 

Routes Assigned PTZ routes (only available for PTZ route schedules). 

 

Note: It is not possible to define mixed recordings with different codecs for the same schedule or 

overlapping time frames (e.g., a 24/7 permanent recording in H.265 cannot be set up in parallel 

to a 24/7 iCat recording in H.264)! 

11. Press Finish to save the configuration and return to the Camera admin. 

12. By selecting a camera in the camera tree its entire configuration is shown on its Properties 

page: 
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4.2.2 Duplicating an existing camera 

Duplicating an existing camera creates an exact duplicate of the camera with all settings except for the 

IP address copied. This is useful when you have more than one camera of the same type or with 
equal/similar settings (like recording or iCat video analytics settings). With duplicating a camera you 
can reduce the set up time for systems with many cameras with similar settings. 

To clone an existing camera: 

1. Choose Camera admin from the System administration menu. This opens the Camera 
admin dialog. 

2. In the camera tree select the camera you would like to duplicate/clone. 

3. Choose Duplicate camera from the menu. 

4. The camera wizard opens with a duplicate of the previously selected camera. 

5. Configure the duplicate's Name and IP address accordingly 

6. Optionally modify other parameters as needed (see 4.2.1 Adding a camera from scratch on page 

31 for details). 

7. Press the Finish button at the bottom of the dialog when you're done. 

Note: Only local cameras and remote camera groups can be duplicated. It is not possible to duplicate 
individually mounted remote cameras. 
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4.3 Setting up the camera recording archive 

The configuration of camera recordings is covered in section 7.1 Programming archive recordings on 
page 72. 

4.4 Checking the camera status 

Netavis Observer offers a camera status overview which enables users to quickly see whether the 
cameras in their system or on connected remote servers are running normally. Issues such as a camera 
being unreachable are indicated by a red icon. An overlay provides additional information about each 

camera and its status and configuration. 

In order for the camera status to be available the Camera status display option has to be enabled in 
the Client preferences (see 2.4 Client preferences on page 19 for details). 

Note: The camera status overview is only updated for cameras which are being actively used by 
Observer for recordings, video analysis or live monitoring in the Online Monitor. For all other cameras 
the status is not updated. 

Once the option has been enabled a status icon is added next to each camera and camera group in 
the camera tree within the Camera admin: 

 

For cameras the status icon indicates one of three states: 

• If the icon is green everything is running normally. 

• If the icon is grey then the status is unknown or still being queried (please allow for up to a 
minute for the status to be determined). 

• If the icon is red then one or more of the following issues have arisen: 

o Unreachable: The camera is not reachable (equivalent to the "Camera not responding" 

message in the Online Monitor's view port). 

o Authentication: The username and/or password in the camera setup are not correct 
(equivalent to the "Camera authentication error" message in the Online Monitor's view 
port). 

o Internal camera error: An internal camera error has occurred. 

The status icon of a camera group is an aggregate of the statuses of its cameras. If one or more of the 
cameras have a grey or red status icon then the group's icon also has that color. This makes it possible 

to quickly get an overview of the cameras even when the groups aren't expanded: 
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More detailed information about each camera is available in an overlay which appears after hovering 
over a camera entry: 

 

• Status: One of the first three error states described above or "Normal". 

• Last error information: Includes the exact timestamp and a short description of the last error. 

• Continuous recording scheduled: If a recording is scheduled to run on the camera at this point 
in time. 

• Video analysis (iCat) scheduled: If an iCat definition is scheduled to run on the camera at this 

point in time. 

4.5 Optional: Configuring video analytics (iCat) 

The configuration of video analytics with iCat is covered in chapter 15 Video analytics with iCat on page 
142. 

4.6 Working with camera groups 

Camera groups are a powerful means for managing and organizing cameras. 

4.6.1 Creating a new camera group 

1. Choose Camera admin from the System administration menu. This opens the Camera 
admin dialog. 

2. In the camera tree select the group in which you want to create the new camera group. 

3. In the menu select Add new camera group which will open new dialog that allows you to enter 
the name and description for the new camera group. 

4. Optionally select the Use group name as camera name qualifier checkbox. If this checkbox is 
selected then the name of the camera group is displayed as prefix to the camera name, e.g. 

“group-name:camera-name”. 

5. Press Save to create the new camera group. 
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4.6.2 Moving a camera or camera group in the camera tree 

Individual or multiple cameras or groups in the camera tree can be moved to another location by 

following these steps: 

1. Choose Camera admin from the System administration menu. This opens the Camera 

admin dialog. 

2. With a mouse click choose the camera or group you want to move. To select multiple cameras or 
groups keep the CTRL key pressed while you make the selection. 

3. In the menu select Move camera or group. A new dialog appears that requires you to enter the 

password. 

4. Enter the password. After you enter the correct password a camera group dialog is opened 

showing the camera groups. 

5. In the newly opened camera groups dialog select the group where you want to move the camera 
or group to and press Select. Now the cameras or groups are moved to the new location and the 

camera tree is updated. 

4.6.3 Modifying cameras in a group 

Using the Modify cameras in group menu-item it is possible to modify all cameras in a group or 

multiple selected cameras in different groups (press CTRL to select multiple cameras at once). 

4.7 Changing the port mapping of analog cameras 

This section is only valid for analog cameras. For analog cameras a port must be defined where the 
camera is connected to at the video capture card or the video server. 

Sometimes the port mapping of analog cameras needs to be changed but it is difficult to do that 

physically by changing the cabling. To help the situation, Observer can change the port mapping in the 

software. 

There are two ways for doing that: 

• Either go to the Camera Administration and manually switch the port there. For this however 

you need to know exactly which camera is connected to which port. 

• You can also swap the ports in the Online Monitor. This has the advantage that you see the 

video pictures and therefore you can identify the correct ports visually. 

In order to swap the ports of two analog cameras visually please follow these steps: 

1. In the Online Monitor go to the view that shows the first analog camera in a view port. 

2. CTRL-click into the view port that shows the first analog camera. 

3. Now go to the view that shows the camera that you would like to swap with and CTRL-click in the 

view port. 

Now the ports of the two cameras have been swapped. 
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5 Managing users 

Observer requires users to login in order to work with the system. This chapter describes how to create 
and manage users in Observer. 

Generally, you can either 

• use Observer to administer users (see 5.1 Creating a new user account on page 44), or 

• use Active directory or LDAP to manage users (see 5.8 Working with Active Directory and LDAP 

users on page 53). 

5.1 Creating a new user account 

An Netavis Observer administrator can create user accounts in the system. 

Note: At initial product installation a set of predefined users accounts and groups are created. These 
users and groups model typical permissions of users in various roles. Instead of creating a new user 
account you can take one of these predefined users and modify the settings accordingly. Also, ensure 
to delete the default users that are not needed on the system! 

Here are the steps for creating a new user account: 

1. Choose User admin from the System administration menu. This opens the User admin 
dialog. 

2. Select a user group to which you want to add the user. Please refer to 5.4 Working with user 
groups on page 52 if you want to create a new user group first. 

3. In the menu select Add new user. The Properties dialog opens to allow you to enter user data. 

4. Enter your user data in the corresponding fields of the dialog. Use the following table as a guide. 

Fields labeled in bold (both in the dialog and in the table) are mandatory; all others are 
optional: 

 

Field label Description 

Login name This is a short name that the user will use to log in. 

Full user name This is the complete name of the user. 

Password Enter a password for the user (with up to 32 characters). The user 
can change this later on (see 5.7 Changing the password on page 

53). 

Re-enter password Enter the password again for verification. 

Secondary password Enable the checkbox and enter a secondary password if a 

secondary password is needed for logging in the user. This is 
important for enforcing the four-eyes-principle for certain video 

operations. 
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Field label Description 

Re-enter sec. password 
Enter the secondary password again for verification. 

Change password Interval in which the user has to change the password: 1 month, 3 

months, Never 

Forgot question Formulate a question that (only) the user can answer if he has 
forgotten his password.  

Forgot answer Provide the answer to the above password question. 

Enable web customizer 

login 

Defines if the user has access to the Customizer on the server's web 

page where system backups, configuration files, custom event 
handlers, and other advanced administration tools are available. 

Hint: As of NetavisObserver 5.1 this option can also be configured 

for Active Directory users. 

Enable download of 

exported files 

Defines if the user has access to the automatically exported files on 

the server's web page (see 19 Automatic Export on page 181 for 

details). 

Hint: As of NetavisObserver 5.1 this option can also be configured 
for Active Directory users. 

E-mail address If the user is to receive an e-mail in the event of an alarm or failure, 
provide his e-mail address. 

Language Specify the preferred language for this user. 

Hint: As of NetavisObserver 5.1 this option can also be configured 

for Active Directory users. 

Auto login after 1 min 

timeout 
Defines whether this user should be logged in automatically when 
nobody else logs at the login panel in for 1 minute. This option can 

be enabled for only one user at a time. 

Ask for login reason If this option is enabled, then the user has to document a reason for 
the login at the system.  

Note: If the global Ask for login reason option is enabled in the 
Host Admin then the user-specific setting is ignored. 
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Field label Description 

PTZ priority (1=lowest, 
10=highest) 

Defines the relative PTZ priority between users. A user with higher 
priority can take away PTZ control from a user with lower priority. 

Note: The automated PTZ actions started by the event manager 
and scheduled routes have priority 4. Therefore users with priority 1 

to 3 will be overridden by automatic PTZ actions, whereby users 
with priority 5 to 10 can override automatic PTZ actions but will not 

be interrupted by them. 

Hint: As of Netavis Observer 5.0 it is also possible to modify the 
PTZ privileges of Active Directory users. 

Max. PTZ use time (sec) Maximum allocation time, after which a PTZ camera is 
automatically released. Zero means no limit. 

Hint: As of Netavis Observer 5.0 it is also possible to modify the 
PTZ privileges of Active Directory users. 

PTZ inactivity timeout (sec) 
When a user has taken PTZ control and is inactive for a certain 
amount of time, the PTZ camera is freed automatically after this 

timeout. Zero means no timeout. 

Note: As of Netavis Observer 5.0 it is also possible to modify the 
PTZ privileges of Active Directory users. 

 

5. Click on Next to go the Privileges dialog. Here you can set the privileges for the new user (see 

5.2 Setting general user privileges on page 46 for details). 

6. Click on Next to go the Camera Access Rights dialog. Here you can set the camera access 

rights for the new user (see 5.3 Setting camera access rights on page 50 for details). 

7. Click on Save to create the new user account with the settings you entered. 

Hints: In order to use the four-eyes-principle you first create a user with the desired privileges and 
camera access rights. You then create a new user, set a secondary password for that second user, 
grant the same privileges and camera access rights as the first user, and then add the desired 

additional rights (e.g. Archive access) compared to the first user. 

5.2 Setting general user privileges 

For each user and group certain privileges can be defined. These privileges define which tools and 
data a user has access to and what he can do. 

1. Choose User admin from the System administration menu. This opens the User admin 
dialog. 

2. Search for the user or directly select the specific user or group you want to modify. 
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3. Click on the Next button to move to the Privileges dialog. 

Here you can edit privileges for the user or group. In their initial state, all privileges in this dialog 

are inherited from the upper group level. Inherited privileges from the group level to which the 
user or group belongs are displayed with normal font, while values that you define at the current 
user or group level are displayed in bold. 

Use the scroll bar to access the lower part of the list. 

4. Choose Modify selected user or group from the menu. 

5. Set the privileges according to your needs. To change a privilege click on its button and select 

the status from the pop-up menu (either Inherited, Enabled, or Disabled): 

 

Field label Description 

Online monitor: Access to Online 

monitor 

Defines if the user/group has access to the Online 

monitor 

Online monitor: Add cameras to views 
in Online monitor 

Defines if the user/group can add cameras to existing 
views in the Online monitor 

Online monitor: Remove cameras 

from views in Online monitor 

Defines if the user/group can remove cameras from 

existing views in the Online monitor 

Online monitor: Create and delete 
views in Online monitor 

Defines if the user/group can create and delete views in 
the Online monitor 

Online monitor: Save view layouts in 
Online monitor 

Defines if the user/group can save different view layouts 
in the Online monitor 

Recordings: Access to recording 
archive player 

Defines if the user/group can access the recording 
archive 

Recordings: View external archive 
recordings (NEA) 

Defines if the user/group can view NEA recordings 

Recordings: Manage external archive 
devices (NEA) 

Defines if the user/group can manage external storage 
devices for NEA 

Events: Access to Event list and 

database 

Defines if the user/group can access the Event list and 

database 

Events: May acknowledge a system 
event 

Defines if the user/group can acknowledge system 
events 

Events: Notification in user interface Defines if the user/group receives notifications about 
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Field label Description 

about system malfunction events system malfunction events within the client 

Events: Sending email about system 
malfunction events 

Defines if the user/group receives notifications about 
system malfunction events via email 

Events: Sending SMS about system 
malfunction events 

Defines if the user/group receives notifications about 
system malfunction events via SMS 

Events: Notification in client user 
interface about system information 
messages 

Defines if the user/group receives notifications about 
system information messages within the client 

Events: Sending email about system 
information messages 

Defines if the user/group receives notifications about 
system information messages via email 

Events: Sending SMS about system 
information messages 

Defines if the user/group receives notifications about 
system information messages via SMS 

Events: Notification in user interface 

about I/O device malfunction events 

Defines if the user/group receives notifications about I/O 
device malfunction events within the client 

Events: Sending email about I/O 
device malfunction events 

Defines if the user/group receives notifications about I/O 

device malfunction events via email 

Events: Sending SMS about I/O device 
malfunction events 

Defines if the user/group receives notifications about I/O 

device malfunction events via SMS 

Events: Notification in user interface 

about I/O device port value change 
events 

Defines if the user/group receives notifications about I/O 
device port change events within the client 

Events: Sending email about I/O 
device port value change events 

Defines if the user/group receives notifications about I/O 

device port change events via email 

Events: Sending SMS about I/O device 
port value change events 

Defines if the user/group receives notifications about I/O 
device port change events via SMS 

Events: Notification in user interface 
about external data sensor 
malfunction events 

Defines if the user/group receives notifications about 
external device malfunction events within the client 

Events: Sending email about external 
Defines if the user/group receives notifications about 
external device malfunction events via email 
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Field label Description 

data sensor malfunction events 

Events: Notification in user interface 
about external data sensor events 

Defines if the user/group receives notifications about 
external device events within the client 

Events: Sending email about external 
data sensor events 

Defines if the user/group receives notifications about 
external device events via email 

User admin: Access to User 
administration 

Defines if the user/group has access to the User admin 
configuration 

User admin: Manipulate user data Defines if the user/group can change the User admin 
configuration 

User admin: Access to information 
about logged-in users 

Defines if the user/group can access the Users tab to see 
which other users are logged into the system 

Camera admin: Access to camera 
admin 

Defines if the user/group has access to the Camera 
admin configuration 

Camera admin: Manipulate camera 
configuration data 

Defines if the user/group can change the Camera admin 
configuration 

iCat: May set iCat definitions read-only 
Defines if the user/group can set iCat definitions read-

only 

iCat: Reset heat map values manually Defines if the user/group can reset heat map values 

manually 

I/O device admin: Access to I/O device 
admin 

Defines if the user/group has access to the I/O device 
admin 

I/O device admin: Manipulate 
I/O device configuration data 

Defines if the user/group can change the I/O device 
configuration 

Rule Admin: Access to rule 

administration 

Defines if the user/group has access to the Rule 

administration 

Rule Admin: Manipulate rules Defines if the user/group can change the Rule 
configuration 

Automatic Export: Access to 
automatic exports 

Defines if the user/group has access to the Automatic 
export administration 
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Field label Description 

Automatic Export: Manipulate 
automatic exports 

Defines if the user/group can change the Automatic 
export configuration 

External device admin: Access to 
device admin 

Defines if the user/group has access to the External 
device administration 

External device admin: Manipulate 

device configuration data 

Defines if the user/group can change the External device 

configuration 

Host admin: Access to Host 
administration and System 

information 

Defines if the user/group has access to the Host admin 
configuration and System information 

Client: Allow GUI layout customization Defines if the user/group can customize the layout of the 
Client 

Client: Allow window management Defines if the user/group can create and delete windows 

Client: Manage number plate lists Defines if the user/group can manage number plate lists 

Client: Modify client preferences Defines if the user/group has access to the client 

preferences 

Client: Allow saving logfiles Defines if the user/group can download the logfiles from 
the server 

 

To set privileges for all users in the system you can select and modify the root group (but please 

be aware that at each group or user level privileges can be overridden). 

6. Click Save to save your changes. 

5.3 Setting camera access rights 

1.  Choose User admin from the System administration menu. This opens the User admin 
dialog. 

2. Select the user or group you want to modify. 

Please note: The camera access rights can be set for regular individual users and Active 
Directory groups but not for regular user groups or individual Active Directory users. 

3. Click the Next button twice to get to the Camera Access Rights dialog. 

 As with the general user privileges also the camera access rights are initially inherited from the 
upper group level. Inherited camera access rights from the group level to which the user or group 
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belongs are displayed with normal font, while values that you define at the current user or group 

level are displayed in bold. 

4. Select the camera or camera group you want to look at or modify. 

5. Choose Modify selected user or group from the menu. 

6. Set the rights according to your needs. To change a camera access right click on its button and 
select the status from the pop-up menu (either Inherited, Enabled, or Disabled): 

 

Field label Description 

Live viewing: View live streams in the 
Online monitor 

Defines if the user/group can view live streams in the 
Online monitor. 

Recordings: Access camera recording 

archive 

Defines if the user/group can view the camera recording 

archive. 

Recordings: May export camera 

archive recordings 

Defines if the user/group can export archive recordings. 

Recordings: May protect archive 
against deletion 

Defines if the user/group is required to enter a reason for 
accessing an archive recording which is stored on the 

system. 

Recordings: Ask user for reason of 
accessing the archive recordings 

Defines if the user/group is required to enter a reason for 
accessing an archive recording which is stored on the 

system. 

Recordings: Manual recording control 

in Online monitor 

Defines if the user/group is able to manually start and 

stop recordings in the Online monitor. 

PTZ control (pan, tilt, zoom) and I/O 
port control 

Defines if the user/group is able to manually control 
PTZ cameras and set I/O ports. 

Camera admin: Manipulate camera or 
group configuration data 

Defines if the user/group is able to modify the 
configuration of cameras and camera groups. 

Events: Notification in client user 
interface about camera malfunction 

events 

Defines if the user/group is notified about camera 
malfunction events in the client. 

Events: Sending email about camera 
malfunction events 

Defines if the user/group is notified about camera 
malfunction events via email. 

Events: Sending SMS about camera 
malfunction events 

Defines if the user/group is notified about camera 
malfunction events via SMS. 
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Field label Description 

Events: Notification in client user 
interface about in-picture events (e.g. 
motion detection, video analysis) 

Defines if the user/group is notified about in-picture 
events in the client. 

Events: Sending email about in-
picture events (e.g. motion detection, 
video analysis) 

Defines if the user/group is notified about in-picture 
events via email. 

Events: Sending SMS about in-picture 
events (e.g. motion detection, video 

analysis) 

Defines if the user/group is notified about in-picture 
events via SMS. 

 

To set access rights for the selected user for all cameras in the system you can select and modify 

the root camera group. 

7. Click Save to save your changes. 

5.4 Working with user groups 

User groups are a powerful means to manage and organize users. For instance, you can set privileges 

for groups that are then inherited by the users belonging to this group. 

5.4.1 Creating a user group 

1. Choose User admin from the System administration menu. This opens the User admin 

dialog. 

2. In the list of users and groups, select a user group to which you want to add a new group. 

3. In the menu select Add new group which will open the new group dialog that allows you to 
define a Group name. 

4. Press Next to edit the group Privileges. The privileges are the same as for a user. Inherited 
privileges are displayed in normal font while privileges defined at this group (level) are displayed 

in bold font. 

5. Press Save to create the new group. 

5.5 Defining Online Monitor views for a new user 

If a new user needs to work in the Online Monitor then camera views need to be defined. Generally, 

there are 2 ways for doing that: 

• Login as the new user and manually create new views as described under 6.1 Creating a new 
view on page 54, or  

• copy existing views from another administration user as described under 6.8 Copying views 

between users on page 62. 
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5.6 Information about logged-in users 

Observer allows you to get information about logged-in users: 

1. Choose Users... from the System administration menu. Now you see the list of logged-in 
users with information about the host from which the user logged in, login time, total bytes 

transmitted since login, and bandwidth. 

5.7 Changing the password 

This section describes how to change passwords for users defined in Observer. For users defined in 
Active Directory/LDAP, the passwords need to be changed there. 

Each Observer administrator with the appropriate privileges can change the passwords of other users 
(see also 5.1 Creating a new user account on page 44). 

Additionally, each user can change his own password by following these steps: 

1. In the Observer menu choose Change password.... 

2. In the newly opened dialog enter the old (current) password and the new password twice. 

3. Push OK to change the password. When you login the next time, you will have to enter the new 

password. 

Please note: The optional secondary password can only be changed by an Observer administrator 

with the appropriate privileges. 

5.8 Working with Active Directory and LDAP users 

The configuration of Observer to work with users from Active Directory and LDAP is covered in chapter 

13 Active Directory Integration on page 124. 

Note: Active Directoy usernames are not case-sensitive. 
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6 Using the Online Monitor 

In the Online Monitor you can view live streams from cameras that are set up at the Observer server. 
The prerequisite is that you must have authorization to access the Online Monitor (see 5.2 Setting 

general user privileges on page 46). Furthermore, you can access only those cameras for which you 
have access rights (see 5.3 Setting camera access rights on page 50). 

When a new user logs in the first time he will encounter an empty Online Monitor waiting for new 
camera views to be defined. Once you have defined your views they will reappear next time you log in. 

You can also have several Online Monitors in multiple windows (see 2.3 Client multi-window and multi-
screen operation on page 17). 

Important: If you are using a low-bandwidth connection between client and server (e.g. via wide area 

networks) it can happen easily that the video streams cannot pass through the connection fast 
enough, which results in bad frame rates and slow responsiveness of the client. In such a case you 

should use the Transcoding feature of Observer. See 2.6 Observer Transcoding for low-bandwidth 
client-server connections (ABS) on page 27 for further details. 

6.1 Creating a new view 

Observer lets you create an unlimited number of named views. Each of these views can contain up to 

100 camera view ports. 

1. Choose Create new view (either from the empty Online monitor or from the Control menu) to 
open the Create new view dialog. 

2. You can now choose the layout for your view from predefined templates and you also can define 

an arbitrary matrix of up to 10 x 10 views. A new dialog is opened asking for the name of the view 

and the aspect ratio for the view ports. 

The Name of view is shown in the view selector at the top of the screen. Please note that you 

can also create a view hierarchy by using a colon between the names. In the example below we 
created a view in the group called “First floor” with a name “Entrance hall”. There might also be a 
view called “Office 1” or “Kitchen”. 

The Aspect ratio pop-up defines the aspect ratio of the view ports in the view: 

o Fixed aspect ratios: PAL, NTSC, VGA, double VGA, or HDTV 16:9. 

o Fill available space: This is the default setting and will adapt the view port size (and 
hence the aspect ratio) to fill the available space. 

o Custom aspect ratio: here you can freely define an N:M aspect ratio. 

The setting Stretch image to fit into view port (selected by default) defines whether a camera 
image can be stretched to fit into the view port. This may cause distorted images for aspect ratios 
that do not fit the current view port aspect ratios. 

The setting Crop image to fit into view port defines whether a camera image can be cropped 
to fit into the view port. This may cause that some parts of the image are not visible in the view 
port. In the section 6.4 Modifying view port settings on page 57 you can define what part of the 
cropped camera image is to be shown in the view port. 
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Please select an aspect ratio that fits most of your cameras you plan to show in the view. 

Selecting an improper aspect ratio can lead to unused space on the screen. 

Press OK to create a new view with these settings. 

3. In accordance with the selection above, Observer creates a new view that might look as follows 

(your view may have a different number of view ports depending on what you selected: 

 

The view ports fill the central part of the window, and each view port has its own view port 
controls. 

At the right side of the window is the Event list, which is explained in 9 Handling events on page 

92. 

4. Choose Save all view settings from the menu in order to save all settings for your current user. 
The next time you log on to Observer, all views will then be available again. If you neglect to save, 
all changes are lost when you exit the application. 

5. You can change the name of the current view with Rename view in the Control menu. 

Please note: All view settings will be stored, also image quality and frame rate settings of view ports. 
New views will be stored automatically without the need to save manually. 

6.2 Selecting cameras 

1. In the view port press the Add camera button. Please note that you first have to set up a camera 

before you can select it in one of the view ports (see 4 Setting up cameras on page 31). This opens 
the camera tree. 

2. Select a camera from the camera tree. 
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You can either: 

o select a camera and press the  Select button, or 

o double click on a camera to add it to the view port where you press Add camera, or 

o drag and drop a camera to the view port of your choice 

3. Proceed in the same way with additional view ports in your view. 

4. You can assign multiple cameras to each view port. However, since you can only view one 
camera image in each view port, Observer lets you manually switch between cameras by clicking 

on the camera selection menu at the upper left corner of the view port. 

 

5. In the camera selection menu of a view port you can also select the option Shuffle. Then 

Observer cyclically switches through all the cameras assigned to the view port. 

6. Please select Save all view settings from the view Control menu in order to save all settings. 

The next time you log in to Observer, all views and view ports will be available again. 

6.3 Navigating in the Online Monitor 

You have several options for navigating in the Online monitor: 

• Select a view from the View dropdown menu. 

• Select a Round tour from the Round tour dropdown menu. 

• Use the Next/Previous view buttons or the corresponding options in the context menu 

(accessible via a right mouse button click) to navigate to the previously displayed views. 
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• Double click in a view port to get a big view of the currently displayed camera in the view port. If 
there is a view defined containing a big view port with the camera, then this view will be shown. 
Otherwise a new temporary view with the camera will be created. You can then go back to the 
previous view with the Previous view button or the corresponding option in the context 

menu. Please see below for a few hints on how to manage big views of cameras. 

6.3.1 Optimizing big views of cameras (views opened after a double click) 

When you double click on a view port with a camera then Observer does the following:  

1. It first tries to open up an already existing big view that contains the camera, or 

2. If such a view does not exist, a new temporary view will be created. For the new view some 
parameters such as the frame rate will be taken from the corresponding camera's default 
configuration whereas the following parameters are inherited from the view port it is derived from: 

• Video stream type (MJPEG, MPEG-4, H.264 or MxPEG) 

• Aspect ratio, incl. different custom aspect ratios 

• Crop or stretch parameters 

• Current crop positioniCat 

•  view options 

Note: The new big view only inherits these parameters upon its initial creation. Subsequent 
changes made in the original view port (e.g. video stream type or iCat view options) will not affect 

the big view. 

To create a permanent big view for a particular camera: Create a view with this camera and adapt 
the settings (see 6.1 Creating a new view on page 54 for details). Then a double click will open that 
view. You can group those big camera views into view groups by supplying view group names such as 
"Big:cam1", "Big:cam2" and so on.  

6.4 Modifying view port settings 

Netavis Observer allows you to set various options including video quality of either single view ports or 

all view ports in the current view at once. 

The settings of a single view port can be modified via the view port's control menu  that appears 
in the upper right corner of a view port when you move the mouse pointer over the view port. 

The view port control menu offers the following options: 
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6.4.1 Adding and removing cameras  

Cameras can be added and removed with the Add camera and Remove camera menu entries. 

Please refer to section 6.2 Selecting cameras on page 55 for more details. 

6.4.2 Controlling PTZ cameras 

The PTZ menu allows PTZ control and is enabled for PTZ cameras (see 10.4.1 Controlling PTZ cameras 

in the Online Monitor on page 101). 

6.4.3 Set stream profile 

The Set stream profile menu allows you to select which of the previously defined stream profiles 

should be shown in the view port. This setting can also be modified for all view ports in the current 
view via Set parameters of all view ports from the Control menu. 

Note: When modifying all view ports at once the selected options are only set for the view ports with 
cameras which support the desired options. 

6.4.4 Controlling video analysis (iCat) display  

The iCat menu offers various options for displaying iCat-related video analysis information. Please 

refer to 15.4 Working with iCat on page 164 for further information. 

6.4.5 Replaying archived images 

The Replay archived images menu offers the option to directly jump into the Archive Player to 

replay the previous 10 minutes, 1 hour, 24 hours or 1 week of recordings of that camera. An error 

message is displayed in case no such recordings are available. 
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6.4.6 Defining a crop area 

For views where you have the Crop image to fit view port setting selected, you can define what part 

of the cropped camera image you want to see by choosing Define crop area... from the menu. 

6.5 Zooming in a view port and in archive recordings 

Observer allows you to zoom view ports in the Online monitor and in the Archive player. 

Basically, you have two ways to zoom a view port or a recording in the Archive player: 

6.5.1 Zooming with the mouse wheel 

1. Just move the mouse pointer over a view port and turn the mouse wheel. The view port will zoom 
accordingly. 

2. You can move the zoomed area in a view port by dragging it with the mouse. 

3. Use the mouse wheel again to zoom out. 

6.5.2 Zooming by drawing a zoom rectangle 

1. With the mouse draw a rectangle in a view port. 

2. Click in this rectangle, which will cause the view port to zoom accordingly. 

3. You can position the zoom by dragging the rectangle. You can also modify its size by turning the 

mouse wheel. 

4. Click outside the rectangle to return to normal (not zoomed) view. 

5. You can remove the zoom rectangle by clicking into it with the mouse and pressing the Delete or 

Backspace key. Alternatively, you can drag the rectangle outside of the view port to remove it. 

You can also have multiple zooming rectangles per view port. 

Showing a zoomed view in another view port (Online monitor only) 

1. Draw a zoom rectangle with the mouse. 

2. Click into another view port. Now the zoomed area is shown in the other view port. 

3. You can position the zoom by dragging the rectangle. 

4. You can remove the zoom by clicking the rectangle with the mouse and pressing the Delete or 

Backspace key. Alternatively, you can drag the rectangle outside of the view port to remove it. 

Removing a rectangle will also remove the zoomed view from the other view port. 

Please note: When PTZ control is enabled, any mouse actions are taken for PTZ control. In order to 

control the view port zooming, hold down the CTRL key while using the mouse. 

6.6 Manual recording control in the Online Monitor 

In addition to programmed recordings, you can also manually start and stop continuous recordings 
directly in the Online monitor. When manual recording control is set up, a recording button is shown in 
camera view ports in the Online monitor. 
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6.6.1 Setting up manual recording control 

To enable recording control, you must do 2 things: 

• Enable the manual recording camera access right for the user 

• Set up a continuous recording schedule for the camera. The continuous recording schedule 

that is active at the time when the user pushes the manual recording button defines the format 
of the recording. Therefore you can also have different manual recording formats for different 

times in the day or week. 

Enable the manual recording camera access right 

Here is how to set the camera access right for manual recording (see 5.3 Setting camera access rights 

on page 50 for a general description on how to set camera access rights): 

1. Login as administrator user (or another user with the right to modify user data). 

2. Choose User admin from the System administration menu. This opens the User admin 

dialog. 

3. Select the user or group for which you want to enable manual recording control. 

4. Click the Next button twice to get to the Camera Access Rights dialog. 

5. Select the camera or camera group for which you want to enable manual recording control. 

6. Choose Modify selected user or group from the menu. 

7. Enable the right Manual recording control from Online monitor by choosing Enabled from 
the pop-up menu. 

8. Push Save to save your changes. 

Set up a continuous recording schedule 

In order to use manual recording control for a camera you have to define a continuous recording 

schedule (please refer to 7.1.1 Scheduling continuous recordings on page 72 for a general description of 
setting up schedules for continuous recordings): 

1. Choose Camera admin from the System administration menu. This opens the Camera 

admin dialog. 

2. In the camera tree select the camera for which you want to set up the recording schedule. 

3. At the bottom of the screen, click on the Next button twice. This takes you to the Scheduling 

dialog. If you are setting up a new camera, this dialog will be quite empty. 

4. In the menu select Modify selected camera or group. 

5. Click the Add button to add a schedule slot to the Time Intervals list. 

6. Click the Change button and choose Continuous recording. 
Now the Scheduling dialog shows the settings for configuring continuous recording. 

7. Now you can define the days and times for the recordings. You can activate individual days or, 

with the All button, the whole week at once. Select hours and minutes from the popup matrix. 

If you want that recording can only be started manually then make sure that the Enable 
interval checkbox is disabled. 

Note: When a user pushes the manual recording button in the Online monitor actually the 

Enable interval checkbox is toggled. This causes the recording to either start ort stop. 
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8. Set all the recording options as described in 7.1.1 Scheduling continuous recordings on page 72. 

9. Click on Save to save your settings. 

6.6.2 Manually controlling recordings in the Online monitor 

When everything is set up as described above then for the enabled user and camera a manual 
recording button is shown in any view port displaying the camera. 

 

You can switch recording on and off by pushing the manual recording button. The recording state is 
shown by the color (a strong red dot means recording is on, otherwise recording is off). 

Please note: For times not covered by a continuous recording schedule no manual recording button 
is shown. 

6.7 Working with round tours (the Smart guard function) 

Observer allows you to make virtual round tours of views. You can define round tours that contain 

certain views. When a tour is started, Observer walks you through all the views by automatically 
showing up the views in the Online monitor. This is like a virtual patrol of a security guard (Smart 

guard function). 

6.7.1 Defining a round tour 

Steps to add a new round tour: 

1. In the Online monitor choose Round tours… from the view Control menu. Now the Round 
tours dialog opens. 

2. In the Round tours dialog push the button Add new round tour. 

3. In the Tour name field enter the name of the round tour.  

4. Now you can select a view from the Views list and push the  button to include it in the tour. 

By pushing the  button you can remove a view from the tour. You reorder views in the tour by 

pushing the Up  and Down  buttons. 

Please note: You can have the same view several times at different locations in a round tour. 

You can select multiple views in the Views list at once by holding the CTRL key while selecting 
the views. 
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5. For each view you can set a Shuffle duration that determines, how long (in seconds) this view is 

shown before Observer automatically changes to the next view in the tour. By pushing Set for all 
you can set the same duration for all view in the round tour. 

6. Push Save to save your changes and OK to leave the dialog. 

Later on you can modify an existing round tour by opening the Round tours dialog and then choose 
an existing round tour from the Round tours list and push Modify round tour. 

A tour can be deleted by opening the Round tours dialog and then choose an existing round tour 
from the Round tours list and push Delete round tour. Then you have to enter your password to 

confirm the delete. 

6.7.2 Activating round tours 

After you have defined a round tour, a new Round tour selector appears in the Online monitor. To 

activate the round tour, just choose its name from the Round tour selector. This activates the 
automatic walkthrough all of the views in the round tour (Smart Guard function). The name of the 
round tour now appears in green to show that it is active. You can stop the tour by choosing a view 

from the View selector (the Round tour selector will change its color to normal to show that no tour 

currently is active). 

6.8 Copying views between users 

If there are several users in a system it can be a lot of work to create views for each user individually. In 
order to help, Observer offers the possibility to copy a selected view or all views (including all view 
settings) of an administrator user to other users. It is important that the user who copies the views to 

other users must have user administration rights (more specifically: „User admin: Access to User 
administration“ and „User admin: Manipulate user data“). 

Please follow these steps: 

1. Login as the user from whom you want to copy the view(s) and go to the Online monitor. 

2. Create the view(s) you want to copy. Please note that only saved settings are copied. 

3. Open the view you want to copy, open the view's Control menu and choose Copy current 

view to other users…:  

 

4. Now a user selection dialog opens: 
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5. Select the user you want to copy the current view to, whereby views can only be copied to 
logged-out users and your own account. You can then choose one of the user's windows or 
select Create new window as a target for the current view. After you have finished the selection 

press the Copy button. Now the selected user receives a copy of the current view in the 

designated window.  

Hint: Multiple users can be selected by holding down the CTRL key while clicking on user names. 
When selecting multiple users it is only possible to select Create new window as a target for 

the current view. So if you want to copy one or all views to specific windows (as opposed to a 

newly created window) of multiple users you have to copy them to each user individually. 

6. The user who received the views has to log-in again in order for the changes to take effect.  

You can also copy all views of the current user by choosing Copy all views to other users… from the 
view's Control menu. 

Please note: If the users already have views with the same name as the copied views, then the 
existing views will be overwritten by the newly copied ones! 

6.9 Working with MPEG cameras and audio (MPEG-4, H.264, H.265, and MxPEG) 

Note: In the current version of Observer, MPEG and bidirectional audio is only supported by clients 

running on MS Windows. For further details please refer to 2.1 Introduction to Observer clients on page 
11. 
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Observer also supports MPEG cameras (MPEG-4, H.264, H.265, and MxPEG) with audio streaming (see 

also 4.2 Adding a new camera and basic configuration on page 31). 

If the camera allows MPEG streaming, you can select the MPEG streaming format from view port 
control menu. Once the MPEG streaming is activated, additional MPEG controls appear on the view 
port(s):  

 

These controls allow you to see and modify Audio aspects: 

Audio from the camera:  indicates that audio from the camera is on.  indicates that audio from 
the camera is off. A click on the icon turns it on or off. 

Audio to the camera:  indicates that audio from your microphone to the camera is on.  indicates 
that audio from your microphone to the camera is off. A click on the icon turns it on or off. 

If you have the Default settings in the Camera Admin set to Audio from and to share single 
button then you will see only one control icon: Bidirectional Audio:  indicates audio in both 

directions is on (loudspeaker and microphone is on).  indicates that audio in both directions is off 
(loudspeaker and microphone is off). 

6.10 Dynamic View Control in Online Monitor 

The use of dynamic views triggered by iCat and motion detection events was significantly simplified by 
the addition of a new configuration menu in Observer 4.5. Combined with the dynamic view control 
feature, archive access within the Online Monitor view ports now allows operators to quickly view 

event-triggered recordings without having to switch to the Archive. They are therefore able to keep an 
eye on live camera-streams while reviewing critical events. 

Hint: Aside of controlling views with iCat and motion detection triggers, it is also possible to control 

them with the Matrix view function (see 23.4 Matrix View function of the Online Monitor (VIP control) on 
page 195 for more details). 

6.10.1 Controlling views via iCat events 

Dynamic view configurations can be added to any of iCat triggers such as motion detection (MD), 
object tracking event trigger, sabotage detection, etc. Once the iCat definition is activated, the 
associated dynamic view is shown. 

Here are the steps to control dynamic views via an iCat definition: 

1. Choose Video analysis (iCat) from the System administration menu. This opens the Video 
analysis (iCat) dialog. 
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2. Select a camera and for the camera select an iCat definition. 

3. Choose Modify selected definition from the menu. 

4. Click the button next to the Dynamic view action field where you are presented with three 
options: 

• No action means that the Online Monitor's views are not changed. This is the default 
option for all iCat definitions. 

• Show camera's live stream in large view results in the live stream of the camera 

which triggered the iCat definition being shown in a large view. This option supports three 
different modes: 

o Current camera: The camera's live stream is shown on all connected clients. 

o Camera-user pairs: A list of camera-user pairs can be configured which specifies 

which cameras' large views are shown on the clients when the respective users are 
connected. 

o Camera-IP Address pairs: A list of camera-IP Address pairs can be configured 

which specifies which cameras' large views are shown on the clients connected 

from the respective IP Address. 

 

Additionally you can define in which Online Monitor Window the large view should be 
shown. For configurations which concern multiple users the largest common subset of 
available windows will be shown. With the Current camera mode only Window(1) is 

supported. 
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• Show live streams in view can be configured with Additional cameras, a selection of 

Users, Windows, and Views (please note that view ports used for dynamic view 
configurations should not be modified manually, e.g. by new adding cameras to them). 

Multiple cameras and users can be selected (and deselected) by keeping the CTRL button 
pressed. For single user configurations it is also possible to limit the feature to clients 
connected from a certain IP address. Show live streams in view offers three different 

modes: 

o Replace oldest view port (first in, first out): The newest iCat events are always 
displayed in the "oldest" view ports (the view ports that stood there the longest 
without a camera change). Thus it is possible to create a view where always 

cameras with the newest events are displayed. 

o Shift older view ports (from top left to bottom right): The newest iCat events 

are always displayed in the top left view port with all other camera views shifting 
towards the bottom right. Cameras in the lower right view port are removed from 

the view. Thus it is possible to create a view where cameras with the most recent 
events are always displayed at the top left position. 

o Insert into empty view ports: The newest iCat events are always displayed in 

empty view ports and each view port has a close button . When the user clicks 
the close button, the cameras are removed from the view, freeing the view port for 

another camera to be shown. Thus it is possible to create a view where cameras 

with the most recent events are always displayed and stay there until they are 

manually closed by the user. 

Please note: When all view ports of the view are filled, no new cameras will be 

shown until a view port is freed. 
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For the Show camera's live stream in large view and Show live streams in view options 
there are also Picture in Picture features which can be enabled: 

• Show event in view port's event line: This option enables a list which keeps track of 
the events which occurred in the view port. To navigate between the events turn the 

mouse wheel up and down while hovering over the list at the bottom of the view port. By 

double clicking on an event in the list the Event details dialog is shown, whereby the 
Acknowledge and next, Previous, and Next buttons are disabled. 

 

Please note: The background color of the event line is the Highlight color which has 
been set for that iCat or motion detection definition. As of Netavis Observer 4.5 and 

similarly to the camera name label it is also possible to change the size (CTRL key + mouse 

wheel up or down) and contrast (CTRL + Shift keys + mouse wheel up or down) of the 
event list. 



Netavis Observer 5.1 User Manual (February 2021) 

Page 68 of 214 

 

• Show archive event replay in view port: This option enables Archive Access from 
within the Online Monitor view port which contains the camera which triggered the iCat 

definition. It can only be used if the Show event in view port's event line option is 
enabled. 
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To watch the event you can either drag the timeslider to the corresponding position or 

click on the preview window to watch 10 second segments of the recording. 

The Archive Access window can be moved by pressing the CTRL key and dragging the 
window with the mouse and it can be resized by pressing the CTRL key and turning the 

mouse wheel. 

The event line and archive replay window are automatically removed when all the 

cameras in the corresponding view port are removed. 

Please note: Until all the cameras are removed the event list and archive playback 

window configuration in the corresponding view port stay the same as configured in the 

definition of the iCat or motion detection event which first triggered a video stream to be 
shown in it.  

5. Alternatively it is also possible - but not generally recommended - to use the Comment field to 
add a dynamic view command to an iCat definition. 

pop: <mode>,<view-name>,<window-ID>,<viewport-eventline>,<viewport-archive-
replay>; <additional-camera-IDs>; <user-names>; <IP-addresses> 

where: 

<mode> is one of: 

• 1: shows the camera in a large view. 

• 2: shows the camera and optional <additional-camera-IDs> in the view named <view-

name> (must be supplied). The cameras are placed in the "oldest" view ports (view ports 
that stood there the longest without a camera change). Thus you can create a view where 

always cameras with the newest events are displayed. 
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• 3: shows the camera and optional <additional-camera-IDs> in the view named <view-

name> (must be supplied). The cameras are placed row-wise starting at the top left view 
port. The cameras that were in these view port before are shifted to the right. Cameras at 

the lower right corner of the view therefore are removed from the view. Thus you can 
create a view where cameras with the most recent events are always displayed at the top 
left position. 

• 4: shows the camera and optional <additional-camera-IDs> in the view named <view-

name> (must be supplied). The cameras are placed in empty view ports. They have a 
close button associated with them. When the user clicks the close button, the cameras are 
removed from the view, freeing the view port for another camera to be shown. 

Thus you can create a view where cameras with the most recent events are always 

displayed and stay there until they are removed by the user. Please note: When all view 
ports of the view are filled, no new cameras will be shown until a view port is freed. 

• 5: similar to mode 1 it shows the camera in a large view. The optional <additional-

camera-IDs> are paired one-by-one with the <user-names>. This causes that these 

additional cameras are shown in large view at the clients where the supplied users are 
logged in. 

• 6: similar to mode 1 it shows the camera in a large view. The optional <additional-
camera-IDs> are paired one-by-one with the in the <IP-addresses>. This causes that 

these additional cameras are shown in large view at the supplied clients workstations. 

<window-ID> defines the window which will be used 

<viewport-eventline> defines whether the events will be shown in the view port's event line 

whereby 0 disables this functionality and 1 enables it. 

<viewport-archive-replay> defines whether the archive event replay is shown in the view port 

whereby 0 disables this functionality and 1 enables it. This functionality can only be used if the 

<viewport-eventline> option is enabled. 

<additional-camera-IDs> is an optional comma-separated list of camera IDs which should be 

shown in addition to the camera that triggered the event. 

<user-names> is an optional comma-separated list of user names to notify. If not defined, then 

all users are going to be notified. 

<IP-addresses> is an optional comma-separated list of client workstation IP addresses to which 

the notification is sent. If not defined then all connected workstations are going to be notified. 

Examples of commands to be used in any iCat comment field 

pop:1;;; 

shows a live view of the camera which triggered the event in all connected client sessions. 

pop:2,my-view;3,4;; 

shows live view of camera which triggered the event and the cameras with IDs 3 and 4 in the view 

named "my-view" in all connected client sessions. 

pop:3,my_fifo;3,4;christoph;192.168.7.12 
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shows a live view of camera which triggered the event and the cameras with IDs 3 and 4 in the 

view named "my_fifo" where the IP address of the client workstation is 192.168.7.12 and user 
'christoph' is logged in. 

pop:4,my_dynamic;3,4;; 

shows live view of camera which triggered the event and the cameras with IDs 3 and 4 in the view 

named "my_dynamic" in all connected client sessions. 

6. Press the Save button. 
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7 Working with archive recordings 

This section shows you how to work with the Observer recording archive, particularly in the following 

areas: 

• Programming archive recordings (timed or triggered by iCat (video analytics) events)  

• Selection and playback of archive recordings 

Please note: In order to work with archive recordings you need to have the appropriate user 
privileges and camera access rights (for further details see 5.2 Setting general user privileges on page 

46 and 5.3 Setting camera access rights on page 50). 

7.1 Programming archive recordings 

Two types of programming are available in Observer: 

• timed recording 

• recording on iCat (video analysis) events like motion detection or people counting 

To be able to program recordings, you need corresponding user privilege. 

7.1.1 Scheduling continuous recordings 

With Netavis Observer 5.1 the previously available Camera admin page "Scheduling" has been 
replaced by the newly designed camera properties page, an updated camera wizard (see 4.2 Adding a 

new camera and basic configuration on page 31 for details), and Schedule Admin (see 21 Schedule 
Admin on page 187 for details). Please see the referenced chapters and sections for how to configure 

and schedule continuous recordings. 

7.1.2 Scheduling video analysis (iCat) operation and recording 

For information on how to schedule video analysis (iCat) operation and recording please refer to 
section 15.3.16 Scheduling iCat video analytics and recordings on page 164. 

7.1.3 Event-triggered recordings 

The option Event-triggered recordings can be used to create schedules which control when 
externally triggered events handled by Observer's Event Management System (EMS) are recorded. 

7.1.4 Operation of the Observer dynamic storage management 

In the Scheduling dialog you can specify the Requested recording period property that defines 
how long recordings are to be kept by Observer. Any recordings that are older than the requested 

recording period are automatically deleted as long as you do not manually protect them from deletion 
(see 7.2.8 Protection of recordings against automatic deletion on page 79). 

For cases like motion detection-based recording it can be very difficult if not impossible to estimate 
the required storage space and therefore space for all requested recordings could be too short. To 
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help with this hopefully rare case, Observer uses an intelligent storage management process. This 

process always tries to store all requested periods for all recorded cameras. 

However, if there is not enough space available, the allocation process is doing two things: 

• It generates a system event once a day and sends an email to the Observer administrator telling 

him that there is not enough space for all recordings. 

• It automatically truncates the recordings of cameras to allow a proportionally even distribution 

of the available space among all cameras. 

For some special cameras that have to record the requested storage period in any circumstances, 
Observer offers the Priority over other cameras (if storage space is short) flag. If this flag is set 
for a camera, Observer always tries to store the requested period for this camera and truncates other 

cameras that do not have this flag set a little more. If there is more than 1 camera that has the flag set, 

the storage management process tries to store all of those cameras. 

Algorithm of the dynamic storage management process:  

Fill-time-percentage (FTP) = 100 * Actual-recording-time / Requested-recording-time. 

Observer tries to keep the FTP of all cameras of each of the two priority classes the same (high-priority 

cameras and lower-priority cameras). First the algorithm tries to fully record the high-priority cameras 
and then use what is left for the lower-priority ones, whereby all of those will reach the same FTP. 

However, the low priority cameras can never go below an FTP of 10%. If the low priority cameras reach 
a level of 10%, then the storage management process starts truncating the archives of the high priority 

cameras as well. Anyway, this should never happen in a normal case and is only possible if the storage 
space is totally insufficient for holding the programmed recordings. 

Since the storage management process considers recording time and not recording space for 

distributing the available space, it happens that the relatively small recording space of a camera with a 
low recording frame rate is truncated in the same proportion like the relatively big recording space of a 

camera with a high recording frame rate. 

Caution: Please be careful when you set the Priority over other cameras flag since, if storage space 

is short, Observer truncates the archives of all other cameras in favor of this camera. If available 
storage space is much too short relative to the requested storage periods of all cameras, this can lead 

to strongly truncated archives. 

7.2 Playback of archive recordings 

Observer features a multitude of powerful functions for working with archives. 

7.2.1 Selecting the camera and the playback period 

1. Go to the main window and choose the Archive player (if the Archive player is not available, 
then perhaps it is disabled in the client preferences; see 2.3 Client multi-window and multi-screen 
operation on page 17). 

Either the Camera tree appears immediately or you have to push the Select camera button 
: 

2. Select the camera from the camera tree and push Select (you can also double click a camera or 
drag it to the calendar view). An overview for the selected camera on the current day is displayed: 
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This one-day overview shows green blocks indicating minutes for which recordings have been 

archived. A red corner in a block indicates that an event was triggered and an event recording 

was started in that minute. 

When you move the mouse pointer over a green block, then the first recorded frame of this 

minute is displayed in the lower right corner of the window. 

You can also switch to a monthly or an annual overview via the View button and its popup 

menu. 

 

Here is an example of a month view for the camera: 
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3. With the mouse select the time span of the archive that you want to play back. To do this press 

the left mouse button at the start of the time range, then move the mouse pointer to the end of 
the time range and then release the mouse button. The color of the selected time range changes 

to dark green. 

 

4. Also select the playback acceleration by moving the Playback acceleration slider (default 

value is 1). At the slider you can see in parentheses how long the selected time will need for 
playback at the selected playback acceleration.  

5. Now click the Playback button . This brings you to the Player view and the images for the 

selected time span are loaded from the server and then will be replayed with the specified 
acceleration (you can cancel the loading process by pushing the Cancel button). 



Netavis Observer 5.1 User Manual (February 2021) 

Page 76 of 214 

 

In the Playback view you have several possibilities: 

• Automatic or manual fast forward and rewind of recordings 

• Selection and playback of a time frame (time zooming) 

• Synchronous playback of recordings of up to 4 cameras 

• Export of individual images as well as the selected video sequence 

7.2.2 Moving forward and back in the recording  

Automatic playback: By clicking the Playback buttons  or  you can let the recording 

automatically play forward or backwards. (Due to the archive storage mechanism backwards playback 
might be a little jumpy with MPEG-4 and H.264 streams.) With the Playback Speed slider at the left of 

the window you can vary the playback speed. Press the Stop button  to end playback. 

Manual playback: By clicking and moving the green Playback marker , you can control the 

playback of images manually. 

You can select the size of the playback by clicking the Original size button at the lower left of the 

Player dialog. Here you have the possibility to choose from various sizes. 

7.2.3 Zooming in a view port and in archive recordings 

Observer allows you to zoom view ports in the Online monitor and in the Archive player. 

Basically, you have two ways to zoom a view port or a recording in the Archive player: 
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Zooming with the mouse wheel 

1. Just move the mouse pointer over a view port and turn the mouse wheel. The view port will zoom 
accordingly. 

2. You can move the zoomed area in a view port by dragging it with the mouse. 

3. Use the mouse wheel again to zoom out. 

Zooming by drawing a zoom rectangle 

1. With the mouse draw a rectangle in a view port. 

2. Click in this rectangle, which will cause the view port to zoom accordingly. 

3. You can position the zoom by dragging the rectangle. You can also modify its size by turning the 
mouse wheel. 

4. Click outside the rectangle to return to normal (not zoomed) view. 

5. You can remove the zoom rectangle by clicking into it with the mouse and pressing the Delete or 

Backspace key. Alternatively, you can drag the rectangle outside of the view port to remove it. 

You can also have multiple zooming rectangles per view port. 

Showing a zoomed view in another view port (Online monitor only) 

1. Draw a zoom rectangle with the mouse. 

2. Click into another view port. Now the zoomed area is shown in the other view port. 

3. You can position the zoom by dragging the rectangle. 

4. You can remove the zoom by clicking the rectangle with the mouse and pressing the Delete or 

Backspace key. Alternatively, you can drag the rectangle outside of the view port to remove it. 

Removing a rectangle will also remove the zoomed view from the other view port. 

Please note: When PTZ control is enabled, any mouse actions are taken for PTZ control. In order to 

control the view port zooming, hold down the CTRL key while using the mouse. 

7.2.4 Playback of a time frame (time zooming)  

 

1. The red and blue markers   let you select a smaller time interval for detailed playback. 

Alternatively, you can click the Set Blue Marker button  or Set Red Marker button  to set 
the respective marker at the current position of the green Playback marker. 

2. Click the Zoom in button  to load and replay the time interval between the blue and red 

markers. 
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7.2.5 Playback with audio 

If the recording also includes audio (i.e. the recording has been done with MPEG-4 or H.264 and with 

Audio recording enabled), then you can decide whether you also want to replay audio. By default 
Audio is switched off, when you replay. To toggle audio on or off, select Control menu - Enable 
speaker in the Playback view. 

7.2.6 Synchronous playback of up to four recordings 

1. Select the playback time frame for the first camera as described above. Then change to the 
Player view. 

2. Click the Synchronous Playback button , which opens the Camera tree, where you can 
select the second camera for synchronous playback. 

3. Repeat camera selection until you have up to 4 cameras for synchronous playback. 

The following illustration shows synchronous playback of two cameras: 

 

Note: Synchronous playback always loads one frame or GOP for each selected camera after each 
other. 

7.2.7 Displaying video analysis (iCat) information for recordings 

The iCat submenu in the Control menu offers various options for displaying iCat-related video 
analysis information also for recordings. Please refer to 15.4 Working with iCat on page 164 for further 
information. 
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7.2.8 Protection of recordings against automatic deletion 

Normally Observer automatically deletes recordings that are older than the Requested recording 

period in order to free space for new recordings. For cases where you want to keep certain scenes 
longer than the requested recording period you can protect arbitrary periods against automatic 
deletion. Here is how you can do that: 

1. In the Archive go to the Calendar view and select a camera. 

2. In the calendar select the period you want to protect against automatic deletion. 

3. Press Protect selected images against deletion. 

Now the color of the selected period in calendar turns to a different color which shows that the 

images are protected. 

To unprotect a protected period you must select this period in the Calendar view and Press 
Unprotect selected images. 

With the Day limit of remove protected archive option (see 11.2 Setting Observer server 

parameters on page 109) it is possible to limit the time that these manually protected recordings are 
stored. Afterwards they are deleted automatically. 

Caution: Please be careful when using this feature. Unless you set the aforementioned Day limit of 
remove protected archive option the protected recording periods will never be deleted 

automatically by Observer. This means that the space will be locked as long as you keep them 
protected. 

7.3 Exporting recordings (images and video sequences) 

Observer allows you to export individual images and video sequences in various formats: 

• JPEG: for single images 

• AVI DivX: for video sequences 

• SAFE: This is a proprietary format that stores the video together with the player in an executable 
format (.exe) that can be run on MS Windows platforms. The file can be password protected (up 
to 10 characters) and you can export synchronous video sequences of up to 16 cameras 

simultaneously. 

The following sections describe how you can export from the recording archive. In 9.2.2 Exporting 

event-related recordings on page 96 you learn how to export recorded video sequences based on 
events. 

7.3.1 Exporting a single JPEG image (the current frame) 

1. In the Archive, select a camera for the export. 

2. In the Calendar select the time for exporting the image. 

3. In the Player move to the picture you want to export and click the Export button  to open 
the Export dialog. 

4. Choose Current image (JPEG) from Export format. 

5. Enter a file name for the image to be saved. 

6. Mark the first checkbox if you want to overwrite a file of the same name that might exist. 



Netavis Observer 5.1 User Manual (February 2021) 

Page 80 of 214 

7. When you click OK a file dialog will be opened asking where on your client computer you to want 

to save the file. Select the location and confirm. 

8. Now you can use the exported file. 

7.3.2 Exporting a recording in AVI DivX format 

1. In the Archive player, select a camera for the export. 

2. In the Calendar select the time period for exporting. 

3. In the Player view or in the Calendar view click the Export button  to open the Export 
dialog. 

4. You have two AVI options for Export format: 

• AVI (all images): This exports a video sequence with all the frames of the currently 
selected time frame (regardless of the Playback acceleration setting). 

• AVI (Subsampled movie): This exports the time-lapse playback with the settings of 

the Playback acceleration slider. E.g. if you have selected a Playback acceleration 
of 3, your exported file will be roughly a third of the size of an AVI (all images) export. 

See also 7.2.1 Selecting the camera and the playback period on page 73. 

5. Enter the file name of video to be exported.  

6. Mark the first checkbox if you want to overwrite a file of the same name that might exist. 

7. When you click OK, a file dialog will be opened asking where on your client computer you to 

want to save the file. Once you select the location and confirm, a File download progress 

dialog will show the state of the export. You can cancel the export anytime by pushing Cancel. 

Note: To play back exported video sequences with Microsoft Media Player, you need the DivX codec. 
You can download this for free from www.divx.com/divx. 

7.3.3 Exporting a recording in SAFE format 

1. In the Archive, select a camera for the export. 

2. In the Calendar select the time period for exporting. 

3. In the Player view or in the Calendar view click the Export button  to open the Export 

dialog. 

4. Choose SAFE (All images) from Export format. 

5. Enter the Filename for the video sequence to be exported. Check the Overwrite old file 

checkbox if you want to overwrite a file with the same name. 

6. Optionally you can create a Multi camera export (synchronous video sequences) by clicking on 

the Select camera button . This opens the camera tree in which you can select multiple 
cameras by holding the CTRL key while clicking on the cameras. 

7. Enter an Export file label which should describe the exported scenes. 

8. Optionally you may enter an Export file password (which needs to be confirmed by entering it 
a second time in the text box below). This password is required when opening the exported file. 

Caution: Do not forget this password because otherwise you cannot open the exported file. 

9. When you click OK, a file dialog will be opened asking where on your client computer you to 
want to save the file. Once you select the location and confirm, a File download progress 

dialog will show the state of the export. You can cancel the export anytime by clicking Cancel. 

http://www.divx.com/divx
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10. The exported file is an executable for MS Windows 8/7/Vista/XP. Below you can find a screen of 

the running SAFE Player: 

 

Zooming in exported SAFE video sequences 

You can zoom into parts of the camera view by drawing a rectangle and then clicking in the rectangle. 

You can drag a zoomed view with the mouse. Alternatively you can show the zoomed view in a 

separate window by selecting View > Separate zoom window. You can also use the mouse wheel to 
zoom in and out. See also 7.2.3 Zooming in a view port and in archive recordings on page 76. 

Displaying iCat information 

The iCat info display menu (accessible via a right mouse button click) offers various options for 

displaying iCat information. Please refer to 15.4 Working with iCat on page 164 for further information. 

Controlling playback 

There are several ways to control the playback of the recording. Besides the Play backward and Play 
forward buttons it is possible to go the Previous Frame / Next Frame and Jump to start / Jump 

to end when the playback is paused. The Speed of the playback can be controlled with a slider and 
ranges from 1/8th to 1024x. 

7.4 Motion detection in archive recordings 

Observer supports server-based motion detection not only for live camera streams but also in the 
archived recordings. Here you find information about how to execute motion detection on recordings. 

Please note: In this version, Observer supports archive motion detection only for MJPEG recordings 

and not for recordings of other streaming formats (like MPEG-4, MxPEG or H.264). 
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1. Go to the main window and choose the Archive player (if the Archive player is not available, 

then perhaps it is disabled in the client preferences; see 2.3 Client multi-window and multi-screen 
operation on page 17). 

2. In the Calendar view of the Player select the camera and the timeframe for the motion 

detection. 

3. Push on the Playback button . This will load the images of the timeframe and replay the 
recorded images. 

4. In the Upper left corner of the Player view select Archive motion detection from the Control 
menu: 

 

Now the motion detection pane is opened on the left side in the Player view: 

 



Netavis Observer 5.1 User Manual (February 2021) 

Page 83 of 214 

5. From the Detection field pop-up menu choose the motion detection field definition you want 

to use for this motion detection. If you do not yet have a detection field defined or want to 
change an existing definition, then you can push the Manage detection fields button to jump 
to the Detection fields view in Administration. Please refer to 8.1.2 Basic configuration of server-

based motion detection on page 86 for details on how to setup detection fields. 

Continuing here, we assume you have a correctly set up detection field definition. 

6. To start the server-based motion detection Push the Start button . 

You can see the progress of the motion detection at the progress bar. You can always stop a 

running motion detection by pushing the Stop button . 

Caution: Since the motion detection actually runs on the Observer server and can potentially 
use up a lot of CPU resources, please be careful selecting the detection fields and also the time 

period. Especially if you have selected a long time period in the Calendar the motion detection 

can take a lot of time. As mentioned above, you can always stop a running archive motion 

detection. 

7. While the motion detection is running, the detected motions are displayed in the hit list sorted by 
the time in which the motion occurred. In our example, we have 2 hits: 

 

8. You can replay the events by just selecting the event with the mouse. The playback time before 
and after the event can be defined by the Pre/Post event (sec) fields. You can change the 
values according to your needs. Please note that there must be archived pre- and post-event 

recordings available in order to be replayed. 

9. You can step through the events by pushing the Previous  and Next  buttons. 

7.5 External archive management (NEA) 

7.5.1 Introduction to external archives (NEA) 

Starting with release 4.4 Observer offers external archives (NEA) for portable archive recordings. Simply 

connect an external storage device via eSATA to the server, then Observer can save video streams on 

the external storage in addition to the main archive storage. Thus it executes a second (mirrored or 
double) recording: recording on the external NEA device in addition to standard recording. 
The external archive can then be carried and connected to another Observer server for replay and 
analysis. 
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NEA also offers a swap function that allows the easy exchange of external storage devices during active 

recording without additional user interaction; therefore no particular operator expertise is needed for 
the exchange. 

This chapter describes how you can manage removable storage devices (NEA devices) for external 
video recording. 

Please note: The NEA recording on the external device is exactly the same as the standard recording 
on the main storage (at least as long as there is enough space on the device). The same recording 
algorithm is used for NEA as the main storage. This means when the NEA device is running out of 
space the oldest recordings will be overwritten. For a detailed description of how Observer manages 

recordings please refer to the Operation of the dynamic storage management section in the User 

Manual. 

Apart from the NEA management functions in the client, NEA storage devices can also be configured 

and managed via the admin command line interface of Observer (see Netavis Observer Server 
Installation and Administration). Some more advanced functions like the setup of swap management 

for storage devices are accessible only in this interface. 

7.5.2 Managing and accessing NEA storages 

A user with the appropriate privileges can do the following with external NEA archives: 

• Initializing of storage devices and starting of NEA recordings as well as stopping of NEA 

recordings and ejecting devices. 
All of these functions are available in the NEA storage management dialog is accessible via 

the System administration menu of the main window. 

The user privilege "Recordings: Manage external archive devices (NEA)" is needed for accessing 

the dialog. See 5.2 Setting general user privileges on page 46 on how to modify user privileges. 

• Replay NEA external archives in the Archive player. 

The user privilege "Recordings: View external archive recordings (NEA)" is needed. 

For an explanation and setup of automatic swap management of NEA device please refer to the 

document Netavis Observer Server Installation and Administration. 

Displaying the status of NEA storage devices 

When a NEA storage device connected to the server you can view its status in the NEA storage 

management dialog accessible from the System administration menu of the main window. The 
dialog shows all connected NEA storage devices, their sizes and their Status: 

• Recording: recording is currently running on the device 

• Archive: a finished archive of the device can be accessed in the Archive player 

• Empty: the storage device is empty (but initialized) 

• Unformatted: the device must be initialized (formatted) first 

• Write error: the device can be accessed in the Archive player 
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Initializing a device and starting NEA recording 

When a new storage device is connected to the server via an eSATA connector, then the device is 
shown in the NEA storage management dialog accessible from the System administration menu 

of the main window. 

You can start NEA recording on the device by pushing the Initialize and start recording button. 

A new device will automatically be initialized (formatted) for NEA before the recording starts. This 

initialization is only executed once per device and it may take a while before it is finished. When 
initialization is done, recording will start automatically. Next time, recording will start immediately 
when you push the button. 

Please note: All data on a storage device will be deleted, when it is initialized for NEA. Also note that 
the minimum size for a NEA archive is 5GB. 

Stopping NEA recording and/or ejecting a device 

In the NEA storage management dialog accessible from the System administration menu of the 
main window you can stop a NEA recording on the device by pushing the Stop/eject button. 

When you push the button, all NEA recordings on the device will be stopped and the device will be 

unmounted/ejected. A dialog will open and ask you to unplug the device before pushing OK. 

If you leave the device connected when you push OK, the archive of the device will be shown again in 
the camera tree of Archive player of users who have the appropriate privileges (see above). In such a 

case you have to execute the command Stop/eject again before unplugging the device. 

7.5.3 Accessing NEA archives at another Observer server 

Any user with the appropriate privileges can play back NEA archives easily at any Observer by just 
connecting the NEA storage device to the server. 

The user privilege for accessing the NEA archives in the archive player is "Recordings: View external 
archive recordings (NEA)". 

In the Archive player of the client the NEA archive appears automatically in the camera tree under 

the camera group External Archive: 

 

Please note: There are some limitations on external NEA archives, like Archive motion detection is 
not possible. 
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8 Working with motion detection 

Please note: Since release R1.12 Observer offers powerful video analytics functions with iCat. 
This chapter describes the motion detection features that were present before R1.12 and that are now 
a part of the iCat toolbox. Motion detection is based on a detection of changed pixels between video 
frames while iCat offers intelligent object detection and tracking. For more details on iCat refer to 15 

Video analytics with iCat on page 142. 

Observer offers two mechanisms for motion detection: 

• Observer’s own server-based motion detection: The images are analyzed by the Observer 
server. The advantage of this method is that it works with any camera, even old cameras. The 
disadvantage might be that if there are many cameras that transfer their images to the server 

for analysis, the bandwidth of the network could be burdened and also the server could be 
overloaded. 

• In-camera motion detection: The images are analyzed in the camera and only when 
detection occurs, an event and image data are sent to the Observer server that then stores the 
event and the images in its archive. The advantage of this method is that the network and the 

server are not burdened. The disadvantage is that it works only with special cameras, that offer 
this feature and that the motion detection settings have to be programmed in the camera 

directly. 

8.1 Observer’s own server-based motion detection 

The simple motion detection feature of Observer can recognize motion by detecting pixel changes 
between video frames. Such a detection can then trigger the following predefined actions: 

• Entry of events in an Event list (optionally accompanied by an acoustic signal). 

• Changes in recording behavior (e.g. higher recording rate) if that has been programmed (see 7 

Working with archive recordings on page 72). 

Here you find the steps how to configure the parameters for simple motion detection. 

8.1.1 Preparation 

Before you begin to configure a motion detection definition, be sure that you have the necessary 
authorization to make settings. If you are not sure, please ask your Observer administrator. 

Please note: Motion detection for PTZ cameras is problematic since normal movement of the camera 
will trigger a motion detection event. 

8.1.2 Basic configuration of server-based motion detection 

1. Choose Video analysis (iCat) from the System administration menu. This opens the Video 
analysis (iCat) dialog. 
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2. In the camera tree at the left, select the camera for which you want to create a motion detection 

definition. 

3. In the menu choose Add new definition. 

4. From the Type menu chose Motion detection. 

5. Select whether you want to create a Rectangle or a Polygon. 

6. Use the mouse to draw a detection field in the preview area. 

7. Mark the Enabled checkbox, otherwise the detection field is inactive and no detection can occur. 

Actually, a detection field must also be assigned to an active motion detection schedule (see 
below). 

8. Assign a name for the field in the Identifier text box, e.g. “Movement”. 

9. Optionally, you can enter a Comment which is shown in the event details. 

Hint: You can also use the Comment field to configure certain views to be shown to one or 

multiple users when a motion is detected. See 6.10 Dynamic View Control in Online Monitor on 
page 64 for more information. 

10. Usually the Sensitivity should be left at Normal. It defines how sensitive (or tolerant) the 
detection algorithm is when detecting the change of pixels. Modify the setting only when you 
want the algorithm to be more or less sensitive. 

11. In the Sample frequency (fps) field you can specify how often the image is to be checked for 
changes. 
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12. In the Time between events (sec) field you can enter the minimum time that must elapse 

before a following event is triggered. This helps to filter out repetitive events. 
Minimum time (sec) = 15 means that, after one motion detection event has been triggered, at 
least 15 seconds must pass before another event for the same Motion Detection is generated.  

Note: In Netavis Observer 5.1 the default time between events value was increased to 15 

seconds (the previous default value had been 3 seconds). 

13. In the Pixel change threshold (%) field you can define how many pixels in % must change so 
that a detection event is triggered. 

Pixel change (%) = 20 means that 20% of the pixels relative to the previous frame (detection 
cycle) must change for a detection to be triggered. 

14. Optionally you can define a specific event icon and sound for this definition: Click on the Icon 
button to assign a symbol. This icon is displayed in the Event list to notify an operator when an 

event related to this definition occurs. 

Click on the Sound button to assign a specific sound to the definition. This sound is played when 
a user notification event related to the definition occurs. 

15. After you have entered all parameters for your definition, save it by clicking on the Save button. 

16. If you have not yet scheduled a detection-based recording for this camera, you will be prompted 
for whether you want to edit the scheduling now. 

Click on the Yes button if you want to configure the scheduling now. Please refer to section 8.1.3 
Scheduling motion detection on page 88. 

Click No if you want to do that later. 

Please note: 
If you add a new iCat definition, it will automatically be assigned to all iCat schedules of the 

camera. If you do not want that, you have to remove the assignment manually.  
If a definition is not assigned to an active schedule then it will not be activated (no archive 

recordings will be made and no events will be generated) although it has the Active option set.  

8.1.3 Scheduling motion detection 

The scheduling for motion detection is the same as for other iCat definitions. Please refer to 15.3.16 
Scheduling iCat video analytics and recordings on page 164. 

8.1.4 Controlling PTZ cameras with motion detection events 

It is possible to assign a sequence of PTZ positioning actions to each motion detection (MD) field 

definition. Once the MD field gets active, the associated PTZ action is executed. PTZ actions can be 

assigned to an MD field by appending the following sequence to the MD Identifier: 

ptz:<CID>:<PresetName>:<WaitTime>:<PresetName>:<WaitTime>... 

where: 

<CID> is the ID of a PTZ camera (the ID is shown in Camera admin > Properties dialog next to the 
camera name). If <CID> is 0, then the MD field's camera is controlled (MD and PTZ camera are the 
same). 
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<PresetName> is the name of a preset position (as entered in the PTZ definitions). 

<WaitTime> is the pause time in seconds starting from the time when the camera receives the 

positioning event. 

There can be any number of "<PresetName>:<WaitTime>" pairs added. 

Further MD-triggered PTZ actions are blocked as long as a sequence is running. However, control of 

PTZ camera can be taken manually, then the automatic MD-triggered PTZ control is suspended until 
the manual PTZ control is released. 

For information on how to setup PTZ preset positions refer to 10 Working with PTZ cameras on page 
100. 

Example of an motion detection Identifier: 

Door ptz:4:Door:10:HomePos:3 

will on an MD event with the Identifier “Door” move the PTZ camera with ID 4 to the preset position 
“Door”, wait 10 seconds and move the camera to the preset “HomePos” and wait another 3 seconds. 

The overall positioning time therefore is app. 13 seconds. From then on the PTZ camera is open to 
receive further MD-triggered PTZ positioning commands. 

8.2 Motion detection in archive recordings 

Observer supports server-based motion detection not only in live streams but also in archived 
recordings. Please refer to 7.4 Motion detection in archive recordings on page 81. 

8.3 In-camera motion detection 

Several IP cameras and video servers support in-camera motion detection and upload (push) of event-
triggered images via FTP or HTTP to a video management system like Observer. Observer implements 

a general mechanism to handle this feature. 

This section describes how Observer supports in-camera motion detection and also how to configure 
it in Observer.  

In order for in-camera motion via FTP to work the FTP service included with any Observer system has 

to be running (please refer to the NETAVIS Observer Server Installation and Administration guide for 

further information). 

Note: Since the camera carries out the detection, the actual configuration and programming must be 
done directly in the camera via the setup interface (e.g. parameters like detection settings, image 
quality, speed, etc.). This can usually be done by connecting with a web browser to the camera (by 

entering its IP address). Please refer to the latest Netavis Observer Supported Video Sources and the 

camera’s user manual for further details. 

8.3.1 How Observer supports in-camera motion detection 

In the camera you define the various settings for the motion detection algorithm and for the 
transmission of event images to the Observer server, which is done via FTP or HTTP ("push upload" by 
the camera). Most cameras also support the transmission of pre- and post-event images. The 
configuration of for these pre- and post-event images must also be done in the camera. 



Netavis Observer 5.1 User Manual (February 2021) 

Page 90 of 214 

Observer is capable of doing these things in connection with in-camera motion detection: 

• Receive in-camera motion detection events from the camera and store these events in the 
standard Observer Event database (these events can also be displayed in the Event list). 

• Receive pre- and/or post-event images from the camera (pushed by the camera) and 
record these images in the standard Observer camera archive. 

• Optionally, with receiving an in-camera detection event, start a server-based post-event 
recording of images and merging this recording with the in-camera event images pushed by 

the camera. This server-based recording can have a much higher frame rate than the pictures 

pushed by the camera. This allows a much better documentation of in-camera events. 

Note: In-camera motion detection cannot be used on a camera in parallel with other types of 
recordings! 

8.3.2 Setting up in-camera motion detection 

To configure Observer for in-camera motion detection follow these steps: 

1. Choose Camera admin from the System administration menu. This opens the Camera 

admin dialog. 

Assuming that you have already defined the basic properties of the camera in Observer, select 

the camera in the camera tree. 

2. On the Properties dialog press the Next button at the bottom of the dialog until you reach the 
Defaults settings dialog. Here you focus on the In-camera motion detection settings: 

 

3. In the menu choose Modify selected camera or group. 

4. Mark either Receive event images via FTP or …via HTTP depending on what your camera 

supports. This tells Observer to receive in-camera events and images from the camera. 
If you already have a defined an active server motion detection schedule for the camera, you will 
get a dialog that tells you that having both, server and in-camera motion detection at the same 

time is not possible. To continue you have to first disable the server-based motion detection 
schedules in the Scheduling dialog and then you can continue here.  

5. Optionally you can set the Post recording length (sec) that defines whether and for how long 
the Observer server should record camera images in addition to receiving and storing the event 
pictures pushed by the camera. As mentioned above, you could want to do that to record the 
post-event images with a high frame rate. In such a case, set the Frame rate according to your 

needs. 

6. Now you also have to tell Observer, for how long it should keep the recorded event-images (both, 
the ones pushed by the camera and the ones, additionally recorded by the server). 
Press the Previous button at the bottom of the dialog until you reach the Scheduling dialog. 
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7. Below the Time intervals list push the Add button and then choose Camera MD (FTP/HTTP) 

from the newly created Change pop-up menu. 

8. In the field Requested recording period (days/hours) enter the values that fit your needs. 
Optionally you can also mark the Priority over other cameras (if storage space is short) 

checkbox. For further details about these recording parameters please refer to sections 7.1.1 

Scheduling continuous recordings on page 72 and 7.1.4 Operation of the Observer dynamic storage 
management on page 72. 

9. Push the Save button to store your changes. 

10. Now you have to configure your camera for pushing the in-camera events and images to the 
Observer server. Since the steps for doing that are very camera-specific, you must consult the 

document Netavis Observer Supported Video Sources. To program the camera's detection 

algorithm please consult its user manual. 

Note: After setting up the camera, do not forget to check and set the date and time of the camera to 

reflect your current time. 
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9 Handling events 

Observer can record and display events of various types. These can be camera-related events like 
video analytics events, archive access by a user, or camera failures, but also system-related events like 

user logon and logoff. 

Events are displayed in Event lists of the client and are stored in the central event database of the 

server were they can also be queried. They have several properties that depend on the type of the 
event. 

Event priorities 

All events also have an event priority that defines the relative importance of events. The default event 

priority is 100. Informational events have a lower priority of 50, system and camera malfunction events 

have a higher priority of 300. For events generated by video analytics triggers, you can specify 
individual event priorities. Event lists can also be sorted according to priority. 

User privileges for accessing and handling events 

In the User admin under the System administration menu you can define for each user some basic 

event handling privileges. For example whether user you can access events at all or what kinds of 

system events are displayed at the users event list (see 5.2 Setting general user privileges on page 46). 

The number of events stored in the database can be defined in the server parameters (see 11.2 Setting 
Observer server parameters on page 109). 

9.1 Event list and event details 

The most recent events are displayed in the Event list: 

 

Each client can have multiple event lists, for example, one that is sorted chronologically and another 
one that is sorted according to event priorities. In the Client preferences you can configure for each 

window's event list what columns are to be displayed, whether acknowledged events should stay in 
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the list or should disappear automatically and other options (see 2.4 Client preferences on page 19 for 

more details). 

The position of the event lists inside client windows and further layout options can be defined as 
described in 2.3 Client multi-window and multi-screen operation on page 17. 

You can sort the event list according to column values by just clicking on the column title. Little arrows 

after the title indicate the sorting order (ascending or descending). Clicking a column title again will 
change the sorting order. For example, you can sort the list according to event priority by clicking on 
the Priority column heading. 

In an event list columns can be rearranged by clicking on a column title and dragging it with the 
mouse to the new location. 

Unseen events have a light red background color. As soon as an event has been opened in the Event 

details dialog its background color changes to light grey. When an event is acknowledged, it usually 

disappears from the event list. However, in the client preferences you can define whether 

acknowledged events should be displayed in the event list. If so, they appear with a white background 
color. 

9.1.1 Event details 

Double clicking on an event in the event list opens the Event details dialog. 

 

The first line contains the event text. Further details of the event are listed at the left side of the dialog. 
The exact contents of the event details depends on the event type, but you will at least find the exact 
time when the event occurred and if it is camera-related then also the camera ID and name are shown. 
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When you move the mouse over the camera preview area you will also see the video analytics object 

markers and annotations related to the event trigger (as seen in the screenshot above). 

The following options are available for users: 

• Start live stream: Starts live monitoring of the camera that triggered the event. 

• Short event replay: Starts a playback of the event recording that triggered the event (a replay 
is only available if the camera has been configured to record the event). 

• Go to Archive player: Opens the Archive player and starts a playback of the event recording. 

• Classify event as: The event can be classified as Unclassified, Irrelevant, Valid (true), and 
Invalid (false). 

• Acknowledge comment: This field can be used to add an optional comment related to the 
acknowledgement of the event. 

• Acknowledge: Acknowledges the event and close the dialog. 

• Acknowledge and next: Acknowledges the event and loads the next event. 

• Previous: Loads the previous event. 

• Next: Loads the next event. 

• Close: Closes the dialog. 

9.2 Searching for and exporting events 

1. When you choose Event search... from the Events menu the Event search dialog appears: 

 

2. Netavis Observer 5.1 introduced full-text search which enables quick searches by simply entering 

the desired text in the Search pattern field. Additionally, it is also possible to use Regular 
expressions by enabling the corresponding option. 

3. Select the Time filter according to your needs whereby the options are either All records (no 
time filter) or manually choosing a time interval. 
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4. You can further constrain the search by using Event filters for Event type, Camera name, 

User name, or Event ID (from- to), and event-specific parameters and their values (e.g. the 
event's classification). For some filters an appropriate dialog will open, e.g. the Event selection 
dialog: 

 

In each of the dialogs it is possible to make multiple selections. For example to search for the 

event types In-camera motion detection, Simple motion detection, and iCat object 

tracking, hold down the CTRL key and select these event types with left mouse clicks: 

 

You can also search for events which have been acknowledged or not acknowledged by 

selecting the appropriate check box. 
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5. With the Number of records options you can also select how many search results should be 

displayed. 

6. After setting different search criteria and filters press the Search button to display the results. 

By clicking the Next button you can step forward in the result list and with Previous button you 

can step backwards. 

9.2.1 Exporting events 

You can also export the search results into an HTML filedifferent file types: 

1. In the Event search dialog press the HTML export...Export...   button which opens the events 

export dialog. 

 

2. Select what file type you want to export the events to whereby the following types are available: 

• HTML (.html) 

• Excel Workbook (.xlsx) 

• Excel 97-2003 Workbook (.xls) 

• JSON (.json) 

• Comma separated values (.csv) 

3. Select whether you want to export All events according to filter criteria or Only events 
display on search result list and enter a file name. 

4. Press Export. Now the corresponding file is created and you can open and use it in a program of 

your choice. 

9.2.2 Exporting event-related recordings 

You can export event-related video recordings from the Event search dialog. For each event that has 

recording associated a separate video file is created. The file name is composed of the event ID, date, 
time, and event type. The export can be done in 2 formats: AVI (DivX) and SAFE (see also 7.3 Exporting 

recordings (images and video sequences) on page 79). 

Here is how you can do that: 

1. In the Event search dialog press the Video export... button, which opens an export dialog. 

2. Select the directory where the exported video files are to be stored and choose whether you want 
to export only the events displayed in current search list or all events matching the filter criteria. 
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You can also supply the pre- and post-event time to be exported. 

Select the video format. 

3. Press Export. Now a separate video file is created for each event that has a recording. At the end a 

summary dialog shows how many files have been create and what is their total size. 

9.3 Generating an event statistics report 

Observer allows you to create an event statistics report in MS Excel XLS format. 

To create a statistics report file, follow these steps: 

1. Choose Event statistics export... from the Events menu.This brings up the Event statistics 
export dialog: 

 

2. Select for which Start time, Time period and time Resolution you want to create the report. 

Also you can filter according to Event type, Camera and User (multiple selection by holding 
down the CTRL key while clicking is supported for all filters). If you do not select any values for 

Event filter, then a summary statistic report will be created. 

3. Press OK to start creating the report file. You will be prompted for a file name where the report 

should be stored. 

4. Open the created file in MS Excel. With the data, you can also create graphics like the following 

one (motion detection statistics for one day): 
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9.4 Receiving notification on events 

Observer can be configured flexibly to notify users on various event types and by various channels. 

The event types for defining notifications are: 

• System malfunction events (e.g. storage failures) 

• System information events (e.g. example user login and logout) 

• Camera-related events 

o Camera malfunction events (e.g. camera is not accessible) 

o Camera in-picture events (e.g. motion detection, video analytics object triggers) 

The notification channels are: 

• Event list of the client 

• Email 

• SMS 

For each of the above event types the notification channels can be enabled/disabled in the user 
privileges and camera access rights (see 5.2 Setting general user privileges on page 46 for details on 
how to define privileges and rights). 

Please note that the notification channels can be defined on a user or on a group level. Likewise the 

camera-related notifications can be defined on a camera or a camera group level. 



Netavis Observer 5.1 User Manual (February 2021) 

Page 99 of 214 

Please note: In order to receive emails, the email address must be correctly defined in the user 

properties. Also the server must be correctly configured and must also have access to an email router 
for sending emails. For receiving SMS an SMS sending device must be configured at the server. See 

Netavis Observer Server Installation and Administration for details. 

9.4.1 Receiving Email notification with alarm image on camera events 

Here you learn how to set up email notification with alarm image on camera motion detection or 
video analytics events: 

1. In the User admin dialog select the user for which you want to define the email notification and 

enter the correct email address (see 5.1 Creating a new user account on page 44). 

2. Continue to the Camera access rights by pushing the Next button and then select the camera 
or group for which you want to define the notification settings and enable the right Events: 

Sending email about in-picture events (e.g. motion detection, video analysis). 

If the user should also be informed about camera failures you can also enable Events: Sending 
email about camera malfunction events (see 5.2 Setting general user privileges on page 46 and 
5.3 Setting camera access rights on page 50 

3. Define and enable a motion detection or iCat definition (see 15.3 Setting up a camera for video 

analytics with iCat on page 146). 

4. Check that the iCat video analytics or motion detection definition has an active recording enabled 

(either continuous or event-based). Please refer to 15.3.16 Scheduling iCat video analytics and 
recordings on page 164. 

5. Make sure that for the motion detection or iCat definition the event generation is enabled (the 

checkbox Save event in event list is marked in the Scheduling dialog) and that it is not 

suppressed in the iCat event definition itself. 

When you have setup all these things the user should receive an email with an attached alarm image 

on every event. 
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10 Working with PTZ cameras 

Observer features the control of PTZ cameras (pan/tilt/zoom). 

Note: To configure and work with PTZ cameras, you need the corresponding user privileges and 

camera access rights (see 5.2 Setting general user privileges on page 46 and 5.3 Setting camera access 
rights on page 50). If you find that you do not have the authorizations you need, please contact your 
Observer administrator. 

10.1 Setting up a PTZ camera 

Setting up a PTZ camera is the same procedure as setting up a camera without PTZ functionality (4 

Setting up cameras on page 31). 

The user must possess the user-specific camera authorizations (see 5.3 Setting camera access rights on 
page 50) to permit PTZ access. 

10.2 Defining fixed PTZ positions 

1. Choose PTZ from the System administration menu. This opens the PTZ dialog. 

2. From the camera tree, select the PTZ camera whose PTZ positions you want to program. 

3. In the menu select Add new definition. 

4. In the Name field enter a designation for the position and then use the PTZ control elements 

to move to the desired position (detailed explanation of control elements in Section 10.4 
Controlling PTZ cameras on page 101): 

5. Click on Save to save your configuration. Then you can repeat steps 3 to 5 to define additional 
PTZ positions. 

6. From the Online Monitor you can select these predefined positions (see below). 

7. Double-clicking on one of the predefined positions lets you position the camera. Proceed 

similarly in order to change positions. 

10.3 Defining PTZ routes 

In addition to individual PTZ positions, you can also define position routes that can be followed on 
command. A position route consists of a list of PTZ positions that are automatically, sequentially 

followed and a duration per position. 

Define a PTZ route as follows: 

1. Choose PTZ from the System administration menu. This opens the PTZ dialog. 

2. From the camera tree, select the PTZ camera whose PTZ route you want to program. 

3. If you have not already defined PTZ positions that now appear in the list, or you can create new 

positions now. See the previous section for defining new positions. 

4. Click on the Next button at the bottom right. This takes you to the Routes dialog, whose layout 
resembles the Positions dialog above. 

5. In the menu select Add new definition. 
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6. In the Name field enter a designation for the route. Optionally you can enter a description. 

7. Click on Next to move to the Route details dialog: 

 

8. Click the New button to create a new entry in the Position list of the route and select a position 

from the list of predefined positions via the Position popup menu. 

9. In the Time at position field, enter the duration in seconds that the camera is to spend at the 
position. Note that this time includes the positioning time of the camera. 

10. Repeat Steps 8 and 9 for each entry in the position list. 

11. You can change the sequence within the position list by selecting a position and then clicking the 

Up or Down button. You can remove an entry from the Positions list by selecting it and then 

pressing the Delete button. 

12. Click the Save button to save your route or Cancel to discard changes. 

You can select the saved route in the Online Monitor via the PTZ menu of the view port control menu 

of the PTZ camera. Proceed similarly to modify a route. 

10.4 Controlling PTZ cameras 

10.4.1 Controlling PTZ cameras in the Online Monitor 

Control PTZ cameras as follows: 



Netavis Observer 5.1 User Manual (February 2021) 

Page 102 of 214 

1. Select the Online Monitor. 

2. Switch to a view that contains a PTZ camera (how to create views and assign cameras is covered 
in section 6 Using the Online Monitor on page 54). 

3. In the view port of the PTZ camera push the PTZ start button  or choose PTZ->Activate PTZ 

from the view port control menu. The icon  of the view port indicates that you have PTZ 
control over the camera. 

 

Note: For each user a PTZ priority and allocation timeouts can be defined (see 5.1 Creating a new 

user account on page 44). If another user with equal or higher priority has already assumed PTZ 

control over the camera, you will be denied control and notified in a window. Then you need to 

wait until this user surrenders control or reaches his timeout. 

A user with a higher PTZ priority can take away PTZ control from a user with lower PTZ priority. 

Direct PTZ control inside a view port 

You have several options for directly controlling PTZ cams: The various modes can be selected 

via PTZ->PTZ control mode in the view port control menu. The default setting is Continuous 
mode and Center on click. As an alternate mode also an operation via a Crosshair is available. 

Continuous mode (available for joystick and mouse operation): Click the mouse in the view port 
and drag it in the direction where you want the PTZ cam to move. A red dot marks the origin of 
the movement and a red line indicates how fast the movement is. When you release the mouse, 

the movement will stop (though depending on the camera and network it is possible that there is 

a small delay). 
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Center on Click: A single mouse click somewhere in the view port commands the camera to 
center on the mouse click location. 

Zooming: Zooming is available via the mouse wheel: zoom-in (forward scroll) and zoom-out 
(backward scroll). The amount of the zoom will be indicated by 3 red dots after the mouse is 

released: 

 

Please note: When PTZ control is enabled, any mouse actions are taken for PTZ control. In 
order to control the client-based view port zooming (see 7.2.3 Zooming in a view port and in 
archive recordings on page 76), hold down the CTRL key while using the mouse. 

Crosshair: When this mode is enabled, a crosshair for relative control mode is shown in the view 

port:  
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Controlling PTZ cameras with a joystick:  

The locally installed version of Observer is able to handle USB joysticks as input device from Java 
VM 1.4 and newer (for information on how to install the application version locally please refer to 
2.2 Working with the installed Observer client on page 12). 

The joystick can be used for panning, tilting the camera, while its buttons for zoom-in and zoom-

out operations (which button is used for which operation is assigned during calibration). The 

joystick must be calibrated before use (found in the System Information menu, beside the 

language change menu). 

Please note: In order for the joystick support to work the Java version (32-bit or 64-bit) installed 

on the client PC has to match the system's processor architecture. 

Jump to a predefined PTZ position and follow PTZ routes 

1. To send a camera to a predefined PTZ position, activate the PTZ control, right-click to open the 
context menu and select a position from the list at the top of the menu (see 10.2 Defining fixed 

PTZ positions on page 100). 
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2. To automatically follow a predefined PTZ route choose it from PTZ->Select PTZ route in the 

view port control menu of the PTZ camera. 

3. In the view port control menu of the PTZ camera, click PTZ->Select PTZ route->Stop route to 

stop control of the PTZ camera. 

Stop PTZ control 

You can stop PTZ control by pushing the  button or deselect PTZ->Activate PTZ control in the view 

port control menu. 

Note: Please do not forget to stop PTZ control; otherwise other users cannot assume control. When 
you end the Observer client, all PTZ control is automatically released. 

For further details on user-specific PTZ priorities and timeouts please refer to 5.1 Creating a new user 
account on page 44. 

10.4.2 Controlling PTZ cameras with motion detection events 

It is possible to automatically control PTZ cameras with motion detection events. Please refer to 8.1.4 
Controlling PTZ cameras with motion detection events on page 88. 

10.4.3 Scheduling PTZ routes 

It is possible to schedule time intervals for PTZ camera to follow predefined routes. 

Note: Before you can schedule a route you first must define the route (please refer to 10.3 Defining PTZ 
routes on page 100). 

To schedule a PTZ route, follow these steps: 
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1. Choose Camera admin from the System administration menu. This opens the Camera 

admin dialog. 

2. Select a PTZ camera. 

3. Press the Next button to go to the Scheduling dialog. 

4. In the menu select Modify selected camera or group. 

5. Click the Add button to add a programming slot to the Time Intervals field. 

6. Click the Change button (now enabled) for a popup menu; select PTZ route. 
This will show the PTZ scheduling settings (see above). 

7. Set the time settings according to your needs. 

8. Select the route from the Route Name pop-up menu (in the example above we selected Route 

1). 

9. Click on Save to store the scheduling settings. 

Note: You can add several PTZ route schedules for a single camera. This means that you can follow 

different routes at different times. 
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11 Administrating Observer servers 

This chapter describes how to 

• get status information about running Observer servers, 

• set server parameters, 

• start/stop servers, 

• administrate external NEA storages 

Further information about administrating servers you find in the document Netavis Observer Server 
Installation and Administration. 

11.1 Server system information and restarting 

Observer offers 2 sets of status information of the running servers in a network. 

• The server load display in the main client window 

• The System information dialog in the Admin area 

11.1.1 Server load display 

The server load display is located in the status bar of the main client window and shows the following 

information: 

 

CPU: xx % Server CPU load in percent. This display is updated every 5 
seconds. 

IDB: xx % 

xx KB/s 

Load of Image database (IDB) engine: This parameter shows 

how busy the server is with saving video data on storage. The 
actual video data storage rate is displayed below the percent 
value in Megabytes/sec or Kilobytes/sec. The IDB display does 

not appear if the server does not record. 

Note that the IDB load also increases when the server removes 
video data when the storage is full or recording time limits are 
reached. IDB details are updated once a minute. 

OVR: xx % Overloaded state of the IDB engine: The IDB engine is 

overloaded if the server receives more video data from the 

cameras than it can record (save on storage). In this case the 
server will drop frames. OVR shows the percent of dropped 

frames. If the label OVR does not appear then the server can 

save every incoming frame. 

SWP: xx MB Swapping: This display appears if the server starts heavy 
swapping, which means that the amount of main memory of 

the server is insufficient. If this is situation persists, the server 
must be extended with additional RAM. 
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11.1.2 System information dialog 

1. Choose System information from the System administration menu. This opens the System 
information dialog. 

The table shows the connected servers and their state: 

Name shows the name of the server and the Observer version running. 

State shows whether the server is running and if there is a failure. 

License shows the license of the Observer server (or the remaining days if the system is in 
license-less mode): 

• Alphanumeric sequence: This is the Machine ID used for licensing the server 

• OBS: represents the basic functionality 

• Server network licensing: 

• UNW: unlimited number of connected servers 

• LNW: max. 3 connected servers 

• Licensed features: 

• SNMP: SNMP support 

• EIDB: Encrypted image database 

• AD: Active Directory/LDAP support 

• ABS: ABS (Adaptive Balanced Streaming) transcoding for low-bandwidth 
connections 

• CAM: shows the number of total camera licenses. If the number contains an “R” 

then it is a floating license from a remote licensing server. If the number of cameras 
exceeds the license limit, then in parentheses first the number of disabled cameras 

is shown and then, after a slash, the number of allowed licensed cameras. 

• USR: shows the number of total user licenses. If the number contains an “R” then it 
is a floating license from a remote licensing server. 

• SNAP: SNAP XML integration interface 

• LNT: Layout Navigation 

• iCat: iCat video analytics 

• SAB: Camera sabotage detection 

• IPAD: Client for iPad 

• URL: SNAP URL integration interface 

• VW: Video wall control 

• V4W: Video4Web 

• SMPH: Client for Smartphone & Tablet 

• TRF: iCat Traffic 

• NPR: iCat Number Plate Recognition 

• WEBC: Mobile Client 

• EDS: External Devices 

• FACE: iCat Face Detection 



Netavis Observer 5.1 User Manual (February 2021) 

Page 109 of 214 

With Observer 4.0 to 4.6 you can display the current license key string by entering the following 

URL in a web browser http://IP-address-of-your-
server/arms/servlet/BrowserServlet?cmd=showlicensekey. 

For further information about licensing please refer to the manual Netavis Observer Server 
Installation and Administration. 

Archive shows the sum of fps and Kbytes per second of archiving on that host. 

Monitor shows the sum of fps and Kbytes per second of all logged in users. 

Please note that you usually only see the status of your server. If you want to monitor the status 
of other Observer servers as well, you have to make other servers known to your server (please 

refer to 12 Working with interconnected Observer servers on page 117). 

2. To show the details of a server, double click an entry or select a server in the table and then 

choose Details from the System menu. Now you see detailed information for the selected 

server with hard disk partitions and their state. 

Partition ctrl: shows the number of the hard disk controller; dev: shows the hard disk number 
on the controller. On the screen dump we have 5 disks on 3 controllers. 

Type indicates the type of the partition: DB is a database holding configuration and event data 
and I is an image partition that holds the actual video image data. 

Status indicates whether there is a failure on the partition. Such a failure needs to be reported to 

your Observer Administrator. 

Capacity indicates the size of the partition in MB. 

Used % shows how much space of the partition is used. 

3. Click on the Back button to leave the server details dialog and go back to the list of servers. 

11.1.3 Restarting Observer and rebooting the server 

1. Choose System information from the System administration menu. This opens the System 
information dialog. 

2. Select a server in the table. In the System menu you have the following actions available: 

Stop Observer system: This stops all video system processes but does not shut down the server. 

Switch off server: This shuts the server down. 

Reboot server: This reboots the server. 

11.2 Setting Observer server parameters 

Observer allows you to set several server parameters. To access them, follow these steps: 

1. Choose Host admin from the System administration menu. This opens the Host admin 
dialog. 

2. Select your own server indicated by bold face (default is netavis). Here you see the Hostname, 

Network name or IP address and Observer Host ID of your server (are read only). The Observer 
Host ID is needed for working with distributed Observer server (see next section). 
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3. If this server is cooperating with other servers, then the settings for synchronization group may 

be relevant (see also 12 Working with interconnected Observer servers on page 117): 

If this server should be part of a synchronization group then enter the name of the 
synchronization group in the field Name of synchronization group. If this server should be the 
main node of the synchronization group, then select the check box main node of the sync 
group. Please refer to 12 Working with interconnected Observer servers on page  for a general 
explanation of synchronization groups. 

Please note: Modification of configuration data is only possible at the main node of the 

synchronization group and not at the secondary node s (as they will be updated by the main 
node automatically). As long as there is no main node in the sync group (which may happen 

during set up of the sync group) no modification is possible at all. 

4. As of Observer 4.7 a direct interface to Netavis sMart Data Warehouse is available. It can be 
enabled by checking the Allow sMart Data Warehouse connection checkbox and then setting 

up (and confirming) a password for the interface. This password then needs to be entered in the 

corresponding Netavis sMart Data Warehouse configuration. 

5. Click on the Next button. Now you see the Server Parameters dialog. The following settings are 
available: 

 

Field label Description  

Event storage period (days) Defines how many days events are stored. Any events that 
are older than these days will be deleted from the event 

database. 

Max number of events stored on 
server 

Defines how many events can be stored in the event 
database. For each event more than the defined max. 

number of events the oldest event will be deleted. 
Please note that both settings, the storage period and the 

max. number of events, together constrain the event 

database. 

Server timezone abbreviation Defines the server timezone. Available values are: 
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Field label Description  

 

Timeout for IP cameras (sec) Defines the time the server waits to receive a response from 

a camera and then displays the "Camera not responding" 

message in the Online Monitor (whereby a maximum value 

of 60 seconds can be set). Note that also other error 
conditions can trigger the "Camera not responding" 

message, so this message might also be shown sooner than 

the configured timeout period (e.g. when there's no route to 
host). 

Retry count for IP cameras, after 
which an event is generated  

Defines the number of connection retries after which the 
server raises a “Camera not reachable” event. 

Maximum login time for the 

“guest” user (sec) 

Defines the time after which the guest user is forced to 

logout. If the value is 0, then the guest is never forced to 
logout. 

Timeout for server-server 
communication (sec) 

Defines the time after which an event “Connection lost to 
server ...” is generated and the cameras mounted from that 

server disappear from the camera tree (only the root 
element of the mounted camera tree remains visible, 



Netavis Observer 5.1 User Manual (February 2021) 

Page 112 of 214 

Field label Description  

painted in red). 

Server network address for camera 
access 

This setting is only important for IP cameras that must 
actively access the server (e.g. for FTP upload with in-

camera motion detection) and only when the server is not 
accessible by the cameras at its set IP address but at a 

different address (e.g. due to address mapping). Per default 
this address always reflects the IP address of the server. You 
can enter an IP address or a network name. 

List of IP addresses from which 
URL control is enabled 

URL control is one way to enable third-party applications to 
start actions via URL-encoded strings (send http GET 

request to an Observer server). The server upon receiving 

these special URL requests executes the actions as if they 
would have been generated internally. 

URL control is only enabled for computers whose IP 
addresses are entered in this fields (comma separated list). 

All other requests are blocked. Please refer to the Release 
Notes for further details on URL control. 

ABS transcoding bandwidth limit 

for live view video streams (kbit/s) 

Bandwidth limit per session for transcoded outgoing live 

view streams (ABS). Zero means no transcoding and no limit 
for live view video streams. Please read 2.6 Observer 

Transcoding for low-bandwidth client-server connections 
(ABS) on page 27 for choosing the best limit values. 

Note: ABS-Transcoding is only available in the Netavis 
Observer client and is not supported by the Mobile Client, 

Layout Navigation or other tools. 
In a single-server setup it is necessary to re-start the streams 

(e.g. by switching from Online Monitor to Archive Player and 

back) for the changes to take effect. In a distributed NCS-
NUS setup and when connected to the NCS then a client 

restart is needed for the changes to take effect. 

ABS transcoding bandwidth limit 
for archive playback video streams 
(kbit/s) 

Bandwidth limit per session for transcoded outgoing 
archive playback streams (ABS). Zero means no transcoding 
and no limit for archive playback streams. Please read 2.6 

Observer Transcoding for low-bandwidth client-server 

connections (ABS) on page 27 for choosing the best limit 
values. 

Note: See the note for "Transcoding bandwidth limit for live 
view video streams (kbit/s)". 
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Field label Description  

ABS transcoding bandwidth limit 
for archive export streams (kbit/s) 

Bandwidth limit per session for transcoded outgoing 
archive export streams (ABS). Zero means no transcoding 
and no limit for archive export. Please read 2.6 Observer 

Transcoding for low-bandwidth client-server connections 
(ABS) on page 27 for choosing the best limit values. 

Note: See the note for "Transcoding bandwidth limit for live 

view video streams (kbit/s)". 

 IP address of network interface 

(NIC) for bandwidth limitation 

IP address of the network interface (NIC) for which 
bandwidth limitation is applied. If zero, then the bandwidth 
limit is applied in total for all available network interfaces. If 

transcoding is switched on, then it will only be applied to 
connections of this NIC. 

If you enter the keyword NUS instead of the IP address of 
the NIC then only traffic to a NUS (Observer user server) is 

transcoded. Local client connections to this server will not 

be transcoded. It also works this way if the server has only 1 
NIC for all traffic to cameras, local clients and a NUS. 

Total outgoing bandwidth limit 
(kbit/s) 

Total bandwidth limit for all outgoing connections of the 
specified network interface (NIC). 

RTSP streaming port Port number generally used for RTSP communication (e.g. 

for some MPEG cameras). 
Please note that modifying the value here does not change 

the RTSP port setting in the cameras. The cameras need to 
be configured separately for the RTSP port. 

Image database AES encryption 

(0=no encryption, 1 or 
2=encryption) 

This defines whether the image data are encrypted with 
AES.  

Value 0 switches off encryption (default). 

Entering the value 1 or 2 will switch on AES encryption of the 
video recording. Value 1 means the system will store the 

encryption key on a local server disk. 

Value 2 will store the key on a USB device (formatted with 

FAT32), which has to be plugged into the server. If the device 

is not accessible, then archive access is not possible. 
Prior to inserting the USB device, a writable directory "nek" 
must be created on the device (this can be done under 

Windows, for example). Observer will search for this 

directory and store the key file in it. After the USB device is 
detected and the key has been written to it the first time, an 
event with following text is generated: "IDB encryption 
started, USB device can be removed now for creating 
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Field label Description  

backup copy". At this time the USB device can be removed 
from the server, and a backup copy of the directory "nek" 
can be created. Note that the stick must be inserted again 

before any archive query is started. 

Warning: Loss of the encryption key stored on the USB 
device will make archive access impossible!  
Also, encryption needs much more CPU power than no 

encryption (see also 1.3 Observer data security on page 7).  

Length of alarm recording image 
database in days 

In case continuous recording is run in parallel to an iCat or 
event-triggered recording this option defines the minimum 

number of days the iCat or event-triggered recordings are 
stored (regardless of how long the continuous recordings 

are stored). 

Warning: If there is not enough space available for all 
recordings then even iCat or event-triggered recordings may 

be deleted sooner than configured here. (Please see 7.1.4 
Operation of the Observer dynamic storage management on 
page 72 for further information.)  

Limit for manually protected 
recordings in days 

Any delete-protected recordings older than this time limit 
(number of days) will be deleted automatically. 

Name of logout PTZ position Name of a PTZ position where all PTZ cameras which have a 
position configured with that name will be positioned when 

a user logs out. If left empty the feature is not activated. 

Heat map export period Interval in which heat map data is exported. Possible 
options are: 

• hourly 

• daily 

Heat map data reset method Per default iCat heat map data is never reset. However since 
NetavisObserver 4.6 it is possible to automatically reset all 
heat map data: 

• daily reset: day:hour (concrete example is day:07 for 

daily resets at 7AM) 

• weekly reset: week:week_day:hour (concrete 
example is week:2:07 for weekly resets on Mondays 

at 7AM whereby week_day is a number where 
Sunday = 1 and Saturday = 7) 

• monthly reset: month:day_of_month:hour (concrete 
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Field label Description  

example is month:01:07 for monthy resets on the 
first of the month at 7AM) 

Note: This setting only affects the current host. This means 

that in a system with multiple Observer servers this option 
has to be set on all servers (NCS and NUS) individually to 
achieve a consistent result. 

Max value for normalizing count 
The maximum value (up to 8 digits) for normalizing count 
heat maps for all cameras on this host. 

Note: See the note for "Heat map statistics reset method". 

Max value for normalizing speed 
The maximum value (up to 8 digits) for normalizing speed 
heat maps for all cameras on this host. 

Note: See the note for "Heat map statistics reset method". 

Max value for normalizing stopped 

objects 
The maximum value (up to 8 digits) for normalizing stopped 

objects heat maps for all cameras on this host. 

Note: See the note for "Heat map statistics reset method". 

Max value for normalizing object 
stopping time 

The maximum value (up to 8 digits) for normalizing stopping 

time heat maps for all cameras on this host. 

Note: See the note for "Heat map statistics reset method". 

Max number of parallel 
transcoders 

Defines the maximum number of parallel transcoders 
providing videostreams via SNAP URL. 

Ask for login reason 
If this value is set to 1 then all users have to document a 
reason for the login at the system. 

Note: If this option is enabled, then the user-specific ones 

are ignored. 

Minimum password length Minimum number of characters for user passwords. 

Minimum password complexity (0-
3) 

The password complexity uses the following scoring 
mechanism: 

• one digit, lower-case, upper-case, special character 
adds one to the score 

• the second digit, lower-case, upper-case, special 
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Field label Description  

character adds another one to the score 

This can give a maximum value of 8 which corresponds to 
100%. The current percentage is computed and the four 

levels (0-3) are at the boundaries of 25%, 50% and 75%. 

 

6. To modify any of these values, select Modify host in the menu, set the values and then press 

Save. 
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12 Working with interconnected Observer servers 

Observer allows you to work with the resources of interconnected (remote, distributed) Observer 

servers. You can import single cameras or whole groups of cameras from other Observer servers and 

you can also export your locally defined cameras to other Observer servers. You can work with remote 
cameras as if they would be local (e.g. you can also access their archive, modify their parameters or 
even add new cameras to remote sites). You can also define whether events should be propagated 

between servers. 

A special feature are so called synchronization groups of servers. A synchronization group allows you 

to automatically synchronize server configuration data (like user configuration data and view 
configuration data) between servers. 

Before you can do any of these things, you first have to make both servers known to each other. You 

can do that by adding the other server as remote server on each of the machines. The next section 
describes how to do that. 

Note: In order for interconnected Observer servers to work together all of them have to run exactly the 

same version. 

12.1 Basic concepts of distributed systems 

12.1.1 Camera servers (NCS) and user servers (NUS) 

In a single server system an Observer server does multiple things: store camera recordings, run 
iCat video analytics on camera streams, store events in the event database, handle user clients. In a 

bigger system with many cameras and users, a single server is not capable of doing all those things at 
once. Therefore multiple servers can be installed to handle the workload and the individual servers 

work in different roles: 

Camera servers (NCS = Netavis Camera Server): A camera servers (NCS) mainly manages 
cameras, it stores recordings and optionally runs iCat video analytics on the video streams of the 

connected cameras. It also stores the events related to the connected cameras. A NCS usually does 
not serve any user clients directly but it offers its cameras to user servers for mounting. 

User server (NUS = Netavis User Server): A user server handles user clients. It usually mounts 
cameras from multiple camera servers and also receives events from them. Thus a user connecting to 

a NUS can have access to the cameras of all camera servers. A user server usually does not manage 
any cameras directly and does not do any recording or any video analytics. However, it usually does 

store the events of all the mounted NCS in its central event database. 

12.1.2 System Architectures 

There are two key considerations which are important when planning distributed Netavis Observer 
systems: 

a. NUS servers must only import cameras directly from NCS servers and similarly NCS servers must 
only export cameras directly to NUS servers. So there should be no chains with one server 
importing cameras from a second server and in turn itself exporting cameras to a third server. 
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b. No Netavis Observer server must import and simultaneously export cameras from the same server. 

So there should be no loops within the architecture. 

12.2 Adding and defining a remote Observer server 

1. Choose Host admin from the System administration menu. This opens the Host admin 

dialog. 

In the menu select Add host. 

Fill in the basic information of the desired remote Observer host (server): 

 

Field label Description 

Hostname This is the name you give to the remote Observer server. It does not 

necessarily have to match the actual name of the remote server. 

Network name or IP 

address 

This is the network name or IP address of the remote Observer 

server. 

Comment A descriptive text.  

Observer Host ID This is an internal ID that uniquely identifies the remote server. The 

ID of an Observer server can be obtained by reading its own entry 
under the Host Admin tab. 

 

2. Now you can define what you want to do with the remote Observer server. Set options according 

to your requirements: 

 

Field label Description 

Send local events to 
remote server 

Check this option if you want that your local events are sent to the 
remote host. 

Import of cameras from 

remote server enabled 

Check this option if you want to import cameras from the remote 

server. 

Export local cameras to 

remote server 

Check this option if you want to export cameras of your server to 

the remote server. If this option is not enabled the remote server 

cannot access your cameras. 

Monitor remote server 
status 

Check this option if you want to monitor the status of the remote 
server in System information dialog. 

Upgrade software on Check this option if you want to allow automatic distributed 
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Field label Description 

remote server (=upgrade 
secondary node ) 

software upgrades of the remote server initiated by your current 
server. In such a case your current local server is the upgrade main 
node and the remote host the upgrade secondary node . For details 

about distributed upgrades please refer to the manual Netavis 
Observer Server Installation and Administration. 

Accept software upgrades 
from remote server 
(=upgrade main node) 

Check this option if you want to accept automatic distributed 
software upgrades of the current server (=secondary node ) initiated 
by the remote server (=main node). In such a case your current local 

server is the upgrade secondary node and the remote host the 

upgrade main node. For details about distributed upgrades please 
refer to the manual Netavis Observer Server Installation and 
Administration. 

Request license from 

remote server (=license 
main node) 

Check this option if your current Observer server should check out 

licenses from the remote server (=license main node). For details 
about floating network licenses please refer to the manual Netavis 

Observer Server Installation and Administration. 

Please note: After setting up a remote license server on a server 

that is in license-less mode, it is necessary to restart the client and 

the netavis services on the corresponding server. 

Use secure connection 

(HTTPS) 

Select this checkbox if you want to use an encrypted connection 

between the two servers (TLS HTTPS). 

Please note: Please be aware that an encrypted connection needs 

more CPU resources on both servers (see also 1.3 Observer data 
security on page 7). 

 

3. Click on Save to save your settings. Now you are ready to import cameras or camera groups from 

a remote Observer server. 

Please note: As of Netavis Observer 5.1 it is also possible to search for all configured hosts via the 

search field at the top. 

12.3 Working with cameras of another server 

In order to work with cameras from another Observer server, the following prerequisites must be 

fulfilled: 

• The servers must know of each other. 

• The server that exports cameras must have the option Export local cameras to remote 
server set. 
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• The server that works with cameras of a remote server must have the option Import of 

cameras from remote server enabled set. 

Note: See 12.2 Adding and defining a remote Observer server on page 118for more details on how to 
configure these prerequisites. 

12.3.1 Mounting cameras of another server 

1. Open the Camera admin dialog from the System administration menu. 

2. In the menu select Mount remote camera or group. 

3. Select the remote Observer host from where you want to import cameras with the Known 
remote machines menu. 

Now the Remote host name and remote host IP address of the remote Observer host are 
shown. 

4. After clicking on Cameras on remote host the remote Observer host's camera tree is shown. 

You can then select a single camera or group to be imported. 

Note: For remote cameras it is recommended to mount them per group rather than individually. 

Confirm your selection by clicking on Select. 

 

Now the camera tree shows this imported camera or group in bold with the name of the remote 
server in brackets (e.g. 209 [grey]): 
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If the remote server is not reachable, the mounted cameras are not shown in the tree; only the 
top point of the mounted camera tree appears in red color. 

5. After you mount remote cameras you can work with them as if they would be connected to this 
server. You can access live streaming via the Online Monitor or you can access the archive. If you 

have the appropriate administrator rights you can also modify camera settings like PTZ, 

scheduling or motion detection. 

Note: Only local cameras and remote camera groups can be duplicated. It is not possible to 

duplicate individually mounted remote cameras. 

12.4 Working with events of remote servers 

Observer servers can forward their events to other servers. Such forwarded events are stored in the 
event database of the generating server itself and also in the event database of the server(s) that 
receive the events. 

Event entries in the event database of remote servers look the same as local events, they just start with 
the remote server’s name and not with the name of the local server. The same kind of search and 

listing is available as with local events. 

In order to receive events from another Observer server, the following prerequisites must be fulfilled: 

• The servers must know of each other (12.2 Adding and defining a remote Observer server on 

page 118) 

• The server that exports events must have the option Send local events to remote server set 

(12.2 Adding and defining a remote Observer server on page 118) 

12.5 Monitoring remote servers 

You can monitor the status of remote servers in the System information dialog (see 11.1 Server 
system information and restarting on page 107). Before you can do that you have to tell your server to 
monitor the remote server by checking the option Monitor remote server status (see 12.2 Adding 
and defining a remote Observer server on page 118). 

12.6 Keeping multiple users servers in sync (synchronization groups) 

In a larger system that requires multiple user servers (NUS) it can be cumbersome to manually keep all 
user configuration data synchronized between all user servers. Thus Observer offers the concept of so 

called synchronization groups. 

In a synchronization group a main node user server automatically propagates its configuration data 
(complete user configuration data and camera configuration data, customer-specific resources like 



Netavis Observer 5.1 User Manual (February 2021) 

Page 122 of 214 

icons and layout navigation data) to all the other user servers in the same group. Thus the main node 

user server is the single point of all user administration (in fact changes at secondary node servers are 
no longer possible). Any changes are automatically propagated to the other user servers in the same 
group. 

Note: Servers included in a synchronization group must not have any locally added cameras and 
I/O devices! 

Whenever a server is added as a secondary node to a synchronization group, it will automatically be 
synchronized with the data from the main node sync server. 

The synchronization group settings can be modified in 11.2 Setting Observer server parameters on 

page 109 (see 11.2 Setting Observer server parameters on page 109). 

Note: When a server is added as a secondary node to a synchronization group, any configuration data 

that does not exist on the main node server will be deleted and overwritten by the data of the main 

node server. So please be careful when you work with synchronization groups. 
Also: When users connect to secondary node servers they cannot modify their user settings, this can 
only be done when they are connected to the main node user server. Thus layout navigation tool (LNT) 

project creation and icon uploads should always be done at the main node user server. 

12.7 Distributed upgrades  

When there are several Observer servers in a network upgrading servers to a newer release of Observer 
one by one can be a very cumbersome and time-consuming task. In order to ease this task, Observer 
offers an automatic distributed upgrade of all interconnected servers in a network. 

Please refer to the manual Netavis Observer Server Installation and Administration for further details. 

12.8 License allocation 

Netavis Observer 5.0 introduced the license allocation feature which adds new flexibility for the 

management of large and distributed systems with a single license server. 

Once a system has been configured to serve as a license main node the new License allocation tab 

becomes available in the Host admin: 
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Here are the steps for configuring the license allocation on the license main node: 

1. Choose Host admin from the System administration menu. This opens the Host admin dialog. 

2. Select the local host and choose Modify host. 

3. Click on Next until you reach the License allocation tab shown above which provides an 

overview of the available licenses in the first two columns. 

4. To limit the number of licenses a license secondary node (a server which requests licenses from 

this license main node) can obtain simply select the cell corresponding to the server and feature 
enter the desired number. 

5. Click on Save to save your settings. 
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13 Active Directory Integration 

You can configure your Observer server to import users from an Active Directory (AD)/LDAP server. In 

this case the users are maintained in AD/LDAP and users are imported (mapped) to a user group in 

Observer. The privileges and camera access rights of the users imported via Active Directory/LDAP can 
be defined with the Observer user group they belong to. 

When the Observer server connects the Active Directory/LDAP server for the first time, it loads all 

matched users into the user group in Observer. These users are then cached in Observer (no user 
passwords are stored in Observer). Every 15 minutes the list of users is reloaded from the Active 

Directory/LDAP server. 

Each time when a user that is defined in Active Directory/LDAP logs into Observer the password is 
checked (authenticated) with the Active Directory/LDAP server. This means that at login time a 

connection to the Active Directory/LDAP server has to be possible. 

Note: No Observer-specific information is stored in Active Directory/LDAP. 

Hint: As of Netavis Observer 5.1 Active Directory authentication is also support for the Layout 

Navigation, Mobile Client, SNAP integrations, Video4Web, and the VideoWall control application. 

13.1 Configuring the users on the Active Directory server 

All the users on the Active Directory server which should have access to Observer must be members of 

the group which will be imported by Observer (though of course they can also be members of 
additional other groups). 

1. Create a new Group with the desired Group Name (e.g. Observer4), Group Scope set to Global, and 
the Group type set to Security.  
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2. Add the desired users to the previously created group.  

 

13.2 Configuring Observer  

Now Observer must be configured to access and use the Active Directory server: 

1. Open the Host Admin, select the current Host, and click Next until you reach the Active 

Directory configuration page. 

2. Click on the New button below the Remote servers list to add a new Active Directory 
configuration.  

 



Netavis Observer 5.1 User Manual (February 2021) 

Page 126 of 214 

3. Configure the Connection parameters:  

a. Enable the configuration by checking the corresponding checkbox. 

b. Enter the Server address (IP address) and Port (the standard port is 389) of the Active 
Directory server. 

c. Enter the User name (including the name of the Active Directory server, e.g. 

NETAVIS\Administrator) and Password. 

d. Select whether LDAPS should be used. 

Note: LDAPS servers with self-signed certificates are not supported. 

e. You can test the entered configuration with the Test connection button. 

4. Select a previously defined Attribute mapping schema or create a new one by choosing Edit... 
and then clicking on New. These are the attributes which will be imported from Active Directory to 
Observer: 

• Login name tag (mandatory): Set it to cn(users login with their common name: e.g. 
John Doe) or sAMAccountName (users login with their account name: e.g. john). 

• Name tag (mandatory): Set it to displayName. 

• Email tag (optional): Set it to mail. 

5. Press Save. 

6. Open the User Admin. 

7.  For importing users from Active Directory you can either: 

i. Select an existing group (though note that this group has to be empty!) 

ii. Create a new group: 

a. Choose Add new group from the User/group menu or the right mouse click menu. 

b. Enter a Group name (e.g. AD-Users). 

c. Check the Users of this group are imported from Active Directory checkbox. 

d. Select one of the previously defined Active Directory servers. 

e. Enter the Active Directory group DN (Distinguished Name) (e.g., 

OU=Vienna,OU=Administrators,DC=netavis,DC=net) 

f. Make the appropriate adjustments on the Privileges and Camera access rights pages. 

8. Press Save. 

9. After Observer has finished synchronization with the Active Directory server (which may take up to 

two minutes) the users configured there will appear under the previously set Observer group 
name in the User admin. 

Note: The camera access rights can be set for regular individual users and Active Directory groups 
but not for regular user groups or individual Active Directory users. 

 

Note: If a user appears in multiple groups with different Privileges and Camera access rights then 
Enabled properties are prioritized (e.g., if UserA does not have a certain permission in AD-group1 but 
does have the permission in AD-group2 then the permission will be enabled for userA). 
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Hint: In case that the configuration does not work please make sure that the configuration options are 

correct. For example no leading or trailing space must be included in the configuration (e.g. 
"DC=netavis,DC=net " with a trailing space does not work if the directory address is netavis.net). 
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14 Working with Layout Navigation 

Observer offers powerful layout navigation features that allow you to navigate based on layouts, floor 
plans, and also other images. This chapter describes how to configure and use Layout Navigation. 

Note: Since Layout Navigation is licensed separately of Observer you need a valid license in order to 
work with these features. See also 11.1 Server system information and restarting on page 107 for details 
about what license you have. 

Note: Layout Navigation only works on Microsoft Windows. See 2.1 Introduction to Observer clients on 

page 11 for details on the functionality available on various platforms. 

14.1 Basic concepts and how it works 

The Observer layout navigation tool (LNT) allows you to define a hierarchy of graphical layouts that 
correspond to various aspects of your physical environment (section 14.4.1 Planning your layout 
hierarchy on page 130 provides details on how to plan the hierarchy). 

Layouts that belong together and other related settings can be grouped together in so called 
projects. Depending on the user rights, several users can access and share the same projects and by 

thus layouts and settings. 

On each layout you can place camera control icons that correspond to cameras on an Observer 
server. The camera icons on layouts are interactive, i.e. trigger certain actions when you move the 

mouse over them or click on them. Such actions can be to show camera live image streams or its 
recording archive in the corresponding Observer client running on the same client workstation. 

On layouts you can also define polygon-shaped zones that group certain cameras together and that 

allow for smart ways of highlighting on events and for good synchronization with the Observer client. 

Additionally, you can also display and acknowledge Observer events in the tool. 

All information used by the LNT (e.g. project and layout definitions, background images, and camera 

mappings) are stored on the Observer server. Users can use the same LNT information as long as they 
load the same LNT project, regardless on which client they work. 

In a typical installation you would run the Observer client on one screen and the layout navigation tool 
on another screen (see 2.3 Client multi-window and multi-screen operation on page 17 for details). 

However, you can of course run both tools on the same screen as well.  

Please note: Currently LNT can only display MJPEG camera streams (MPEG camera streams are not 
yet supported). 

14.2 Installing Layout Navigation 

Layout Navigation is available in a locally installed client (see 2.2 Working with the installed Observer 
client on page 12) or alternatively via a desktop web browser (see 2.1 Introduction to Observer clients on 
page 11). 

Note: Layout Navigation only works on Microsoft Windows and requires Windows .NET 2.0 or later. 



Netavis Observer 5.1 User Manual (February 2021) 

Page 129 of 214 

14.3 Starting Layout Navigation 

Layout Navigation can be started in three different ways: 

• in the locally installed client (please refer to 2.2.2 Starting the installed Observer client on page 
12 for more details) 

• in a desktop web browser (with the Start the Layout Navigation Tool (from the browser 
using Web Start) option on the start page of Observer) 

• in a desktop web browser with a One-Click Single-Sign-On simultaneously with the Observer 

client (with the Start the NETAVIS client and the Layout Navigation Tool (from the 

browser using Web Start) option on the start page of Observer). When using this option 

entering wrong Login credentials will result in two separate error messages.  

Hint: The size and position of the Layout Navigation window is saved and restored upon the next start 
of the application. 

The Layout Navigation main window looks like this: 

 

14.4 Setting up a project and defining layouts (Editing mode) 

In order to setup LNT for work you have to execute a few steps: 

• Plan your layout hierarchy 

• Select and upload images to be used for layout backgrounds 
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• Define the hierarchy and map your cameras 

In the next subsections we will cover the above topics. 

14.4.1 Planning your layout hierarchy 

Before you create a project and start to upload graphics images for your layouts it makes sense to plan 

the layout hierarchy. For example, if your Observer system covers a building then you could have an 
overview layout image for the building and then separate subordinate layout images for each floor. 

For an even bigger setup: If your Observer system covers a whole area with several office or plant 

buildings then you could have an overview layout image for the whole area and subordinate layout 
images for each of the buildings and additional images for the parking lots, driveways, fence sectors, 
etc. Each of the building layouts then in turn could have subordinate layout images for parts of the 

building like each of the floors. Each of the floors could additionally have subordinate layouts for parts 
of the floor or even for each of the rooms. Thus you can create hierarchies at arbitrary levels of detail. 

14.4.2 Switching to editing mode and creating a project 

1. Switch to editing mode by choosing Project > Switch to editing mode or by pushing the 

editing button  at the right side of the tool bar. 
In editing mode the LNT window now has added a new control icon list. 

2. Create a new project by choosing Project > New project and then enter a name of the new 
project in the newly opened dialog. Push OK. Now you start to upload background images for 

your layouts. 

14.4.3 Creating layouts and mapping cameras, I/O contacts, and zones 

After you planned your layout hierarchy you have to select appropriate images for the various layouts. 

The layout navigation tool supports popular image graphics file formats like GIF, JPEG, PNG, etc. 

Depending on your needs and the available screen resolution for the layout navigation you have to 

choose the size (in pixels) for your images. Please keep in mind that the LNT also supports image 
scaling to fit the available space. 

Please note: Each image's file size is limited to 2MB. For performance reasons it is recommended to 

use JPEG and PNG files and keep their sizes small. 

Creating a new layout 

To create a new layout, follow these steps: 

1. In the layout navigation tool (LNT) switch to customizing mode by choosing Project > Switch to 

editing mode or by pushing the editing mode button  at the right side of the tool bar. 

2. In the Layout menu choose New…, which opens the Layout dialog: 
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3. Enter a name for the layout. 

4. Select a background image from the list of available uploaded images or push Upload to upload 
a new background image for the layout (you can also delete uploaded images from the server by 

selecting an image from the list and pushing Delete). 

5. If the layout is subordinate to another layout then choose the parent layout from the Parent 

pop-up menu (you can change the layout hierarchy later on via the Layout > Properties 

dialog). 

6. Push OK to create the layout. 

Now you see that the layout with the selected background image has been created. 

Mapping cameras 

1. From the list of controls at the right side drag a camera control icon with the mouse onto the 

layout and drop it there. A camera selection dialog opens automatically. Choose the I/O device 

and contact and push OK. Now you have mapped the camera to your camera icon. 

Repeat the above step for other cameras. 

You can delete a camera by selecting it with the mouse by choosing Delete from the right mouse 
button pop-up menu. 

Mapping I/O contacts 

LNT allows you to work with I/O devices, i.e. you can display the state of input contacts and you can 

switch output contacts of I/O devices (for configuring I/O devices, please refer to 23.7 Configuring 

I/O devices on page 199). You can place such I/O controls onto layouts like camera controls. 

Here are some icons representing the various states of input and output contacts: 

Output contacts:   

Input contacts:   
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Impulse button:   

1. From the list of controls at the right side drag an I/O control icon with the mouse onto the layout 
and drop it there. An I/O contact selection dialog opens automatically. In the list you only see I/O 
devices that are configured with Observer. Choose the device and the I/O contact and press OK 

(depending on whether the I/O control represents an input, an output or an impulse button, you 

get only input or output contacts of the selected device). Now you have mapped the I/O device to 

the icon. 

Repeat the above step for other I/O contacts. 

You can delete an I/O contact control by selecting it with the mouse by choosing Delete from the right 
mouse button pop-up menu. 

Defining zones 

LNT allows you to group several cameras on a layout into so called zones that can have arbitrary 

polygon shapes. 

Cameras belong to a zone as long as they are positioned inside the boundaries of the zone. You can 

place an arbitrary number of zones onto a layout. 

Here is how you can create a zone: 

1. Select a layout from the layout hierarchy. 

2. Drag the Zone field with the mouse from the controls list at the right side and drop it onto your 
layout. Where you drop the zone field control with the mouse will be the first corner of the 
polygon shape and you can now define the zone shape by clicking at further corners. To finish 

the zone definition, close the polygon shape. Alternatively you can create a rectangular zone by 

pressing the CTRL key while moving the mouse. 

3. Per default the zones will be named “Zone-1”, “Zone-2” and so on. You can rename and delete a 
zone via the right mouse button pop-up menu. Zones can be moved by dragging them with the 

mouse. 

Please note: A zone can trigger certain actions, e.g. when you click with the mouse on it, a zone can 

show all cameras belonging to the zone in the Observer client. This, for example, will either create a 
new view in the Observer client or map it to an existing view depending on the names of the views and 

zones. Therefore the name of a zone can be of importance. 

Here is how the mapping works for the LNT action Show zone live in Observer Client: 
If there is an Observer view that has the same name as the LNT zone and that also contains all the 
cameras of the LNT zone, then this view is exposed in the Observer client. Otherwise a new view is 
created with the name of the zone. Details for zone actions can be found under 14.5.3 Modifying zone 

control appearance and behavior on page 135. 

Linking layouts with link fields 

LNT offers link fields to easily navigate between layouts. Link fields can be placed on layouts and are 
resizable grey areas. Clicking on a link field in Navigation mode will open the “linked” layout. 

Here is how you can link layouts via link fields:  
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1. Drag the Link field from the controls list at the right side and drop it onto your layout. Where 

you drop the zone field control with the mouse will be the first corner of the polygon shape and 
you can now define its shape by clicking at further corners. To finish the link field definition, close 
the polygon shape. Alternatively you can create a rectangular link field by pressing the CTRL key 

while moving the mouse. 

After you finished defining the shape of the link field, a dialog is opened offering the available 
layouts for this link field. Choose a layout by double clicking or by pushing the Select button. 
This defines which layout is to be opened when the link field double clicked in Navigation mode. 

2. Choose Save from the Project menu to save your changes. 

Now you can repeat the steps above to create your overall layout hierarchy. You can switch back to 

Navigation mode by clicking the navigation mode icon  at the right side of the tool bar. 

Defining a default project 

To define a default project to be loaded when LNT is started, follow these steps: 

1. In the Project menu choose Set default project… which opens a dialog listing all available 

projects. Choose a project and push Select. To not load a default project, choose <No default 

project> from the list. 

Now this project will be loaded automatically at startup. 

Defining a home layout 

A home layout can be defined which is automatically shown when the project is loaded. You can set 
the home layout by following these steps: 

1. In the layout hierarchy select the layout that you want to set as home layout. 

2. In the Layout menu choose Set as home. 

Now this layout will be opened automatically when the project is loaded. 

14.5 Customizing the behavior and appearance of controls 

LNT currently has 2 types of controls that can be modified: camera controls and zone controls (the link 

field control cannot be modified). 

LNT lets you modify several aspects of the appearance and behavior of these control icons: 

• Icon image and appearance. 

• What happens when you move the mouse over a control icon or when you click on it. 

• What happens on certain events originated by Observer related to cameras or zones. 

Also you can create new control icons with your own icon images. 

14.5.1 Modifying camera control appearance and behavior 

1. Switch to editing mode by choosing Project > Switch to editing mode or by pushing the 

editing button  at the right side of the tool bar. 

2. In the control icon list click on a camera icon with the right mouse button and choose Modify… 

from the pop-up menu. This opens the Modify control dialog: 
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In this dialog you can define the control name and image and which actions are to be performed 
on certain mouse operations and events. 

Actions 

The possible Actions are: 

• Show live in Observer Client exposes a large live view of the respective camera in the 
Observer client that runs on the same machine. If no client is running on the same 

machine, then noting is happening. 

• Show archive calendar in Observer Client exposes the archive calendar view of the 

respective camera in the Observer client that runs on the same machine. If no client is 
running on the same machine, then noting is happening. 

• Show live stream in LNT opens a window showing a live stream of respective camera in 

LNT. If this action is bound to Mouse over then the window will be automatically closed 
when the mouse is moved away from the camera icon. If this action is bound to Single 

click or Double click, then the window stays until it is closed manually. To close all such 
windows, you can select Close all live streams in the View menu. 
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• Start/Stop continuous recording starts or stops continuous recording of the camera in 

Observer. It actually sets or deletes the Enable interval checkbox in the camera admin’s 
Scheduling dialog. Please be aware that there must be at least one continuous recording 

interval for the camera for this to work (refer to 7.1.1 Scheduling continuous recordings on 
page 72 for details). 

• Start/Stop motion detection enables or disables motion detection of the camera in 

Observer. It actually marks or unmarks the Enabled checkbox in the camera admin’s 

Motion detection dialog. Please be aware that there must be at least one detection field 
definition for the camera for this to work (refer to 8.1.2 Basic configuration of server-based 
motion detection on page 86 for details). 

• Start/Stop analog video decode allows the control of special devices that decode IP-
based network video signals to analog video signals. This is useful for example for security 
center video walls that are driven by analog video signals. The configuration of these 
special devices must be done in configuration files (please refer to the Release Notes or to 

the customization documentation). 

Events 

You can also modify the behavior of control icons for certain events, like Connection to camera 

lost or Motion detected. 

3. Click OK to save changes. 

14.5.2 Adding a new camera control 

1. Switch to customizing mode by choosing Project > Switch to editing mode or by pushing the 

customize button  at the right side of the tool bar. 

2. In the control icon list click the right mouse button and choose Add control… from the pop-up 
menu. This opens the Add new control icon dialog which is essentially the same as the Modify 

control icon dialog (see 14.5.1 Modifying camera control appearance and behavior on page 133). 

Here you can define the icon name and image and which actions are to be performed on certain 

mouse operations. 

You can also modify the behavior for certain events, like color and blinking. 

3. Click OK to create the new camera control icon. 

14.5.3 Modifying zone control appearance and behavior 

1. Switch to editing mode by choosing Project > Switch to editing mode or by pushing the 

editing button  at the right side of the tool bar. 

2. In the control icon list click on a zone icon with the right mouse button and choose Modify… 

from the pop-up menu. This opens the Modify Zone dialog: 
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In this dialog you can define the color of the zone and which actions are to be performed on 
certain mouse operations and events. 

Actions 

The possible Actions are basically the same as for the camera control (see 14.5.1 Modifying 
camera control appearance and behavior on page 133) with one addition: 

• Show zone live in Observer Client exposes the corresponding view of the zone in the 

Observer client that runs on the same machine. If there is an Observer view that has the 
same name as the LNT zone and that also contains all the cameras of the zone, then this 

view is exposed in the Observer client. Otherwise a new view is created with the name of 
the zone. 

Events  

You can also modify the behavior of zones of this type for certain events, like Connection to 
camera lost or Motion detected. 
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The event View selected in Observer Client works this way: If there is an LNT zone with the 

same name as the view in Observer then the corresponding action is triggered. 

3. Click OK to save changes. 

14.5.4 Adding a new zone control 

1. Switch to customizing mode by choosing Project > Editing mode or by pushing the customize 

button  at the right side of the tool bar. 

2. In the control icon list click the right mouse button and choose Add zone… from the pop-up 
menu. This opens the New zone dialog which is essentially the same as the Modify Zone dialog 
(see 14.5.3 Modifying zone control appearance and behavior on page 135). 

3. Click OK to create the new zone control. 

14.5.5 Modifying I/O contact control appearance and behavior 

1. Switch to editing mode by choosing Project > Switch to editing mode or by pushing the 

editing button  at the right side of the tool bar. 

2. In the control icon list click on an I/O control icon with the right mouse button and choose 

Modify… from the pop-up menu. This opens the Modify control dialog for the corresponding 

I/O control type: 

 

In this dialog you can define the name of the control and the two images for activated and 

deactivated states. For the Impulse Button you can also set the Impulse Duration (ms) and 
whether 0 or 1 should be set. The control type (Input, Output, Impulse Button) cannot be 
modified. 

3. Click OK to save changes. 

14.5.6 Adding a new I/O contact control 

1. Switch to customizing mode by choosing Project > Switch to editing mode or by pushing the 

customize button  at the right side of the tool bar. 

2. In the control icon list click the right mouse button and choose Add I/O contact… from the 

pop-up menu. This opens the Modify I/O Contact Control dialog (for a screenshot see 14.5.5 

Modifying I/O contact control appearance and behavior on page 137). 

In this dialog you can define the name of the control and the two images for activated and 
deactivated states. Also set the Control type: An Input contact displays the state of the input 
contact of an I/O device. An Output contact allows you to switch an output contact of an I/O 
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device. An Impulse button allows you to manually switch an output contact for a predefined 

period of time. 

For example, for an input contact that shows the state of a gate barrier you can use images that 
reflect the open and closed state of the barrier. 

3. Click OK to create the new camera control icon. 

14.6 Layout navigation and operation (Navigation mode) 

Switch to Navigation mode by clicking the navigation mode icon  at the right side of the tool bar or 
by choosing Project > Switch to navigation mode. 

Note: An Observer client must be running under the same user on the same client workstation so that 
it can be controlled by Layout Navigation. 

14.6.1 Peeking live video of mapped cameras 

The default behavior of some camera icons is that you can peek at live video of mapped cameras by 

moving the mouse pointer over a camera icon. Then the live video stream will be shown on top of the 

layout: 

 

As soon as you move the mouse pointer away from the icon, the stream disappears. This behavior can 

be changed with the Modify control icon dialog (see 14.5.1 Modifying camera control appearance and 
behavior on page 133). 

14.6.2 Showing a camera in the Observer client 

When you single click a camera icon in LNT then the corresponding camera will be shown in full size 
in the Observer client. This behavior can be changed with the Modify control icon dialog (see 14.5.1 

Modifying camera control appearance and behavior on page 133). 

Alternatively a camera can also be dragged from Layout Navigation and dropped into a specific view 
port in the Observer client to show its live stream there. 
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Note: An Observer client has to be running on the same machine being connected to the same server 

in order for the feature to work (the client will not be started automatically by LNT). 

14.6.3 Positioning to the camera recording archive in the Observer client 

When you double click a camera icon in LNT then recording archive of the corresponding camera will 
be shown in the Observer client running on the same machine. This behavior can be changed with the 

Modify control icon dialog (see 14.5.1 Modifying camera control appearance and behavior on page 

133). 

Note: An Observer client has to be running on the same machine being connected to the same server 
in order for the feature to work (the client will not be started automatically by LNT). 

14.6.4 Navigating in the layout hierarchy 

You can position to a layout by clicking its name in the layout hierarchy. 

You can also jump to a connected layout by clicking a link field. 

14.6.5 Working with events in the layout navigation tool 

The layout navigation tool (LNT) also allows you to view and acknowledge Observer events.  

Please note: Event handling will only work if the user has the rights to work with events. 

When a new event occurs in Observer, then it is displayed in the Event list at the right side of the LNT 
window (the Event list can be switched on and off in editing mode by choosing View > Event list).  

The Project settings define what happens when a new event is coming in (see 14.6.7 Project settings on 

page 140): The layout that contains the primary control for related to the event can be exposed 

automatically and also the control that is related to the event can be highlighted (blinking rectangle). 

Additionally a longer description is displayed in the Event description field at the bottom of the 

window (which also can be switched on and off in Editing mode by choosing View > Event 
description). 

You can acknowledge an event by pushing Acknowledge in the Event description field. 
Acknowledged events will be removed from the Event list. Pressing Cancel sets the state of the event 

to seen (visited) but does not acknowledge it. 

Please note that for each camera, a primary control can be defined that is exposed when a new event 

is generated. You can set the primary flag for a camera icon by right-clicking on the icon in editing 

mode and choosing Primary from the pop-up menu. 

Generally, events in LNT can have the following states (indicated by different colors of the event entry): 

• New (unseen) events are shown as grey (if it is selected then it is shown in green). 

• Seen (visited) events are shown in blue. 

• Acknowledged events are removed from the list. 

When there are several new events, then LNT offers you to see (visit) them one by one. The exact 
behavior of the visiting and how the event state can be set to seen (visited) can be defined in the 
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Project settings (see 14.6.7 Project settings on page 140). You can, for example, mark a new event as 

seen and jump to the next event by moving the mouse over the blinking control. 

14.6.6 Camera status display 

LNT allows you to display certain states of cameras in the mapped camera and zone control icons. 
Examples for states that can be displayed are recording, motion detection active, broken connections, 
etc. 

An example of a status display is: 

 

This camera currently is recording and has motion detection enabled. 

To modify the status display settings, follow these steps: 

1. Switch to editing mode by choosing Project > Switch to editing mode or by pushing the 

customize button  at the right side of the tool bar. 

2. Choose Project > Camera status display settings… which opens the Status display 

settings dialog. 
This dialog now allows you to define the status settings for camera and zone controls. You can 
modify the status display settings according to your needs. You can also enable/disable certain 

status displays by setting the Enabled flag. 

3. Push OK to save your changes or Cancel to discard them. 

When you switch to navigation mode, the new settings become effective. 

14.6.7 Project settings 

The layout navigation tool (LNT) allows you to set several project settings that define the workings of 

the tool. In the Project menu choose Project settings… to open the Project settings dialog. 

Here you can set the following values: 

 

Setting Description 

Show home layout on load Defines whether the Home layout is shown when the tool is 

started. In order for that to work you must have a home 
layout defined. 

Highlight zone under mouse 

cursor 

Defines whether zones will be highlighted when you move 

the mouse over them. This can be useful for distinguishing 
when the mouse cursor is over the zone or over the camera 

control icon on top of the zone. 

Automatically jump to layout on 
event 

In case of an event this setting defines whether the layout 
that contains the primary control related to the event 
should be exposed. 
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Setting Description 

Visiting order of events Defines in which order new events are to be visited. 

Set event state to seen (visited) by When a new event comes in or an existing event is selected, 

the related control blinks or is highlighted. This setting 
defines with what mouse operation the state of the event 
can be set to seen (visited) (blinking is stopped). 

Only suggest events of mapped 
images for visiting 

If this checkbox is marked then only events of mapped 
cameras will be suggested for automatic visiting. If it is 
unchecked then all events will be suggested. 

Standard view size for layouts Defines the default image size, either Fit image or Full 
size. 

Event list insertion mode Defines whether new events in the Event list are inserted 
from the Top or from the Bottom. 
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15 Video analytics with iCat 

iCat is the video analytics toolkit of Observer. It provides powerful and easy-to-configure object 
detection and tracking mechanisms as well as a statistics module with integration to the event 
management system EMS. 

iCat can also interface to 3rd-party video analysis toolkits and algorithms (contact Netavis Software 
GmbH). 

Please note: Since iCat and some functions are licensed separately of Observer you need a valid 
license in order to work with these features. See also 11.1 Server system information and restarting on 
page 107 for details about what license you have. 

15.1 iCat highlights 

• iCat works with any camera that can deliver an MJPEG, MxPEG, MPEG-4, H.264 or H.265 

stream (this covers also analog cameras that are connected via a video server). 

• iCat is easy to configure and setup and it works in difficult situations also with extreme 
camera perspectives. 

• It offers flexible scheduling of iCat definitions depending on date and time. Thus you can 

have different setups for weekdays and weekend as well as day and night. 

• All iCat video analytics modules can provide the resulting video analytics data while optional 

privacy masks cover the video streams. Additionally it is possible to run iCat video analytics 
without storing any associated recordings. As such only the iCat video analytics data 

output is stored and no video streams are available, neither live in the Online Monitor nor as 
recordings in the Archive Player. This is particularly useful for installations in the retail sector 

(e.g. for obtaining the customer frequency and customer segmentation via iCat video analytics). 

• The iCat Number Plate Recognition module detects number plates for use in vehicle entry, 
parking, and free flow scenarios. 

 

• The iCat Traffic module enables applications for roads and highways: Traffic Monitoring, 
Stopped Vehicle Detection, Wrong Way Detection. 

 

• The Face Detection module automatically detects human faces in video streams and 
estimates the person’s age group and gender. 
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• The Smart Tripwire function for people and object counting prevents wrong and double 

counting and works even with the most difficult entrance situations. 

 

• The Smart Tripwire also allows detecting wrong direction movements of people and objects. 

• Powerful and robust object tracking and event triggering can be constraint to object 

sizes, speeds, and other properties. 

 

• Heat maps allow you to view various object statistics in an intuitive way. 

 

• Event statistics can be manually exported to Excel or automatically into .csv files for further 

processing. 

• All iCat detection annotations are available for live streams and in archived recordings. 

• Seamless integration with the Observer event management system EMS and other Observer 
functions. Additionally iCat offers camera sabotage detection and lighting change 
detection. 

• iCat algorithms have been tuned for the highest performance and least burden on the 

server. 

15.2 Basic iCat concepts 

iCat basically consists of the following components that are tightly integrated with Observer: 

1. An object detection and tracking engine analyzes the video stream and tracks detected objects. 

Please be aware that an object has to show consistent motion first in order to be detected and 
tracked. 
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2. An event logic engine with configurable event triggers decides when a tracked object triggers an 

event. 

3. A real-time statistics module stores statistical information about various aspects of objects like 

object sizes and speeds.  

For setting up a camera with most iCat video analytics features you essentially configure the following 
things: 

Object tracking region: The object tracking region defines the part of the camera view in which iCat 
is detecting and tracking objects. For each camera you can define one tracking region that is either the 

full camera view or a part of it in the form of a polygon or rectangle. No object will be detected or 
tracked outside of this tracking region. Since the CPU overhead caused by iCat is directly proportional 

to the size (area) of all the active tracking regions of all active cameras of a server, optimizing the 
tracking regions will save CPU power. Region definitions can also be used to mask out problematic 
areas in the scene as well (e.g. swaying trees). 

For each tracking region you can also define what object statistics should be measured by iCat. Such 
statistics can then be visualized. 

Event triggers: Each camera can have several event triggers that define under what conditions an 
event is generated by the detected objects. Event triggers only work inside of the object tracking 
region. Examples of event triggers are people or object counters and detectors of stopped or started 
objects. The CPU load caused by event triggers compared to the tracking region is negligible. 

Scheduling: The standard Observer scheduling mechanisms are also used for scheduling (activating) 

various iCat setups. For example, it is possible to have different iCat settings for weekdays and 

weekends. 

15.2.1 Considerations for setting up a system with iCat 

Camera selection and placement  

Though iCat is able to analyze video captured by any type of supported camera, using a device with 

higher image quality will result in better detection and tracking. The iCat video analytics features work 
with in- and outdoor cameras as well as for different perspectives. The configuration of these features 

in Netavis Observer is pretty simple, as you will see below. 

For people and object counting, the best results are possible if the camera is mounted overhead 

downward looking. 

Please note: Setting up iCat definitions for PTZ cameras is problematic since most of the iCat 
functions require a fixed camera position. 

Video streams, codecs, and multi-streaming 

iCat video analytics works with any supported camera (including analog cameras that are connected 
via a video server or encoder). If the camera has been configured with stream profile with an MJPEG 
stream, iCat uses this format because it is the most efficient for video analytics. If the camera provides 

only MPEG formats (MPEG-4, H.264, H.265, and MxPEG) then iCat can also work on these streaming 
formats. However, please be aware that video analytics on MPEG streams requires a lot more CPU 
power than on MJPEG streams since the decoding is much more complex (for multi-stream operation 
please see below). Also video analytics in MPEG streams causes additional delays because it works on 

groups of pictures or frames (so called GOPs). As a rule of thumb, iCat adds a delay of approximately 1 
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GOP duration. Depending on the actual MPEG cameras model, a GOP duration is between 0.5 and 1 

sec (see also 4.2 Adding a new camera and basic configuration on page 31). 

Per default iCat automatically selects the best available video stream profile depending on the specific 
iCat type whereby the following minimum requirements are considered: 

• Motion detection: minimum QVGA resolution (320x240 pixels) 

• iCat video analytics (with object tracking region, e.g., people counting and heat maps): 
minimum VGA resolution (640x480 pixels) with at least 15fps 

• iCat Face Detection: minimum 720P resolution (1280x720 pixels) with at least 15fps 

• iCat NPR: minimum 720P resolution (1280x720 pixels) with at least 15fps 

The video stream profile selected for iCat on each camera is shown in its Video Analysis (iCat) tab. 

Additionally, it is possible to manually select which stream should be used by iCat video analytics via 

the Stream used for iCat configuration option available in the Video Analysis (iCat) admin. 

Please note: The Stream used for iCat information only refreshed upon the initial selection of a 
camera. Subsequent changes only become visible after selecting a different camera and then 

switching back to the original one. 

Hint: When using multi-streaming it is strongly recommended to use video streams with identical 
aspect ratios. This is particularly important when using a (dynamic) privacy mask since differing aspect 

ratios can lead to areas which should be covered becoming visible! 

CPU load of iCat (performance issues)  

iCat runs on the server and works very efficiently. The CPU overhead caused by iCat is directly 
proportional to the following aspects (see also 15.2 Basic iCat concepts on page 143): 

• The size (area) of all the active tracking regions of all cameras of a server. This means that 
optimizing the tracking regions will save CPU power. The number and shape of event triggers is 

negligible. 

• The video processing speed (in fps) of iCat. 

• The streaming format (see above). 

An Observer server running with iCat on standard (not high-end) server hardware can easily handle 

approximately 10 iCat-enabled cameras with standard settings. Additional CPU power (e.g., additional 
cores), enhanced RAM speed, and bigger L2 caches help to boost the iCat performance. 

Object detection 

Depending on the sensitivity and other settings iCat currently detects objects of 8x8 pixels or bigger in 
size (in a VGA image). Only moving objects are detected. New objects are detected by iCat after a few 

video frames. How quickly objects are detected is also influenced by the sensitivity setting. 

iCat video processing speed 

If the objects you want to track move very quickly across your camera view you will require a higher 

video processing speed of iCat than if they move slowly across your camera view. As a rule of thumb 
the optimal frame rate for object detection and tracking is 15 fps. 
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Note: Not the absolute speed of the objects influences what processing speed you need but the 

relative speed that these objects have in your camera view. This relative speed is influenced by the 
camera perspective and distance from objects. Example: Cars on a highway are moving very fast. 

However if you look at them with a camera from a larger distance and from a perspective with a flat 
angle the cars are actually are moving pretty slowly in your camera's view. Therefore you can choose a 
slower video processing speed even for such fast objects like cars on a highway. 

15.3 Setting up a camera for video analytics with iCat 

15.3.1 Working with iCat definitions 

Several options for working with iCat definitions are available in the right-click mouse menu: 

• Add new definition: Opens the dialog for adding a new iCat definition. 

• Delete selected definition: Deletes the iCat definition. 

• Modify selected definition: Allows the modification of the iCat definition. 

• Duplicate definition: Creates a copy of the selected iCat definition on the same camera. 

• Deny modification of selected definition: Makes an iCat definition read-only so other users 
cannot modify or delete it. The names of read-only definitions are displayed in italics. 

• Reset traffic direction learning: Only applicable for Wrong Way Driver definitions. See 
15.3.13 Defining Wrong Way Detection on page 160 for more information. 

• Reset all heat map values on this host: Resets the heat map values of all cameras on this 

server. 

15.3.2 iCat event settings 

Event properties can be configured for each iCat definition: 

1. You can enter an optional Comment which is shown in the event details. 

Hint: You can also use the Comment field to configure certain views to be shown to one or 

multiple users when an iCat event occurs. See 6.10 Dynamic View Control in Online Monitor on 
page 64 for more information. 

2. You can choose a specific Icon, Sound, and Highlight color for the event when it is shown in 
the Event list. 

3. You can also define a special event priority for events generated by the iCat definition by setting 

the value Priority of generated event. Please note that the event priority is a relative priority 
whereby 100 is the default priority (see also 9 Handling events on page 92). 

4. For more information on the Dynamic view action configuration please see 6.10 Dynamic View 

Control in Online Monitor on page 64 

5. The check boxes Save event in event list and Do not save event in event list allow you to 
selectively override the general setting for the camera schedule which is defined in 15.3.16 

Scheduling iCat video analytics and recordings on page 164). 
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15.3.3 Defining an object tracking region 

1. Choose Video analysis (iCat) from the System administration menu. This opens the Video 
analysis (iCat) dialog. 

2. Select a camera in the camera tree and in the menu select Add new definition. 

3. In the Type pop-up menu choose Object tracking region. 

4. In the Identifier text field enter a name for this region. 

5. Choose whether you want a Polygon or Rectangle shape by checking the respective check box. 

6. Now you can draw the region with the mouse in the preview pane. For a polygon you just click 

with the mouse to define the corners of the polygon. You close the polygon by crossing an 
existing edge or by double clicking with the mouse. Here is an example of a tracking region: 

 

Please note: As indicated in 15.2 Basic iCat concepts on page 143 and 15.2.1 Considerations for 
setting up a system with iCat on page 144 objects will only be detected and tracked inside a 

tracking region. Event triggers will only work inside the boundaries of tracking regions. On the 

other hand, making the object tracking region as small as possible helps you to save CPU power 
of your Observer server.  

Also be aware that the tracking region should approximately at least be twice the size of the 
biggest objects you want to track. 

7. Now you have to set the configuration parameters of the tracking region: 

 

Field label Description 

Indoor camera Enable this setting if the camera is an indoor camera. Indoor setting 
usually is best for rooms not bigger than 10x10m and objects not 
farther away than 15m. Disable this check box for outdoor 

environments. Experiment with this setting, if the 

detection/tracking quality is not ideal. 

Overhead downward 
looking 

This setting only takes effect if Indoor camera is enabled. Enable 
the setting if the camera is overhead mounted and downward 
looking. This will improve object separation and the accuracy of 
object counting. In our example above, the camera is an indoor 

camera and mounted overhead downward looking. 
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Field label Description 

Sensitivity Usually this setting should be left at Normal. Only if you are not 
satisfied with the object detection quality or behavior you can try to 
modify this setting. 

If you want a sharper object detection and separation, you can set 
the Sensitivity to High or Very high. Also for example, if you want 

to detect very small objects, you can improve the sensitivity. The 
Sensitivity also influences how fast new objects are detected. 
Higher Sensibility means quicker object detection, lower means 

slower detection. 

For environments that are very noisy visually and that cause too 
many objects to be detected, the Sensitivity can be set to Low or 
Very low.  

Max object lifetime (sec) Defines how long a detected object is tracked before it is dismissed 

by iCat (i.e. no longer treated as object but essentially becoming 
background). After an object is being dismissed by iCat, if it starts 

moving again, it will be detected as new object. The setting is useful 
to lower the probability of falsely tracked objects which remain in 

the scene for too long. If you experience that objects are no longer 
tracked though they are visible and moving, this value might have 

to be increased. 

Max stopped object 
lifetime (sec) 

Defines how long a detected object that stopped is tracked before it 
is dismissed by iCat (i.e. no longer treated as object but essentially 

becoming background). After an object is being dismissed by iCat, if 

it starts moving again, it will be detected as new object. 
The setting is useful for removing false detections (usually caused 
by environmental changes) which often remain still for a longer 

period. If objects in the scene usually stop longer than this time 

limit, then set it higher. 

Video processing (fps) This defines at what frame rate the iCat algorithms operate. If the 

objects you want to track move very quickly across your camera 
view you want to improve the speed. If they move slowly across the 

camera view you can decrease the speed. See also 15.2.1 
Considerations for setting up a system with iCat on page 144. 

Tolerance radius for 

stopped object (%) 

Defines when how much a stopped object may move away from its 

stopping position before iCat detects it to move again. 

There is a virtual circle centered at the object's center point. In this 
field one can define its radius proportional to the size of the object. 
If the object's center remains inside the circle it is detected as 
stopped. When this value is set close to 100%, slowly moving or 

loitering objects will be detected as stopped. It also influences the 
statistics of stopped objects. 
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Field label Description 

Reinitialize on light change Defines whether the iCat object tracking region will be re-initialized 
if there are significant light changes (e.g. a flashlight that is turned 
on in a dark environment). 

Slow adaptation This option lengthens the learning period to distinguish between 
the static background and moving objects. It can be useful for 
particularly crowded scenes in people counting applications. 

 

8. Press Next to get to the Heat map data collectionheat map settings for the object tracking 

region. Here you can define what heat map data iCat should collect. Later on the resulting heat 
maps can be shown in the Online monitor and Archive player (see 15.4.2 Displaying heat 

maps on page 166). Currently, the following data can be collected: 

• Count statistics 

• Speed statistics 

• Stopped object count statistics 

• Object stopping time statistics 

• Size statistics 

• Object count 

• Object speed 

• Stopped object count 

• Object stopping time 

Netavis Observer 4.6 introduced two new features for heat maps: 

a. Normalizing the heat maps of all cameras (see 11.2 Setting Observer server parameters on 

page 109 

b. Resetting the heat maps (applied to all cameras on this server!):  

• Manually: Select the corresponding Object Tracking Region definition, right-click on it, 

and select Reset all heat map values on this host.  

• Automatically: Configure the Heatmap statistics reset method option in the Host 
Admin (see 11.2 Setting Observer server parameters on page 109 

9. Press Save to create the tracking region. Later on you can modify the tracking region settings. 

10. If you did not yet define the scheduling for iCat activities, then after you save the first iCat 
definition for a camera, you will be prompted for whether you want to edit the scheduling now. 

Click on the Yes button if you want to configure the scheduling now (refer to section 15.3.16 

Scheduling iCat video analytics and recordings on page 164 for further information). 

Click on the No button if you do not wish to schedule the recording or if you want to do that later. 
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Please note:  

- If you add a new iCat definition, it will automatically be assigned to all iCat schedules of the 
camera. If you do not want that, you have to remove the assignment manually (see 15.3.16 

Scheduling iCat video analytics and recordings on page 164).  
- If a definition is not assigned to a schedule then it will not be activated and no archive 
recordings will be made and no events will be generated.  

15.3.4 Defining an event trigger for people and object counting (Smart Tripwire) 

Once you have created a tracking region, you can create an arbitrary number of event triggers inside 
this tracking region. Event triggers define under what conditions an Observer event is generated by 
iCat. Such events can trigger automatic recording and are stored in the normal Observer event 

database that can be queried and exported. 

Currently iCat supports the following event triggers: 

• A Smart Tripwire for directional people or object counting. This tripwire is directional, so if you 

want to count objects in two directions you would create two tripwires. 

• A polygon or rectangle that creates an event when an object either crosses the field, stops 

inside the field or starts moving inside the field (e.g. for perimeter protection). 

Please note: Before you can define an object trigger you must first define an object tracking region 

(see 15.3.3 Defining an object tracking region on page 147). 

Here are the steps for creating a counting tripwire: 

1. Choose Video analysis (iCat) from the System administration menu. This opens the Video 
analysis (iCat) dialog. 

2. Select a camera make sure that you have a suitable tracking region defined that allows for object 

counting. 

3. Choose Add new definition from the menu. 

4. In the Type pop-up menu choose Event trigger, which will expose the configuration settings. 

5. Under the camera preview choose the Tripwire check box for directional people or object 

counting. 

6. Now you can draw the tripwire line with the mouse in the preview pane (whereby the previously 
defined object tracking region is also visible for your reference). You just click with the mouse to 
define the corners of the polygon. You finish the line by double clicking with the mouse. Here is 
an example of a tripwire: 
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This tripwire triggers a counting event whenever an object moves from the green area across the 

red tripwire. The tripwire is “smart” as it only counts objects that have first been detected in the 

green area and move across. It would not count the object if it would first be detected in the non-
green area, then moved across the line into the green and then move across the tripwire from the 

green to the non-green area. It also would not double count an object that would have moved 

across the line twice. 

Hints: To count incoming and outgoing people or objects you would create two different 
tripwires with opposite green areas which would both trigger events. 

You can also use the tripwire to detect objects moving in the wrong direction. 

Please note: As indicated 15.2.1 Considerations for setting up a system with iCat on page 144 
objects will only be detected after a few frames. Therefore an object can move a bit before it is 
actually detected as object by iCat. Therefore it makes sense to have the green area big enough 

to allow iCat time for the object detection. If that is not the case it might be possible that quickly 

moving objects are not detected before they cross the tripwire and therefore would not be 
counted. The ideal settings depend on viewed (relative) object speed and iCat video processing 

frame rate. 

Do not place the tripwire too close to areas where objects exit the scene (e.g. image borders, 

doors), because they might disappear before crossing the tripwire. It is a good practice to draw 
the tripwire about half the average object size away from such areas. 

7. You can also define when an object is counted by either selecting Object center point, Any 

point of object, or Whole object. The most appropriate choice in most cases is Object center 
point because of its robustness. 

8. When you press the Next button you can define additional constraints for the event creation. 
You can limit the counting only to certain object sizes, certain aspect ratios, and a certain speed.  

Currently those measures are definable in pixels (please keep in mind that the resolution iCat 

works on is either CIF or QVGA depending on the aspect ratio of the camera). Future releases of 

iCat will allow for real world measures. 

Zero values in these fields mean that there is no constraint. 

Hint for constraining the object size or speed: The size is the area of the object in pixels and 
the speed is also measured in pixels per second. To know what object sizes or speeds you want 
to filter it is helpful to watch a few objects passing the triggers and switch on the object markers. 
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These markers show the size and speed of the object in pixels. These are exactly the same 

measures that you can use for the trigger. Here is an example of an object marker (Object ID is 
[10], object size is 9110 pixels, speed is 208 pixels/sec): 
 

 
 
The section 15.4.1 Displaying iCat information in the Online Monitor and when playing recordings 

on page 165 shows you how to view object markers. 

9. In the Identifier text field enter a name for this event trigger. An example name for a people 

counter would be "Entrance 1 incoming". 

10. Press Save to save your definition. 

Please note: 

• If you add a new iCat definition, it will automatically be assigned to all iCat schedules of 

the camera. If you do not want that, you have to remove the assignment manually (see 
15.3.16 Scheduling iCat video analytics and recordings on page 164). 

• If a definition is not assigned to a schedule then it will not be activated and no archive 
recordings will be made and no events will be generated. 

Hint: For more details on using NetavisObserver for people counting please refer to the People 
Counting with iCat White Paper available in the documentation section of our website. 

15.3.5 Defining an event trigger for object starting and stopping 

In addition to object counting, iCat also offers to detect starting, crossing, and stopping objects in a 

defined field. 

Here are the steps for creating an event trigger for object starting and stopping: 

1. Choose Video analysis (iCat) from the System administration menu. This opens the Video 
analysis (iCat) dialog. 

2. Select a camera and make sure that you have a suitable object tracking region defined that 
allows for object counting (see 15.3.3 Defining an object tracking region on page 147). 

3. In the menu select Add new definition. 

4. In the Type pop-up menu choose Event trigger, which will expose the configuration settings. 

5. Under the camera preview choose the Rectangle or Polygon check box. 

6. Now you can draw the field with the mouse in the preview pane (whereby the previously defined 
object tracking region is also visible for your reference). For a polygon you just click with the 
mouse to define the corners of the polygon. You close the polygon by crossing an existing edge 
or by double clicking with the mouse. 

7. Now select on what object behavior you want to trigger an event: When an Object is crossing 

field, when an Object starts moving in field, or when an Object stops in field. You can also 
define when an event is triggered by choosing Object center point, Any point of object, or 
Whole object. 

http://www.netavis.net/en/support/documentation
http://www.netavis.net/
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8. In the text field Minimum time for staying inside field (sec) (for Object is crossing field 

event triggers) or Min. time for stopping/staying inside (sec) (for Object stops in field 
triggers) you can enter a minimum time required for an object that either stops or stays inside a 
field before an event is triggered. 

9. When you press the Next button you can define additional constraints for the event trigger. You 

can limit the counting only to certain object sizes, certain aspect ratios, and a certain speed.  
Currently those measures are definable in pixels (please keep in mind that the resolution iCat 
works on is either CIF or QVGA depending on the aspect ratio of the camera). Zero values in these 

fields mean that there is no constraint. 

Hint for constraining the object size or speed: The size is the area of the object in pixels and 

the speed is also measured in pixels per second. To know what object sizes or speeds you want 
to filter it is helpful to watch a few objects passing the triggers and switch on the object markers. 
These markers show the size and speed of the object in pixels. These are exactly the same 

measures that you can use for the trigger. Here is an example of an object marker (Object ID is 
[10], object size is 9110 pixels, speed is 208 pixels/sec): 
 

 
 
The section 15.4.1 Displaying iCat information in the Online Monitor and when playing recordings 

on page 165 shows you how to view object markers. 

10. In the Identifier text field enter a name for this event trigger. 

11. Push Save to save your definition. 

Please note:  

- If you add a new iCat definition, it will automatically be assigned to all iCat schedules of the 
camera. If you do not want that, you have to remove the assignment manually (see 15.3.16 
Scheduling iCat video analytics and recordings on page 164).  

- If a definition is not assigned to a schedule then it will not be activated and no archive 
recordings will be made and no events will be generated.  

15.3.6 Defining sabotage detection 

iCat offers intelligent features for detecting three types of camera sabotage actions: 

• Camera defocused 

• Camera covered 

• Camera moved 

Please note: For sabotage detection an object tracking region is NOT needed. 

When initializing the camera for sabotage detection please make sure that the camera has the correct 
focus setting and that the scenery and brightness is stable. 

Here are the steps for installing iCat-based sabotage detection: 



Netavis Observer 5.1 User Manual (February 2021) 

Page 154 of 214 

1. Choose Video analysis (iCat) from the System administration menu. This opens the Video 

analysis (iCat) dialog. 

2. Choose a camera and in the menu select Add new definition. 

3. In the Type pop-up menu choose Sabotage detection, which will expose the configuration 

settings. 

4. Select any of the three sabotage detection types. 

5. In the Identifier text field enter a name for this sabotage detection. 

6. Push Save to save your definition. 

Please note:  

- If you add a new iCat definition, it will automatically be assigned to all iCat schedules of the 

camera. If you do not want that, you have to remove the assignment manually (see 15.3.16 
Scheduling iCat video analytics and recordings on page 164).  
- If a definition is not assigned to a schedule then it will not be activated and no archive 

recordings will be made and no events will be generated.  

Background information on sabotage detection algorithms 

Sabotage detection uses three detector algorithms to generate events for camera moved, defocused 

and covered. 

The camera movement detector tries to locate a couple of strong (= has high contrast) points across 
the entire picture. Then it searches for them on each of the following frames, while continuously 

creating new points to keep adapting to a new scenery. A "camera moved" event occurs when a given 
number of these points are lost for a while. 

The focus change detector acts like the auto focus algorithms in digital cameras. It estimates the 

average sharpness of the picture and produces an event if this sharpness changes abruptly. A "focus 

lost" event is produced if the sharpness of the picture decreases below a threshold, and a "focus 
gained" event if the sharpness is increased above a threshold. Both thresholds are based on average 
sharpness values of previous frames. 

The camera covered detector uses a brightness analyzer that calculates the average brightness of the 
picture for each frame and if something strange happens tries to find out what has happened (light 

switched off, light switched on or just a person in dark clothes passed by). It does so by analyzing a 
sample of average brightness values collected in previous frames. 

The result of the these three detectors are combined to give the final alarm event (camera moved, 
camera covered, focus lost/gained, brightness change) 

Possible reasons of missed or wrong detections 

As mentioned above the camera movement detector works with high contrast points on the picture 

and the focus change detector checks the sharpness of the picture (measuring the sharpness of 
edges). Logos or date and time text fields generated and placed on the picture by the camera could 

decrease the accuracy of these detectors or could even prevent detection at all. This is because such 
overlay fields are always stable, have a high contrast and sharpness and can therefore balance real 
picture changes, so that the overall change is too small to be detected. 

The solution is to disable the text overlay at the camera's own web page. 

"Focus lost" and "focus gained" events: 
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A dynamic scene with moving objects of various sizes always changes the average sharpness a little bit 

and the detector tries to filter out these small variations. This is not always possible, so one can 
sometimes experience false "focus lost" or a "focus gained" events. 

Covering the camera should cause a "camera covered" event, but the effects of the covering could be 
very similar (from the algorithm's point of view) to a moved camera or to a lost focus. So the algorithm 
has to decide what happened and the result is not always the proper event category (one may get 
"camera moved" and more usually "focus lost" instead of "camera covered"). However, a sabotage 

event should occur at unusual situations, it is just possible that the detailed category will not match 
the actual reason. 

Hint: As the three sabotage types have many properties in common, to get the best detection rate 
switch on all sabotage categories. For example, a camera cover event might be categorized as a focus 
lost, because then image sharpness drops dramatically. If this category is also switched on, the 
sabotage will surely be detected. 

15.3.7 Defining simple motion detection 

Prior to release R1.12 Observer offered simple motion detection based on a detection of changed 
pixels between video frames. Since then this detector has been made more robust and it is now part of 
iCat toolbox. Simple motion detection does not require an object tracking region. 

For more details on setting up and working with this simple motion detection please refer to 8 Working 

with motion detection on page 86. 

15.3.8 Detecting a lighting change 

Please follow these steps to enable lighting change detection: 

Please note: For lighting change detection an object tracking region is NOT needed. 

1. Choose Video analysis (iCat) from the System administration menu. This opens the Video 
analysis (iCat) dialog. 

2. Choose a camera and in the menu select Add new definition. 

3. In the Type pop-up menu choose Lighting change detection, which will expose the 

configuration settings. 

4. Select the checkboxes for Light switched on and Light switched off to detect abrupt lighting 

changes like when somebody switches the light on or off. 

You can also enter values in the Brightness high limit (%) and Brightness low limit (%) 

fields to detect slower lighting changes like during sunrise and sundown. If you leave these 
values empty, then slower lighting change detection will be disabled. 

5. In the Identifier text field enter a name for this definition. 

6. Push Save to save your definition. 
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Please note:  

- If you add a new iCat definition, it will automatically be assigned to all iCat schedules of the 
camera. If you do not want that, you have to remove the assignment manually (see 15.3.16 

Scheduling iCat video analytics and recordings on page 164).  
- If a definition is not assigned to a schedule then it will not be activated and no archive 
recordings will be made and no events will be generated.  

15.3.9 Defining Face Detection 

NetavisObserver offers iCat Face Detection. The functionality can be used to detect and count faces in 
a video stream. Optionally, it is also able to provide age and gender estimations of peopleand since 
NetavisObserver 5.0 the attention time and dwell time of faces is also detected. 

Here are the steps for configuring Face Detection: 

1. Choose Video analysis (iCat) from the System administration menu. This opens the Video 
analysis (iCat) dialog. 

2. Select a camera in the camera tree and in the menu select  Add new definition. 

3. In the Type pop-up menu choose Face detection, which will expose the configuration settings. 

4. In the Identifier text field enter a name for this Face detection. 

5. Choose whether you want a Polygon or Rectangle shape by checking the respective check box.  

6. Now you can draw the region with the mouse in the preview pane. For a polygon you just click 

with the mouse to define the corners of the polygon. You close the polygon by crossing an 

existing edge or by double clicking with the mouse. 

7. Check or uncheck the Age and gender detection checkbox depending on the requirements. 

Note: The default age groups are 0 to 24, 25 to 55, and above 56. These age groups can be 

customized via the AgeRangeConfig.SAMPLE.txt file on the Netavis Observer Customizer 

page. A server restart is required once the custom AgeRangeConfig.txt file has been uploaded 
to the server in order to apply the changes. 

8. Check or uncheck the Display age groups option to select whether the exact age estimation or 
the corresponding age group should be shown in the iCat info display. (Only available if Age and 
gender detection is enabled.) 

9. The attention time and dwell time feature introduced in Netavis Observer 5.0 added three new 

options: 

• Maximum yaw angle (degrees): Only the time during which a face's angle towards the 
camera is lower than this threshold is counted as attention time. The time during which 

the face's angle towards the camera is higher than this threshold is counted as dwell time. 

• Generate face report after (seconds): With the addition of the attention and dwell 

time feature every detected face will result in two events: The event one will be created 
once a face is recognized (considering the Minimum detection length option below). 
The second event which contains the attention and dwell time will be created once the 
face is not visible anymore plus the time span configured here has passed. 

• Minimum detection length (milliseconds): Defines how long a face has to be visible 
before a corresponding event is created. 
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10. There is also an option to define a Minimal face size. Clicking the button opens a separate 

window with a snapshot of the camera's videostream and you can draw the minimal face size 
with the mouse on that snapshot: 

 

Faces which are smaller than this rectangle will not be detected and will not create an event. For 

increased accuracy you can resize this snapshot window by clicking and dragging on its corners 
or edges. A previously configured minimal face size can be removed by clicking the Remove 

min. face size button. 

Hint: For more details on using NetavisObserver for face detection, including information about 

how to configure the desired age groups, please refer to the Face Detection with iCat White Paper 
available in the documentation section of our website. 

15.3.10 Defining a Privacy Mask 

Privacy masks allow hiding private areas of a camera view from live viewing and recording. 

This is an example of a privacy mask hiding the text on the carpet: 

 

Here are the steps for creating a privacy mask: 

http://www.netavis.net/en/support/documentation
http://www.netavis.net/
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Please note: 

- No object tracking region is needed for a dynamic privacy mask. 
- Currently, privacy masks are not shown in Client for Smartphone & Tablet, Layout 

Navigation, Video4Web, and Video Wall Control. 

1. Choose Video analysis (iCat) from the System administration menu. This opens the Video 

analysis (iCat) dialog. 

2. Choose a camera and in the menu select Add new definition. 

3. In the Type pop-up menu choose Privacy mask, which will expose the configuration settings. 

4. Under the camera preview choose the Rectangle or Polygon check box. 

5. Now you can draw the privacy field with the mouse in the preview pane. For a polygon you just 

click with the mouse to define the corners of the polygon. You close the polygon by crossing an 

existing edge or by double clicking with the mouse.  

6. In the Identifier text field enter a name for this privacy mask. 

7. Push Save to save your definition. 

Please note: 

- If you add a new iCat definition, it will automatically be assigned to all iCat schedules of the 
camera. If you do not want that, you have to remove the assignment manually (see 15.3.16 
Scheduling iCat video analytics and recordings on page 164).  

- If a definition is not assigned to a schedule then it will not be activated and no archive 
recordings will be made and no events will be generated.  

15.3.11 Defining Traffic Monitoring 

NetavisObserver 4.5 introduced iCat Traffic and with it Traffic Monitoring. It assesses the speed and 

density of road traffic and can thereby detect traffic jams, low traffic, and other traffic patterns. 

Here are the steps for configuring Traffic Monitoring: 

1. Choose Video analysis (iCat) from the System administration menu. This opens the Video 

analysis (iCat) dialog. 

2. Select a camera in the camera tree and in the menu select Add new definition. 

3. In the Type pop-up menu choose Traffic Monitoring which exposes the configuration settings. 

4. In the Identifier text field enter a name for the Traffic Monitoring definition. 

5. By default the Traffic Monitoring region is assumed to have one lane but you can choose 
between one, two or three lanes in the Number of lanes menu. You can change the position of 
the region by dragging the green and red dots in the preview pane. The direction of each lane is 
indicated by the yellow arrow and can be changed by clicking on the area of a lane. 
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6. Adjust the Road length and Road width (both in meters) of the road section which is covered 
by the region configured above. 

Please note: The included section should be around 70-100 meter long. 

7. Define the Measurement time unit (in minutes) which defines how long a certain traffic state 

has to last before a corresponding event is triggered. 

8. Now for each Traffic state except Normal traffic the lower and upper thresholds for the Speed 
(in km/h) and Traffic Density (in %) have to be defined. Additionally a Highlight color, Icon, 

Sound, and Dynamic View Action can be defined for each Traffic state. 

Please note: The Speed and Density ranges from the different traffic states should not overlap. 

15.3.12 Defining Stopped Vehicle Detection 

NetavisObserver 4.5 introduced iCat Traffic and with it Stopped Vehicle Detection. It detects vehicles 

which stop on a road or special segments such as an emergency lane or an exit lane. 

Here are the steps for configuring Stopped Vehicle Detection: 

1. Choose Video analysis (iCat) from the System administration menu. This opens the Video 
analysis (iCat) dialog. 

2. Select a camera in the camera tree and in the menu select Add new definition. 

3. In the Type pop-up menu choose Stopped Vehicle Detection which exposes the configuration 
settings. 

4. In the Identifier text field enter a name for this Stopped Vehicle Detection. 

5. Draw the region you want to monitor in the preview pane. Just click with the mouse to define the 
corners of the polygon and close it by crossing an existing edge or by double clicking with the 

mouse: 
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6. Adapt the Alarm time limit (sec) option which defines after how many second the 

corresponding event is triggered. 

Hint: It is possible to set up more than one Stopped Vehicle Detection per camera, e.g. to generate 

different events for vehicles stopped on the main road or the emergency lane. 

15.3.13 Defining Wrong Way Detection 

NetavisObserver 4.5 introduced iCat Traffic and with it Wrong Way Detection. It detects vehicles going 
into the wrong direction on a normal road or special segments such as an emergency or exit lane. 

Here are the steps for configuring Wrong Way Detection: 

1. Choose Video analysis (iCat) from the System administration menu. This opens the Video 

analysis (iCat) dialog. 

2. Select a camera in the camera tree and in the menu select  Add new definition. 

3. In the Type pop-up menu choose Wrong Way Detection which exposes the configuration 

settings. 

4. In the Identifier text field enter a name for this Wrong Way Detection. 

5. Draw the region you want to monitor in the preview pane. Just click with the mouse to define the 

corners of the polygon and close it by crossing an existing edge or by double clicking with the 
mouse: 

 

6. Next the detector learns the typical direction of the traffic inside the previously defined region. 

Depending on the amount of traffic the duration for this learning process can range from a 
couple of hours to a day. When the learning process is completed every vehicle going into a 
direction other than the usual one will be detected as a wrong way driver and an event will be 

generated. 
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If the typical traffic direction changes temporarily, e.g. because of construction work, the 

detector can be reset: Select the Wrong Way Detection definition, right-click on it, and select 
Reset traffic direction learning. 

Please note: The Wrong Way Detection region should always include road parts where the 
typical traffic direction is observable. For example, if the scenario is to detect drivers traveling the 
wrong way on the emergency lane it is not a good practice to draw the detection region tightly 

around the emergency lane. Rather the solution is to extend the detection region to include the 
lane next to the emergency lane, so the detector can compare a vehicle’s route to the direction 
learned on the adjacent lane. 

Hint: It is possible to set up more than one Wrong Way Detection per camera, e.g. to generate different 
events for vehicles going the wrong way on the main road or an exit lane. 

15.3.14 Defining Number Plate Recognition 

NetavisObserver 4.6 introduced iCat Number Plate Recognition that can detect number plates for use 
in vehicle entry, parking, and free flow scenarios. 

Note: iCat Number Plate Recognition is a separate module which needs to be enabled with an 

appropriate license key and - depending on the specific configuration - a USB hardware dongle. 

The basic steps for setting up Number Plate Recognition in Observer are: 

1. Configure an iCat Number Plate Recognition definition (which is covered in this section). 

2. (Optional) Configure the desired NPR lists (please see 18 NPR List Management on page 178 for 
more details). 

3. (Optional) Configure desired actions for number plates included or excluded in NPR lists (please 

see 17 Rule Administration on page 172 for more details). 

Here are the steps for configuring iCat Number Plate Recognition: 

1. Choose Video analysis (iCat) from the System administration menu. This opens the Video 

analysis (iCat) dialog. 

2. Select a camera in the camera tree and in the menu select Add new definition. 

3. In the Type pop-up menu choose Number Plate Recognition which exposes the configuration 

settings. 

4. In the Identifier text field enter a name for this iCat Number Plate Recognition definition. 

5. Draw the region where the number plates appear in the preview pane. Just click with the mouse 
to define the corners of the polygon and close it by crossing an existing edge or by double 
clicking with the mouse: 
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6. Select in which Region the system is used (please refer to the iCat NPR datasheet available on 

our website for the complete list of countries whose number plates are supported): 

• Europe and Russia   

• Arabian Peninsula 

• North Africa 

• Southeast Asia 

• Pakistan 

• Central Asia 

If possible iCat NPR also detects which specific country a number plate is from. The detected 

country is then shown in the corresponding event details and can also be used in event searches. 

Note: This option has to be configured in accordance with the license running on your system. 

7. Set the Event suppression time (sec) which filters out repetitive iCat NPR events, e.g. when 

cars are idling in front of a camera. 

The default event suppression time of 10 seconds means that after an iCat NPR event for a 
number plate has been generated, a second event for the same car will only by generated if it 
leaves the detection region for 10 seconds and then moves back into it. 

8. Select the Minimum plate length whereby you can choose values between 1 and 5. Recognized 
number plates with fewer than this minimum length will be discarded and not stored in the event 
database. Please note that whitespaces are excluded from the minimum plate length. 

9. Select the Number Plate Recognition Scenario: 

• High speed is used for free flow scenarios 

• Slow speed is used for vehicle entry, parking, and similar scenarios 

Note: This option has to be configured in accordance with the license running on your system. 

10. Check or uncheck the Motion detection trigger checkbox (only available for Scenario: Slow 

Speed). If this option is enabled number plate recognition is only attempted after a motion is 
detected in the image whereby the threshold is a 5% pixel change in the previously selected 

detection region. 

http://netavis.net/en/products/datasheet-collection
http://netavis.net/en/products/datasheet-collection
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11. Check or uncheck the Fast detection checkbox. If this option is enabled then the first number 

plate recognition of a given plate will create a corresponding event, else three consecutive 
recognitions are needed for the event to be created. 

12. Check or uncheck the Disable learning checkbox. If this option is checked then the initial 

learning period is disabled. 

13. Check or uncheck the Get color information checkbox. It is only available for some regions 
(e.g. Arabian Peninsula) where the color of the plates has a significance. The detected color is 
then shown in the corresponding event details and can also be used in event searches. 

14. Check or uncheck the Country/region only checkbox. If this option is checked then only the 
country/region of a number plate rather than the full plate is read by the system. 

15. There is also an option to Set minimal plate size. Clicking the button opens a separate window 
with a snapshot of the camera's videostream and you can draw the minimal plate size with the 
mouse on that snapshot. Number plates which are smaller than this rectangle will not be 

detected and will not create an event. For increased accuracy you can resize this snapshot 

window by clicking and dragging on its corners or edges. A previously configured minimal plate 

size can be removed by clicking the Remove minimal plate size button. 

16. Next the detector learns the typical location of the number plates inside the previously defined 
region. The duration of this learning process depends on the number of vehicles passing through 
the region and the previously selected Disable learning option. During this learning period a 

corresponding message appears in the camera ports of the Online Monitor where the camera is 
shown, no number plates will be recognized, and no Number Plate Recognition events will be 

generated. 

Note: Only one Number Plate Recognition iCat definition can be created per camera. 

15.3.15 Defining a Dynamic Privacy Mask 

Netavis Observer 4.7 introduced dynamic privacy masks which expand upon the original NETAVIS 
Privacy Mask to provide dynamic privacy protection for customers and employees. 

This is an example of a dynamic privacy mask hiding a person walking around an office: 
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Please note: 

- No object tracking region is needed for a dynamic privacy mask. 
- Currently, dynamic privacy masks are not shown in Client for Smartphone & Tablet, Client for iPad, 

Mobile Client, Layout Navigation, Video4Web, and Video Wall Control. 

Here are the steps for creating a dynamic privacy mask: 

1. Choose Video analysis (iCat) from the System administration menu. This opens the Video 
analysis (iCat) dialog. 

2. Select a camera in the camera tree and in the menu select Add new definition. 

3. In the Identifier text field enter a name for this dynamic privacy mask. 

4. In the Type pop-up menu choose Dynamic privacy mask which exposes the configuration 
settings. 

5. Under the camera preview choose the Rectangle or Polygon checkbox. 

6. Now you can draw the area where moving objects should be covered with the dynamic privacy 
mask with the mouse in the preview pane. For a polygon you just click with the mouse to define 
the corners of the polygon. You close the polygon by crossing an existing edge or by double 

clicking with the mouse.  

7. Select the desired Sensitivity whereby this setting should usually be left at Normal and only be 
modified if you are not satisfied with the dynamic privacy mask performance. 

8. Set the desired Learning time (sec) (default value: 30 seconds) which defines how long the 
entire previously selected area will be covered before the dynamic privacy mask becomes active. 

9. Set the desired Make union of masks (msec) (default value: 200 milliseconds) which defines 

the duration for which a mask is retained on an area. 

10. Check or uncheck the Slow learning checkbox depending on the requirements. With this option 

the adaptation to changing environments takes longer (approximately 1 hour). This means that 

objects can stop for longer periods of time before they are no longer detected. It is 

recommended that this option is only used wenn the dynamic privacy mask is started in a static 

situation with few movements. 

15.3.16 Scheduling iCat video analytics and recordings 

With Netavis Observer 5.1 the previously available Camera admin page "Scheduling" has been 
replaced by the newly designed camera properties page, an updated camera wizard (see 4.2 Adding a 

new camera and basic configuration on page 31 for details), and Schedule Admin (see 21 Schedule 

Admin on page 187 for details). Please see the referenced chapters and sections for information on 
how to schedule iCat video analytics and related recordings. 

15.4 Working with iCat 

In this section you will learn about: 

• Watching iCat information live in the Online monitor and also when replaying recordings. 

• Displaying heat maps in the Online monitor. 

• Generating reports on iCat events like people counting and stopped objects. 
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15.4.1 Displaying iCat information in the Online Monitor and when playing recordings 

For each camera that has active iCat schedules enabled you can display additional iCat information 

like object markers, bounding boxes, and event trigger fields in the Online monitor and also when 
playing back recordings in the Archive player or an exported SAFE Player. 

Here is an example of additional iCat information displayed: 

 

To choose what iCat information to display you have these options: 

In the Online Monitor in the view port of a camera that has iCat processing enabled the view port 
Control Menu menu offers an iCat info display menu. For setting the display for all view ports in a 

view the same menu is also available in the view's Control Menu - Set parameters of all view 

ports. 

In the Archive player's Control Menu you can select the iCat information to be shown via iCat - iCat 
info display. 

The iCat info display menu allows you to select from various display options: For each of these 
options you can select Show always, Show on mouse over, and Do not show. For some you also 

can select Show on event. 

The display options are: 

 

Field label Description 

All 

information 
Displays all available iCat information. 

Tracking 

boundaries 
Defines whether the object tracking region boundaries should be shown. 

Event trigger 
lines/boxes 

Defines whether the event triggers like tripwires (including arrows indicating the 
direction of the tripwire) and object starting/stopping fields should be shown. 

Object 

markers 
Defines whether object markers should be displayed. Object markers show the 
object ID and information about the state of the object (MOV = moving, STP = 

stopped, LOUNGE = move just a little bit), size and speed. 

 



Netavis Observer 5.1 User Manual (February 2021) 

Page 166 of 214 

Field label Description 

 
In this example object ID is [10], object size is 9110 pixels, and the object is moving 

with a speed of 208 pixels/sec. 

Event count 
fields 

Defines whether the event count fields are to be displayed in the lower left corner of 
the view port. When enabled the count information will be displayed for each event 
trigger separately in the form of Q for last quarter of an hour, H for last hour, D for 
day and T for total since setup. 

Here is an example:  

 

There are two event triggers: a field for counting stopped objects and a people 

counting tripwire (counter 1). 

Object 

bounding 
boxes 

Defines whether object bounding boxes should be displayed. 
Here is an example of an object bounding box displayed:  

 

Please note that also the object marker and the event triggers are displayed. 

 

15.4.2 Displaying heat maps 

For every camera you can display heat maps as overlays to the normal video stream in the Online 

monitor and also in the Archive player. 

The requirements for displaying heat maps for a camera are: 

• an object tracking region with enabled heat map data collection (see 15.3.3 Defining an object 
tracking region on page 147 for details) 

• an enabled and currently running iCat schedule for that object tracking region 

Below you can find an example of an object count heat map: 
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In the Online monitor you can display these heat maps by choosing the desired heat map type from 

the view port's right-click menu - iCat heat maps - Type: 

• Object count 

• Object speed 

• Stopped object count 

• Object stopping time 

Next, in the iCat heat maps - Show menu you can choose when to show the heat maps: 

• Show always 

• Show on mouse over 

• Do not show 

For showing the heat maps for all view ports in a view the same menu is also available in the view's 
Control Menu - Set parameters of all view ports. In the Archive player's Control Menu you can 
select the heat map type to be shown via iCat - iCat heat maps. 

In the screenshot above you see an example of the object count heat map in an office situation. Cold 

colors (such as blue) mean few object counts and hot colors (such as red) mean high object counts. 

When you move the mouse over the view port you can see the raw heat map data for the 

corresponding heat map type: 

• Object count: accumulated object count 

• Object speed: average speed of objects 

• Stopped object count: accumulated stopped object count 

• Object stopping time: accumulated stopped object time 



Netavis Observer 5.1 User Manual (February 2021) 

Page 168 of 214 

In the screenshot above the count in the middle of the screen would be 3199 objects. If you are 

normalizing the type of heat map (see 11.2 Setting Observer server parameters on page 109 for further 
information) then the max value set there is displayed in brackets (3500 in the screenshot above). 

As a comparison, here you see the heat map of the stopped object counts of the same camera: 

 

Notice the difference in coloring. You see that people only very seldomly stop in the right side of the 

office but stop very often in the middle near the chair. 

Resetting all the heat maps on a server: 

To reset all the heat maps on a server follow these steps: 

• Manually: Open the iCat admin, right-click anywhere on the window, and select Reset all 

heat map values on this host.  

• Automatically: Configure the Heatmap statistics reset method option in the Host Admin 

(see 11.2 Setting Observer server parameters on page 109). 

Resetting the heat maps of individual cameras: 

1. Choose Video analysis (iCat) from the System administration menu. This opens the Video 
analysis (iCat) dialog. 

2. Choose the camera and then the corresponding object tracking region. 

3. In the menu select Modify selected definition. 

4. Press Next to get to the Heat map data collectionheat map settings. 

5. Disable the checkboxes of those statistics you want to reset. 

6. Press the Save button to save the changes. Now the heat map data of the disabled types is reset. 

7. Now enable the heat map data collection again by repeating the above steps accordingly. Do not 

forget to press Save again. 
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15.4.3 Working with iCat events 

Working with iCat events is the same as working with other events of the Observer event management 

system EMS (as described in 9 Handling events on page 92). 

Currently, iCat generates events of the following types (as shown in the event type hierarchy dialog of 

the Event search; see 9.1 Event list and event details on page 92): 

Camera specific messages 
    State change events 
        Video analysis (iCat) events 

            Simple motion detection 
            iCat object tracking 

All events that are generated by iCat (that are not simple motion detection) like people counting, 

object stopping, and sabotage detection are of type iCat Object tracking. Therefore if you want to 

filter iCat events you have to choose the event type iCat Object tracking. 

You can differentiate events for the various iCat event triggers by their names. You can also create 
event statistics reports in Excel XLS format (see 9.3 Generating an event statistics report on page 97). 
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16 I/O Device Administration 

Netavis Observer 4.6 introduced I/O Device Administration which enables the configuration of I/O 
devices within the Observer user interface. Adding I/O devices to a Netavis Observer system is now as 

easy as selecting the model and entering its IP address, port, user, and password. 

Note: I/O devices (and their corresponding actions) configured in versions prior to Netavis Observer 
4.6 via the XML configuration file will continue to work in Observer 4.6. However if you want to use 
I/O devices with new features introduced in Observer 4.6 (e.g. Rule Administration) then you will need 

to remove the previous XML configuration and re-add the I/O device in the I/O Device Administration. 

16.1 Configuring I/O devices 

1. Choose I/O device admin from the System administration menu. This opens the I/O device 

admin: 

 

2. To add a new I/O device right-click anywhere in the window and select Add new device. 

3. In the Name text field enter a name for this I/O device. 

4. In the Type pop-up menu choose the type of I/O device you want to add to the system. 

Hint: Device-type specific Configuration hints are shown to the right of the text boxes. 

5. Next enter the device's IP address. 

6. Almost all I/O devices also require entering a TCP/HTTP port for connecting to it. 

7. Additionally many I/O devices require authentication via a username and password. 

8. The device-type specific I/O ports and relays are shown in the table below the configuration text 
boxes. 
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Hint: When selecting an Axis Generic or ONVIF Profile S device type you need to Collect 

capabilities before the device's output ports can be shown. 

9. You can edit the Port name for each I/O port and relay by double-clicking on it. 

10. For some devices (e.g. many AXIS cameras, AXIS P8221) you can also configure the Port type by 
double-clicking on it and choosing the desired type from the pop-up menu. 

Note: It is important that the port type configuration made here matches the one on the 

corresponding I/O device's webpage! 

11. When you press Save Observer will try to connect to the I/O device with the given configuration 

and a corresponding "I/O device was added" event is generated: 

If the connection is not successful or lost at any time a "Connection lost to I/O device" event is 
generated: 

 

12. For any changes of input ports and relays of I/O devices a corresponding event will be generated: 

 

13. Finally, you can also Modify and Delete selected I/O devices via the right-click mouse menu. 

Corresponding events are again generated when an I/O device is modified or deleted. 

16.2 Generic I/O devices 

It is also possible to add other TCP/IP based systems to an Observer system as I/O devices. In order to 

do that an I/O device of the Type "Generic TCP" has to be added as described above. The 
corresponding system or device then has to be configured to send TCP messages to the Observer 

server's port 10100 with the following syntax: 

statechange,<DEVICE_ID>,<IO_PORT_ID>,<IO_PORT_VALUE> 

So for example changing the value of the first port of an I/O device with ID=1001 to "0" would require 

the following TCP message: 

statechange,1001,1,0 
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17 Rule Administration 

Netavis Observer 4.6 introduced Rule Administration which enables the simple configuration of a 
range of actions which are triggered by specific events. For example, the permanent recording of 

cameras can be started once an alarm system is activated or a barrier can be opened upon the 
detection of certain number plates. The rule administration is an extensible system which will 
continue to cover more scenarios in the future. 

Note: Actions triggered by I/O devices configured in versions prior to Netavis Observer 4.6 via the XML 
configuration file will continue to work in Netavis Observer. However, if you want to use Rule 

Administration you will need to remove the previous XML configuration, reconfigure the I/O device in 
the I/O Device Administration, and then add the corresponding actions via Rule Administration 
(described in this chapter). 

17.1 Configuring rules 

1. Choose Rule admin from the System administration menu. This opens the Rule admin: 

 

2. To add or modify rules right-click anywhere in the window and select Modify rules. 

3. To add a new rule click on the Add rule... button which opens the Rule Editor: 
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4. Enter a name for this rule in the Rule Name text field. 

5. Since NetavisObserver 5.1 it is also possible to select a Schedule (previously defined in the 

Schedule Admin) for each rule, whereby the default value is Always. 

6. Next you choose and configure a Trigger type whereby NetavisObserver5.1 currently supports 
the following triggers: 

a. Motion detected: In its basic configuration the trigger is any motion detection (option: Any 

definition) on one or multiple cameras and/or camera groups which can be selected. 
Additionally, it is also possible to limit the trigger to only occur when any of the selected 

iCat Motion Detection definitions occurs (option: Any selected definition). When selecting 
more than one camera then only the subset of identically named iCat Motion Detection 

definitions available on all cameras is shown here. 

b. Connection to camera lost: You can select one or multiple cameras and/or camera 
groups. The trigger is if NetavisObserver loses the connection to one of them. 

c. Connection to camera restored: You can select one or multiple cameras and/or camera 
groups. The trigger is if NetavisObserver restores the connection to one of them. 
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d. I/O device port value changed: You can select any I/O device which was previously added 

via the I/O Device Administration (see UNRESOLVED CROSS REFERENCEI/O Device 
Administration on page 170). Then you can choose any of its input ports or relays and define 
whether the port value changing from 0->1, 1->0 or Any value change is used as the trigger. 

e. Number plate detected: In its basic configuration the trigger is simply a number plate being 

detected on one or multiple cameras and/or camera groups which can be selected. 
Additionally it is also possible to limit the trigger to only occur when a number plate is in or is 
not in one or multiple NPR lists (see 18 NPR List Management on page 178). 

f. Object crossed field or tripwire: In its basic configuration the trigger is any object is 
crossing field and object crosses tripwire iCat detection (option: Any definition) on one or 

multiple cameras and/or camera groups which can be selected. Additionally it is also possible 
to limit the trigger to only occur when any of the selected iCat Object is Crossing Field and 
Object Crosses Tripwire events occurs (option: Any selected definition). When selecting 

more than one camera then only the subset of identically named iCat Object is Crossing Field 

and Object Crosses Tripwire definitions available on all cameras is shown here. 

g. Object started moving in field: In its basic configuration the trigger is any object starts 
moving in field iCat detection (option: Any definition) on one or multiple cameras and/or 
camera groups which can be selected. Additionally it is also possible to limit the trigger to only 
occur when any of the selected iCat Object Starts Moving in Field events occurs (option: Any 

selected definition). When selecting more than one camera then only the subset of 
identically named iCat Object Starts Moving in Field definitions available on all cameras is 

shown here. 

h. Object stopped in field: In its basic configuration the trigger is any object stops in field 

iCat detection (option: Any definition) on one or multiple cameras and/or camera groups 
which can be selected. Additionally it is also possible to limit the trigger to only occur when 

any of the selected iCat Object Stops in Field events occurs (option: Any selected 
definition). When selecting more than one camera then only the subset of identically named 

iCat Object Stops in Field definitions available on all cameras is shown here. 

7. By clicking on the Add action button you can then add one or multiple actions which will be 

executed when the trigger configured above occurs. NetavisObserver5.1.0 currently supports the 
following actions: 

a. Enable current continuous recording scheduling: You can select for which Camera(s) 

the current continuous recording scheduling will be enabled: either the camera from the 
event which triggered the rule or any other camera(s). 

Note: This action does not automatically start a continuous recording on the corresponding 

camera(s)! Rather it simply enables a previously configured continuous recording schedule 

(see 7.1 Programming archive recordings on page 72) which is scheduled to run at the current 
time. Changes of the scheduling can take up to 2 seconds to be executed and no other 

changes should be made during that time. 

b. Disable current continuous recording scheduling: You can select for which Camera(s) 
the current continuous recording scheduling will be disabled: either the camera from the 

event which triggered the rule or any other camera(s). 
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Note: This action does not automatically stop a continuous recording on the corresponding 

camera(s)! Rather it simply disables a previously configured continuous recording schedule 
(see 7.1 Programming archive recordings on page 72) which is scheduled to run at the current 

time. Changes of the scheduling can take up to 2 seconds to be executed and no other 
changes should be made during that time. 

c. Enable current iCat scheduling: You can select for which Camera(s) the current iCat 

scheduling will be enabled: either the camera from the event which triggered the rule or 
any other camera(s). 

Note: This action does not automatically start a Video Analysis (iCat) recording on the 

corresponding camera(s)! Rather it simply enables previously configured Video Analysis (iCat) 
schedules (see 7.1 Programming archive recordings on page 72) which are scheduled to run at 
the current time. Changes of the scheduling can take up to 2 seconds to be executed and no 

other changes should be made during that time. 

d. Disable current iCat scheduling: You can select for which Camera(s) the current iCat 
scheduling will be disabled: either the camera from the event which triggered the rule or 

any other camera(s). 

Note: This action does not automatically stop a Video Analysis (iCat) recording on the 

corresponding camera(s)! Rather it simply disables previously configured Video Analysis (iCat) 

schedules (see 7.1 Programming archive recordings on page 72) which are scheduled to run at 
the current time. Changes of the scheduling can take up to 2 seconds to be executed and no 

other changes should be made during that time. 

e. Show window: You can select which Window to show on a user's screen by selecting the 

User(s) and Window which will be shown. Optionally, it is also possible to configure 

Minimize window after (in seconds) and the Limit to IP address (to limit the action to 

clients connected from the respective IP address) options. 

f. Show camera in large view: You can select which Camera to show in the large view: either 
the camera from the event which triggered the rule or any other camera. Additionally you 

need to configure the User(s) and Window where the camera will be shown. When multiple 

users are selected only the subset of commonly available windows are shown here. 

g. Show view: You can configure which view to show whereby there are three different Display 
modes: 

• Show view: Here you can select in which specified View of a selected User and 

Window the camera from the triggering event or other cameras are shown. Optionally, 

it is also possible to configure the Limit to IP address option to limit the action to 
clients connected from the respective IP address. 

• Show camera in view replacing the oldest camera: The newest events are always 

displayed in the "oldest" view ports (the view ports that stood there the longest without 

a camera change). Thus it is possible to create a view where always cameras with the 

newest events are displayed. The other options are identical to the Show view display 
mode. 

• Shift camera in view shifting older cameras: The newest events are always 

displayed in the top left view port with all other camera views shifting towards the 

bottom right. Cameras in the lower right view port are removed from the view. Thus it is 

possible to create a view where cameras with the most recent events are always 
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displayed in the top left position view port. The other options are identical to the Show 

view display mode. 

h. Set I/O device port value: You can select any I/O device which was previously added via the 
I/O Device Administration (see 16 I/O Device Administration on page 170). Then you can choose 

one of its output Ports or relays and define whether the Port value should be set to 0 or 1. 

Optionally you can define whether to Switch the value back to the opposite value after a 
certain amount of time (in milliseconds). 

i. Set PTZ position: You can select a previously configured PTZ position of a Camera and 

define a Minimal stay time for which the camera will remain at that position. 

Note: This action does not work if the camera currently follows an automatic PTZ route! 

j. Play sound: You can select one of the default sounds from the list and choose for which 
user(s) the sound should be played. Additionally it's also possible to upload a custom sound 

by clicking on the ... button (whereby .au and .wav files are supported). 

k. Send email: You can select NetavisObserver users as Recipient users and CC users of e-
mail notifiCations (do note that these users need to have a filled in e-mail address in the 

User admin). Additionally arbitrary e-mail addresses not associated with any Observer users 

can be added in the Recipient addresses and CC addresses fields whereby multiple 
addresses have to be separated by a comma (,).  

For the Subject of the corresponding e-mail it is possible to either choose Use event text as 

subject (e.g. Object stopped in field "Stopped person" of camera "Main Entrance") or Specify 
subject and entering a custom text. 

Similarly for the Body of the e-mail it is possible to either choose Use event details as 

message (which adds all the information also visible in the Event details dialog of the trigger 
event) or Specify message and entering a custom text. Additionally the Include trigger 

image option can be checked so if the trigger event contains an image it will be attached to 

the e-mail. 

Note: Your NetavisObserver server needs to have a corresponding SMTP mail server and 
networking setup configured in order to be able to send e-mail notifiCations (please see the 

document NETAVIS Observer Server Installation and Administration and specifically the "Edit 
network settings" section for further information). Also note that NetavisObserver has a 

10MB limit for e-mail attachments. So if the Include trigger image option is checked and the 
associated image is larger than 10MB then the e-mail notifiCation will not be sent. 

l. Generate custom event: Using the Edit custom events button you can enter the Custom 
event editor which allows you to add fully customizable event types. You can Add, Modify or 
Delete these custom events which are defined by their Event type, up to 5 Event 

parameters, and a corresponding Event text. These custom events can then be generated 

as an action within a rule whereby the custom event parameters can either be copied from the 
triggering event or entered manually: 
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Note: The length of all event parameter names combined cannot exceed 200 characters! 

m. Send TCP message: You can enter a destination IP Address and Portto which the 
configured Message which will be sent upon the rule's execution. 

n. HTTP request: You can enter a URL, choose between the GET or POST Method and add an 

optional Username, Password, and Message and the configured request will be made upon 
the rule's execution. 

8. You can also delete actions by clicking on the delete button  next to each action. 

9. Press OK to create the rule. If you forgot to specify any mandatory options then an icon  will 
pop up next to it. 

10. Press Save to store the changes. For any changes also a corresponding event will be generated : 

 

11. Existing rules can be enabled and disabled via the Active checkbox next to each rule. They can 

also be modified by double-clicking on one or selecting it and pressing the Modify rule... button. 

12. Finally, you can also DupliCate and Delete selected rules via the corresponding buttons. 
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18 NPR List Management 

NetavisObserver 4.6 introduced iCat Number Plate Recognition that can detect number plates for use 

in vehicle entry, parking, and free flow scenarios. 

Note: iCat Number Plate Recognition is a separate module which needs to be enabled with an 
appropriate license key and a USB hardware dongle. 

The basic steps for setting up Number Plate Recognition in Observer are: 

1. Configure an iCat Number Plate Recognition definition (please see 15.3.14 Defining Number Plate 
Recognition on page 161 for more details). 

2. (Optional) Configure the desired NPR lists (which is covered in this section). 

3. (Optional) Configure desired actions for number plates included or excluded in NPR lists (please 

see Using Rule Administration for more details). 

18.1 Configuring number plate lists 

1. Choose NPR admin from the System administration menu. This opens the NPR admin: 

 

2. To add a new number plate list right-click anywhere on the window and select Add new list. 

3. In the Name text field enter a name for this NPR list. 

4. You can choose a specific Icon, Sound, and Highlight color for the corresponding event when it 
is shown in the Event list. 

5. The Ignore separator characters checkbox defines whether separator characters in the number 
plate (such as spaces) should be considered when matching detected number plates against the 

selected NPR list. 

6. Select the Tolerance (in number of characters) whereby you can choose 0, 1 or 2. 
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Selecting 0 means that a detected number plate has to exactly match a number plate in the 

NPR list in other to be associated to it. 

Selecting 1 character tolerance means that the detected number plate and a plate in the selected 
NPR list have the same length but at most one character is different OR the detected number plate 
has one character less or more than a plate in the selected NPR list. 

Selecting 2 characters tolerance means that the detected number plate and a plate in the selected 
NPR list have the same length but at most two characters are different OR the detected number 
plate has one character less or more and at most one character is different than a plate in the 

selected NPR list. 

7. There are two options to add number plates to this list: 

a. You can manually add number plates by clicking on the Add button at the bottom: 

 

To add multiple number plates you can either separate them with a comma or add them in 

separate lines by pressing ENTER after each number plate. 

b. You can import number plates stored in text-, CSV- and Excel-files by clicking on the Import 

button at the bottom and selecting the corresponding file from your hard drive. 

Note: When importing number plates with non-standard characters (e.g. German umlauts) 

ensure that the files to be imported are encoded with UTF-8. Please also note that for example 

Microsoft Excel does not provide support for saving CSV-files with UTF-8 encoding! 

8. By selecting one or multiple number plates and clicking on the Comment button it is possible to 

add comments to number plates (e.g., the owner or type of a car). These comments are also 

included in any number plate events that are generated when the corresponding number plate is 
detected. 

9. Once added you can also filter the number plates by entering characters into the Filter textbox: 

 

 

10. Press Save to store the changes. For any changes also a corresponding event will be generated : 
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11. You can also Modify, Delete and Export (as text-, CSV- and Excel-files) selected lists of number 

plates. Corresponding events are again generated when an NPR list is modified or deleted. 

Note: As of Netavis Observer 5.0.1 it is also possible for 3rd party systems to modify number plate 
lists via SNAP XML, SNAP URL, and the SNAP Java SDK. For further information please refer to the 

corresponding SNAP API documentation. 
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19 Automatic Export 

Netavis Observer 4.7 introduced an Automatic Export tab for configuring the automatic export and 

upload of event statistics, events including their parameters, and heat maps to Netavis sMart Data 

Warehouse and other 3rd party systems. 

19.1 Configuring automatic exports 

1. Choose Automatic export from the System administration menu. This opens the Automatic 
Export tab: 

 

2. To add or modify automatic exports right-click anywhere on the window and select Modify 

exports. 

3. To add a new automatic export click on the Add button. 

4. Per default the Enabled checkbox is checked which means that the automatic export is activated. 

5. In the Name text field enter a name for this automatic export. 

6. Select the Type of the automatic export where you are presented with three options: 

• Event statistics are CSV files containing aggregated statistical values, equivalent to what 
can be manually obtained with the event statistics export menu (e.g. 3 people were 
counted at an entrance in the past hour). For these exports you can additionally select the 
desired types of Events, the Cameras, and the Resolution of the export (15 minutes, 1 

hour, 1 day, and 1 week). 

• Events are CSV, HTML, JSON or XLS files containing the full event details, equivalent to 

what can be manually obtained by exporting the result of an event search (e.g. vehicle with 
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number plate W-123AB was detected at 11:03 on July 25). For these exports you can 

additionally select the desired types of Events, the Cameras, and if only a single event 
type is selected also specific event parameter requirements. 

• Heatmaps are CSV files containing the relative heatmaps data (e.g. of stopped object 
time). 

7. For event statistics and events the default Export period which defines how often the automatic 

export is uploaded is 1 day, other options are: 15 minutes, 1 hour, 1 week, and 1 month. For heat 

maps the default value is 1 hour, the alternative is 1 day, and the period has to be configured via 
the "Heat map export period" option in the Host Admin. 

8. Destination(s) are the servers such as Netavis sMart Data Warehouse and other 3rd party systems 

to which the automatically generated export files are uploaded. To add a new destination click on 
Edit destination(s) which opens the Upload destination editor: 

 

1. To add a new destination click on the Add button. 

2. In the Name text field enter a name for this automatic export. 

3. Select the Protocol which should be used for the upload whereby FTP, FTPS, and 
SFTP are supported. 

4. Enter the destination Address which can be an IP address or a domain. 

5. Enter the Port on the destination system. 

6. Enter the Directory where the files should be uploaded to (which is relative to the 

home directory of the user used to connect to the destination system). 

7. Enter the Username which should be used to connect to the destination system. 

8. Enter the Password for the corresponding username. 

9. (SFTP-only: Upload the Certificate for the corresponding username.) 

10. You can test the configuration by pressing the Test connection button. 

• If any part of the configuration is missing or erroneous a warning symbol will be shown:  

• You can also Delete a selected destination via the corresponding button. 
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9. The File prefix text box allows to add a specific prefix to the name of the automatically generated 

export file. 

10. The Export delay (min) defines how many minutes an export is delayed which can be useful in 
systems with unreliable connections between NCS and NUS servers. 

11. The Retention time (days) defines how long the automatically generated export files are stored 

on the Netavis Observer server. The default value is 7 days and it can be changed by entering a 
different value in the text box. 

12. The Export format version defines the naming schema of the exported files: 

• Event statistics: 

o v1: Original naming schema (e.g. event-

statistic_v1_h2663615583332447065_20180313T180000+0100_20180313T181459+0100.
csv) 

• Events: 

o v1: Original naming schema (e.g. 

event_v1_h2663615583332447065_20180313T181500+0100_20180313T182959+0100.cs

v) 

• Heatmap: 

o v1: Original naming schema (e.g. heatmap_v1_h2663615583332447065_cam3-
1_oc_20180313T181500+0100_20180313T182959+0100.csv) 

o v2: Additional naming schema which also contains the name of the corresponding 
iCat definition (e.g. heatmap_v2_h2663615583332447065_cam3-

1_zone1_oc_20180313T181500+0100_20180313T182959+0100.csv) 

Note: sMart Data Warehouse up to 3.1 only supports heatmap naming v1! 

13. Press Save to store the changes. 

14. You can also Delete a selected automatic export via the corresponding button. 

15. If any issues occur during the export or upload a corresponding system event will be generated: 

 

16. Users with the "Enable download of exported files" permission (see 5.2 Setting general user 
privileges on page 46 for details) can download these automatically created files on the server's 

web page by clicking on Download exported files link: 
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20 External Device Administration 

Netavis Observer 4.8 introduced External Device Administration to support the configuration and use 

of devices such as 3D sensors within the Observer user interface. Adding such devices to a Netavis 

Observer system is now as easy as selecting the model and entering its IP address, port, username, 
and password. 

Note: The configuration of counting lines and zones needs to be done on the external device's web 
interface! 

20.1 Configuring external devices 

1. Choose External device admin from the System administration menu. This opens the External 

device admin: 

 

2. To add a new external device right-click anywhere in the window and select Add new device. 

3. In the Name text field enter a name for this external device. 

4. In the Type pop-up menu choose the type of external device you want to add to the system. 

Hint: Device-type specific Configuration hints are shown to the right of the text boxes. 

5. Next enter the device's IP address. 

6. Almost all external  devices also require entering a TCP/HTTP port for connecting to it. 

7. Additionally many external devices require authentication via a username and password. 
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Hint: For Hella 3D devices the username is "user-role-edit", the default password is "admin", and 

the default port is: 8091. The password and (REST) port can be changed on the sensor's web 
interface. 

8. It is also possible to define the icon, sound, and highlight color for the resulting Generic 
counting and Zone alarm events. 

9. Optionally it's also possible to configure thresholds for zone level alerts and dwell time alerts. 

• Select the zone level alerts checkbox to enable the corresponding zone alert events when 
the level is above or below a certain threshold. 

• Select the dwell time alerts checkbox to enable the corresponding zone alert events 
when the level is above or below a certain threshold (in seconds). 

Note: For Hella 3D devices the sensor's "max. dwell time" value is used for the dwell time 

alerts! 

Hint: In zone monitoring and queue length detection applications these alerts can be used as a 
trigger for speaker announcements, informing staff to open an additional counter, and many other 

processes. 

10. When you press Save Observer will try to connect to the external device with the given 
configuration and a corresponding "External device was added" event is generated. 

If the connection is not successful or lost at any time a "Connection lost to external device" event 
is generated: 

 

11. Once the connection to an external device has been established the system will start generating 

counting and zone events with the latest data from the sensor as well as corresponding alert 

events when the configured thresholds are crossed. Counting events will be generated once every 

5 seconds and zone events will be generated every 60 seconds but only when the level and dwell 

time are not 0: 
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12. Finally, you can also Modify, Delete, and Clone selected external devices via the right-click 

mouse menu. Corresponding events are again generated when an external device is modified or 

deleted. 



Netavis Observer 5.1 User Manual (February 2021) 

Page 187 of 214 

21 Schedule Admin 

Netavis Observer 5.1 introduced the new Schedule Administration for centralized management of all 

schedules for continuous recordings, iCat video analytics, and rules. 

21.1 Configuring schedules 

1. Choose Schedule admin from the System administration menu. This opens the Schedule 
admin: 

 

2. A 24/7 schedule is available per default. 

3. To add a new schedule right-click anywhere on the window and select Add new definition. 

4. Enter a Name for the schedule. 

5. Set the desired time interval of the schedule and choose on which days weekdays it should be 
effective (default: all). 

6. Click on Add for the interval to be added to the schedule 

7. Continue adding more intervals as needed. 

8. Press Save to store the schedule. 

Existing schedules can be Modified, Duplicated, and Deletedafter selection via the right-click menu. 
Additionally, it is possible to Add the opposite for a selected schedule, for example to allow an easy 

configuration of different schedules for work-days and weekends. 

If multiple Netavis Observer servers are connected to each other then the schedules on the NCS are 
also visible and modifiable from the NUS server. 
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22 Video walls with Observer 

The Observer video wall solution allows you to configure and operate professional video walls using 
standard Observer servers and clients. Such a video wall can then be controlled by the Video wall 

control application, which allows you to: 

• Handle video walls with up to 10x10 monitors. 

• Connect multiple monitors to a single client PC. 

• Flexibly control the views and layouts in any of the video wall monitors. 

• Maximize individual camera streams on any of the monitors. 

• Work with multiple control consoles in parallel. 

The video wall control application has been specifically designed for control center personnel to 

operate video walls. Any configuration of the servers, video wall clients, cameras, recordings, or other 

administration has to be done in the main Observer client and admin consoles. 

Here is the basic architecture of a video wall with Observer: 

 

The video wall control application itself runs in a web browser on a PC that serves as the video wall 
control center. It connects to one of the Observer servers in the network that then in turn controls the 

Observer video wall clients that directly connect to the monitors of the video wall. 

22.1 Setting up a video wall with Observer 

22.1.1 General setup considerations 

The video wall control application connects to an Observer server (normally a user server – NUS) in 
order to control the display of the video wall clients. It is possible to choose any server in the network 
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for that purpose. However, all cameras that you want to display on the video wall must be accessible 

by this server (i.e. must be configured at this server or must be mounted from other servers). 

It is also possible to use more than 1 server for providing the streams for the video wall (this depends 
on how you setup your server network topology). In such a case the VWCA and also the video wall 
clients (that directly connect to the monitors) must connect to these servers. For simplicity and easier 
setup and management of the video wall, we suggest using one Observer server for driving the video 
wall. 

Each video wall client workstation/PC can drive several monitors of the video wall (how many depends 

on your hardware setup, i.e. graphics card). Each such video wall monitor has to map to one window 
in the Observer client. 

User management for the video wall 

You will need a few users to manage video wall functions appropriately. Generally these users must 

have access rights to all cameras that are to be displayed on the video wall: 

• 1 video wall management user (with which you login in to the VWCA). 

• For each video wall client workstation/PC you need 1 user 

You can create a user group that has privileges and access rights to all relevant cameras and then 

create the above users belonging to this group (automatically inheriting the privileges and rights). 

Please note these special issues: 

• It is impossible to display a camera on a video wall monitor which is not available on the server 

where the video wall client connects to. Depending on your setup, it is therefore possible that 
you cannot display every camera on any video wall monitor. 

• The video wall control application itself does not display live video streams of the cameras but 
snapshot images for better orientation instead. The real video streams appear in the video wall 

monitors. 

22.1.2 Setting up the video wall 

Please follow these steps for setting up the video wall: 

1. Configure your Observer server network with all the cameras and other settings. 

2. Setup the video wall monitors and the video wall client PCs (how many monitors you can connect 
to 1 client PC depends on your hardware setup). The video wall clients must run the Observer 
desktop application. 

3. We suggest using 1 specific user per video wall client PC. As indicated above, you can create a user 

group that has privileges and access rights to all relevant cameras and then create 1 user for each 

VW client PC. In the example diagram above it would be 2 users with names like VWPC1 and 

VWPC2. 

4. Start the Observer application on the first video wall client PC and login with the user of that client 
PC (e.g. VWPC1). 

5. For each video wall monitor you have to define a separate window in the Observer application 
(there is a 1 to 1 mapping between video wall monitors and Observer application windows). For 
each of these windows you can define multiple views with different layouts (you can also add and 
modify views later on). These views can later on be controlled by the video wall control 

application. 
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6. In the Observer application position each of the created windows to the corresponding video wall 

monitors (and put it in full screen mode). You can do that by dragging the window with the mouse 
and then maximize the window. 

7. When you are done setting up all the video wall client PCs and windows (monitors) you can 

continue to configure and use the video wall control application (see 22.2 Controlling the video 

wall with the control application on page 190). 

22.2 Controlling the video wall with the control application 

The video wall control application (VWCA) is a client/server web application, which you can activate 
from an Observer server (from release 4.4 on). The client part runs within a web browser and needs 

only minimal computer resources and the server part of the application runs on an Observer server. 

You can use any workstation/PC in the network (also your standard Observer client workstation) to run 

the VWCA client. 

Parallel working of multiple VWCAs: It is possible that multiple operators work on the same video wall. 
In this case Observer always executes the last command no matter who initiated it. Therefore we 
assume a cooperative multitasking style, which means that the operators have coordinate with each 

other. 

Supported browsers: 

• Mozilla Firefox 10.0 or higher 

• Google Chrome 17.0 or higher 

• Other browsers with HTML5 compatibility 

22.2.1 Starting the video wall control application 

You can start the video wall control application (VWCA) in a web browser with the following URL: 

<your server address>/videowall 

Please note: VWCA stores its configuration information (like monitor settings, linked servers, etc.) on 
the server where it was started from. If you want to control more than 1 Observer servers with your 
VWCA, you have to start it always from the same server. 

VWCA has the following components: 
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• Left side: Camera tree – separate for each server link. 

• Middle: Video wall monitors – here you can control the contents of the video wall monitors 

• Right side: Properties of the current selection – here you can see and modify the properties. 

22.2.2 Configuring the video wall control application (VWCA) 

Before you can control the video wall with the video wall control application you have to configure it. 
We assume that you have already set up your video wall physically and you have already configured 

the video wall client workstations/PCs that connect to the various monitors of your video wall (see 22.1 
Setting up a video wall with Observer on page 188). 

Configuring the basic setup 

1. Select video wall matrix by clicking on the default tab or the background area between monitors. 

You will see the Matrix settings in the Properties pane. 

2. Define the number of rows and columns of your video wall (this must obviously match your 
physical setup). 

3. Select the appropriate aspect ratio of the monitors 

4. The zoom factor defines how many monitor columns of your video wall you want to see in your 
VWCA without scrolling. 

Additionally, you can also define some colors. 

Linking the VWCA to servers 

Before you can operate the video wall with VWCA you have to define the linking (mapping) between 

the physical monitors of the video wall and the monitors inside VWCA. The linking is actually done via 

the Observer server that serves the video wall client workstations that actually connect to the monitors 

and by choosing the appropriate Observer user login for which the windows for the monitors have 

been defined. 

Here are the steps for linking VWCA to the video wall servers: 

1. Select one of the monitors by clicking on it. You will see Server link in the Properties pane. 

2. Enter the server address, Login name and Password of the Observer server that serves the 
video wall control workstations/PCs (for a general description on which servers and users to 
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choose please see 22.1 Setting up a video wall with Observer on page 188). Please note that you 

have to select the correct user login for the monitor: You have to take the user login of the video 
wall client workstation/PC where the monitor is connected to. 

3. Push Validate. If you entered the correct server and login combination you will be offered to 

choose from the available windows of the user. 

4. Choose the window that is associated with the monitor (please remember that each monitor has 
an associated Observer window; for a basic explanation please refer to 22.1 Setting up a video wall 
with Observer on page 188). You will notice that a view of the window has been selected by default. 

5. Repeat the above steps for all monitors of the video wall. 

22.2.3 Operating the video wall with the video wall control application (VWCA) 

You have several possibilities for controlling the contents video wall monitors. When you select a 

monitor by clicking on the monitor title bar inside VWCA you can: 

Select a view from the View list. Please note that each window in Observer can have several views. 

Drag/drop a camera from the camera tree to a view port in a monitor. Please note that you drag a 

camera only to the view port of a monitor that also has the appropriate server link. Impossible camera 

drops are prohibited and are shown with a red cross. 

Push the Back and Next buttons at the monitor title bars to move in history. You can also specifically 

select a point in the history by selecting it from the History tab in the Properties pane. 

Please note that the status bar shows the camera name when you move the mouse pointer over 
monitor view ports. 



Netavis Observer 5.1 User Manual (February 2021) 

Page 193 of 214 

23 Special functions 

This chapter describes some special functions of Observer. 

23.1 Video annotations 

Video streams for live viewing and recording can be annotated with text that then displayed in the 
video stream. The annotations can come from external data sources and can be stored in the event 

database for later retrieval and search. 

Annotations can be created via the SNAP XML interface or with a simple shell command with 
command line options. 

Example applications are POS cash register data, ATM data, logistics data, or access control data. 

23.1.1 Working with video annotations 

You can access the video annotation tools from the server's web page: 

1. At the server's web page click on Customizer login to login to the Customizer area (the admin 
password is needed for that). 

2. After login click on Download configuration files. 

3. Download the file annotate.zip and unpack the zip to a local directory on your client. 

4. The zip contains the Windows command line program annotate.exe. Just run the program from 

a command line to see all options. You can also refer to annotate-readme.txt. (The Java source 
code of the program is also part of the zip file) 

5. If you select to generate an event with the video annotation, an event will be stored in the event 

database for later retrieval and search. By selecting VideoStreamAnnotation in the event type filter 

of the Event search dialog, the annotation text can be searched for by SQL-type wildcards. 

23.2 Embedding Observer video streams in web pages (Video4Web) 

Observer 4.5 introduced Video4Web which replaced the previous Snapplet technology with a 
significantly more versatile solution for embedding cameras’ live video streams in standard web 
pages. 

Video4Web is a small embeddable JavaScript app which works on most desktop and mobile browsers. 
It provides the following functionalities: 

• Plays back MJPEG stream or JPEG image series (browser-dependent) 

• Plays single stream or users can select from the camera tree popup 

• Full screen support, with image maximize effect fallback on older browsers 

• Supports all major desktop and mobile browsers, back to Internet Explorer 6 

• Easy-to-use: no JavaScript knowledge required to embed in HTML pages 

• Small unobtrusive JavaScript app, doesn't interfere with other JS code 
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To see how to integrate Video4Web into your web pages please refer to the examples and full 

documentation available on the Observer server's web page (http://<your-server-IP>) under 
Documentation - Video4Web. 

Please note: Currently Video4Web only supports MJPEG streams. 

23.3 Controlling Observer with HTTP commands from external sources (URL 

control) 

URL control is one way to enable third-party applications to start actions via URL-encoded strings 
(send http GET request to an Observer server). The server upon receiving these special URL requests 

executes the actions as if they would have been generated internally. 

For testing purposes, you can execute URL control by entering an HTTP command in a standard web 

browser. 

http://<your-server>/arms/servlet/BrowserServlet?cmd=clientcontrol&... 

23.3.1 Available URL control parameters 

Here is a list of available URL control parameters: 

• selector.tool= name of the target tool in the client application (possible values: online_monitor, 
archive_tool) 

• selector.machine= optional IP address of the target client PC 

• selector.user= optional name of the logged-in target user (if both machine and user are 

specified then only the client application is selected which fulfills both conditions) 

Further action parameters are: 

• action.action= the action to be executed (possible values: show_live_stream, show_calendar, 

play_archive, draw_bounding_box) 

• action.cameraid= ID of camera that is involved in the action 

• action.mode= further descriptor for the action (possible values: pop_if_exists, show_as_large, 
show_in_view, show_all_cams) 

• action.fromtime= from time stamp (YYYY-MM-DDTHH:MM:SS or millisecs since Unix epoch) of 

archive playback. Should be given only when action is play_archive. 

• action.totime= to time stamp of playback (YYYY-MM-DDTHH:MM:SS or millisecs since Unix 
epoch). Should be given only when action is play_archive. 

• action.idlist= comma separated list of camera ids which we want the archive playback or want 
to place them in the current Online monitor view . Should be given only when action is 

show_live_stream or play_archive. 

• action.panelname= name of Online monitor view that should be exposed. Should be given only 

when mode is show_in_view or show_all_cams. Following conditions exist: 

o If panelname does not exist it will be created and all cameras listed in the idlist 

parameter will be placed into it. 

o If panelname exists with the cameras listed on the idlist parameter, it will be popped up. 

o If panelname exists but the idlist parameter contains more cameras as there already are 
in the view, then: 1) if we have enough view-ports to show the rest of the cameras it will 
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be shown there, or 2) if the view can not handle any more view-ports, a new view will be 

created where all listed cameras are then placed. 

• box.x0= upper left x coordinate of box (valid between 0 and 1000). The values are in 1/10th 

percentages of the displayed image. Box parameters should be supplied only when the action is 
draw_bounding_box. 

• box.y0= upper left y coordinate of box (valid between 0 and 1000) 

• box.x1= lower right x coordinate of box (valid between 0 and 1000) 

• box.y1= lower right y coordinate of box (valid between 0 and 1000) 

• box.linewidth= line width used when drawing the box 

• box.color= color of the box (possible values: black, blue, cyan, darkgray, gray, green, lightgray, 
magenta, orange, pink, red, white, yellow) 

• box.text= text which is written into the box 

• box.timeout= seconds after the box disappears automatically (0 mean click to disappear) 

Please note: URL control is only enabled for allowed computers whose IP addresses are known to 
the server (see 11.2 Setting Observer server parameters on page 109 for details). All other requests 

are blocked. 

Please refer to the Release Notes for further details or updates on URL control. 

23.3.2 URL control examples 

Create an action that brings up images of camera ID 12 in a large view on a client machine where the 

"admin" user is logged in (we assume that the address of the server to which we are sending the URL 
control is 192.168.7.2): 

http://192.168.7.2/arms/servlet/BrowserServlet?cmd=clientcontrol&selector.user=admin 

&selector.tool=online_monitor&action.action=show_live_stream 

&action.mode=show_as_large&action.cameraid=12 

Create action which draws a red box (for two seconds) onto the frame of camera ID 12 in the Online 
Monitor of the "admin" user: 

http://192.168.7.2/arms/servlet/BrowserServlet?cmd=clientcontrol&selector.user=admin 

&selector.user=admin&selector.tool=online_monitor 

&action.action=draw_bounding_box&box.x0=100&box.y0=100&box.x1=500&box.y1=500 

&box.linewidth=2&box.color=red&box.text=MD&box.timeout=3&action.cameraid=12 

Each server offers a simple test page for URL control at the following address: 

http://<your-server>/URLtest.jsp. 

23.4 Matrix View function of the Online Monitor (VIP control) 

With the matrix view function (also called VIP control) you can control, which cameras defined in a 
bigger matrix are displayed in a view in the Online monitor. 

For example, assume you have a big area covered with 50 cameras. Each of these 50 cameras cover a 
part of the overall area. The Matrix view function now allows you to position all the cameras in a huge 
virtual matrix covering the whole area: 



Netavis Observer 5.1 User Manual (February 2021) 

Page 196 of 214 

 

Now assume that in the Observer Online monitor you want to show adjacent cameras of this virtual 
matrix in a 3x3 view . Whenever you double click any of the 50 cameras in any of the views in Observer 

this camera is then positioned as the center of the 3x3 view and the adjacent cameras of the big matrix 
are automatically positioned around it. In the example above you see how the 3x3 view would look like 

if you would double click Cam24 and Cam18. 

The Matrix view function is defined by XML files sitting on the server. The name of the XML files follows 
the form server.utils.CameraMatrixMapping.<action>.xml. You start by downloading and 

editing the file server.utils.CameraMatrixMapping.sample.xml. When you are done with editing 

you upload the file under a specific name to the server. 

23.4.1 Download the XML config file 

You can access the XML file in a web browser from the server's web page: 

1. At the server's web page click on Customizer login to login to the Customizer area (the admin 

password is needed for that). 

2. In the Customizer click on Download configuration files. 

3. In the list of files find and save server.utils.CameraMatrixMapping.sample.xml to your local 

hard disk. You can do that by right clicking on the file and then choosing Save link as... from the 

menu. 

23.4.2 Edit the XML config file 

Edit the file according to your needs. A detailed description about the function can be found in the 

comment at the beginning of the file. When you are done with editing save the file under a file name 
that reflects the trigger action for which you want to enable the Matrix view. 

Possible trigger actions for the Matrix function and the corresponding XML file names are: 

 

Trigger action XML file name 

double click in a camera view port  
server.utils.CameraMatrixMapping.DOUBLE-

CLICK.xml 

single click in a camera view port  
server.utils.CameraMatrixMapping.SINGLE-
CLICK.xml 
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Trigger action XML file name 

 LNT: single click, double click, mouse over or 
context menu on a camera icon  

server.utils.CameraMatrixMapping.LNT.xml 

 

In addition to the above you can also control on which Observer clients the Matrix view function 
should be triggered. You can do that by downloading and editing the file 

server.utils.TargetActionMapping.sample.xml. 

23.4.3 Upload and activate the XML config files 

You can upload and activate the Matrix function by following these steps: 

1. At the server's web page click on Customizer login to login to the Customizer area (the admin 
password is needed for that). 

2. In the Customizer under the heading Upload configuration files click on the button Choose 
file. 

3. In the opened file dialog choose the file that you want to upload and push Open. Repeat this step 

for all files you want to upload. 

4. Uploading a properly filled CameraMatrixMapping file to the server will activate the mapping 

function. No server restart is necessary, changes become active within 10 seconds after upload. 

23.5 Holiday calendar 

A holiday calendar allows you to define a list of special days (holidays) and to modify the standard 
recording schedules of cameras for these days (enable or disable recordings). 

The holiday calendar is defined in an XML file that can be accessed via the standard server web page. 

23.5.1 Download the XML config file 

You can access the XML file in a web browser from the server's web page: 

1. At the server's web page click on Customizer login to login to the Customizer area (the admin 

password is needed for that). 

2. In the Customizer click on Download configuration files. 

3. In the list of files find and save HolidayCalendar.SAMPLE.xml to your local hard disk. You can 

do that by right clicking on the file and then choosing Save link as... from the menu. 

23.5.2 Edit the XML config file 

Edit the file according to your needs. A detailed description about the function can be found in the 

comment at the beginning of the file. When you are done with editing, save the file. 

The SAMPLE file has to be renamed to HolidayCalendar.xml. 

Please note: The holiday calendar has to be configured on camera servers (NCS). Controlling recording 

over user servers (NUS) is not supported. 
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23.5.3 Upload and activate the XML config file 

You can upload and activate the function by following these steps: 

1. At the server's web page click on Customizer login to login to the Customizer area (the admin 
password is needed for that). 

2. In the Customizer under the heading Upload configuration files click on the button Choose 

file. 

3. In the opened file dialog choose the file HolidayCalendar.xml and upload it to the server. 

4. Please restart Observer to activate settings of the holiday calendar. 

23.6 Automatic export of event statistics 

Note: Automatic exports configured in versions prior to Netavis Observer 4.7 via the XML configuration 

file (as described below) will continue to work in Observer 4.7. However if you also want to 
automatically upload these exports then you will need to remove the previous XML configuration and 
re-configure the setup in the Automatic Export tab (see 19 Automatic Export on page 181 for details). 
From Netavis Observer 4.7 onwards using Automatic Export tab is the recommended way to 

automatically export and upload event statistics, events including their parameters, and heat maps to 
Netavis sMart Data Warehouse and other 3rd party systems. The description below is only included for 

legacy reasons. 

Observer allows you to automatically export event statistics data in the format of a CSV (comma-

separated text file) that can be easily read by programs like MS Excel. The details of the statistics like 
resolution, duration and filters for event types and camera can be flexibly defined. 

The exported file will be stored in the file system of the server. This means you must have file system 

access to the server in order to obtain the file. You can do that, for example, via FTP and the admin 

user and password. Or you can mount a network drive (via Samba or NFS) and place the file there. 

The statistics export function is defined by an XML file sitting on the server. You must download, edit, 

and then upload the file in order to configure and activate the function. 

23.6.1 Download the XML config file 

You can access the XML file in a web browser from the server's web page: 

1. At the server's web page click on Customizer login to login to the Customizer area (the admin 

password is needed for that). 

2. In the Customizer click on Download configuration files. 

3. In the list of files find and save StatisticExportConfig.ACTIVE.xml to your local hard disk. You 
can do that by right clicking on the file and then choosing Save link as... from the menu. 

Please note: If there is no such file then download the StatisticExportConfig.sample.xml. 

23.6.2 Edit the XML config file 

Edit the file according to your needs. A detailed description about the function can be found in the 
comment at the beginning of the file. When you are done with editing save the file. 

If you want to access the generated statistics files via FTP, we suggest that you create the output file in 

/home/admin. If you want to put the file on a mounted network drive then use the mount location. 
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The SAMPLE file has to be renamed to StatisticExportConfig.ACTIVE.xml. 

23.6.3 Upload and activate the XML config file 

You can upload and activate the function by following these steps: 

1. At the server's web page click on Customizer login to login to the Customizer area (the admin 

password is needed for that). 

2. In the Customizer under the heading Upload configuration files click on the button Choose 
file. 

3. In the opened file dialog choose the file StatisticExportConfig.ACTIVE.xml and upload it to the 

server. 

4. Please restart Observer to activate settings of the automatic event export. 

23.7 Configuring I/O devices 

Note: I/O devices (and their corresponding actions) configured in versions prior to NetavisObserver 4.6 
via the XML configuration file (as described below) will continue to work in Observer 4.6. However if 
you want to use I/O devices with new features introduced in Observer 4.6 (e.g. Rule Administration or 

iCat Number Plate Recognition) then you will need to remove the previous XML configuration and re-
add the I/O device in the I/O Device Administration (see 16 I/O Device Administration on page 170 for 

details). From NetavisObserver 4.6 onwards using I/O Device Administration and Rule Administration is 
the recommended way to work with I/O devices and the description below is only included for legacy 

reasons. 

Netavis Observer allows you to work with I/O contacts of cameras and special I/O devices. 

The I/O device configuration is done by XML files sitting on the server. You must download, edit, and 

then upload the files in order to configure and activate the function. 

23.7.1 Download the XML config files 

You can access the XML file in a web browser from the server's web page: 

1. At the server's web page click on Customizer login to login to the Customizer area (the admin 
password is needed for that). 

2. In the Customizer click on Download configuration files. 

3. In the list of files you find several XML files that are responsible for the device configuration: 

 

XML file name Description 

server.externalIO.deviceio.DeviceMappings.xml Actual I/O device configuration 

server.externalIO.deviceio.DeviceTypeDescriptor. 

<device_type>.xml 

Device descriptor files (not intended for 

modification by you) 

 

Save server.externalIO.deviceio.DeviceMappings.xml to your local hard disk. You can do 
that by right clicking on the file and then choosing Save link as... from the menu. 
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Please note: If there is no such file then download the 

server.externalIO.deviceio.DeviceMappings.sample.xml. 

23.7.2 Edit the XML config files 

Edit the file server.externalIO.deviceio.DeviceMappings.xml to your needs. A detailed description 
about the function can be found in the comment at the beginning of the file. 

For each supported I/O device types there is a device descriptor file 
server.externalIO.deviceio.DeviceTypeDescriptor.<device_type>.xml. For configuring a device you 
must refer to one of the supported devices in server.externalIO.deviceio.DeviceMappings.xml. 

 When you are done with editing, save the file. 

Please note: The sample file has to be renamed to 
server.externalIO.deviceio.DeviceMappings.xml. 

23.7.3 Upload and activate the XML config files 

You can upload and activate the function by following these steps: 

1. At the server's web page click on Customizer login to login to the Customizer area (the admin 

password is needed for that). 

2. In the Customizer under the heading Upload configuration files click on the button Choose 

file. 

3. In the opened file dialog choose the file server.externalIO.deviceio.DeviceMappings.xml and 
upload it to the server. 

4. Please restart Observer to activate the configuration. 

Hint: For more details on configuring I/O devices please refer to the I/O Contacts White Paper available 

in the documentation section of our website. 

23.8 AXIS T8310 Control Board configuration 

Observer 4.5 added support for the AXIS T8310 Video Surveillance Control Board which consists of a 
joystick, keypad, and jog dial. These input devices can be used be used individually or combined. 

Note: Joystick-support is only available in the locally installed Observer client on Microsoft Windows 
platforms! 

23.8.1 Installation 

Follow these steps to enable AXIS T8310 Control Board support on a client: 

• Connect the AXIS T8310 Control Board to the system and wait for Windows to detect and install 

it 

• Install the latest Observer client via the corresponding option from the Observer Start page 

• Restart the client computer to complete the installation process 

http://www.netavis.net/en/support/documentation
http://www.netavis.net/
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23.8.2 Use 

The following two figures show the controls and buttons of the AXIS T8312 keypad and AXIS T8313 jog 

dial. For simplicity we have numbered the buttons for later reference. 

AXIS T8312 keypad: 

 

AXIS T8313 jog dial: 
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The functions assigned to the different buttons of the keyboards are dependent on whether the Online 
Monitor or Archive are in focus. To show the current focus press the Alt (13) + View (3) button 

combination. The focus between windows and between different tabs within windows can be 
changed forward with the Tab (1) button and backward with the Alt (13) + Tab (1) button combination. 

Below you will find a list with the assignment of the buttons in the Online Monitor and Archive: 

• Online Monitor: 

AXIS T8312 keypad 

1 - Tab: Move focus forward, or combined with Alt (13) backward 

2 - Camera: After entering numbers and pressing this button the camera whose name ends with 

an underscore (_) character followed by the entered number (e.g. Camera_212) is activated. In 

case no such camera exists an „Invalid camera: XXX” message is shown 

3 - View: After entering numbers and pressing this button the view whose name starts with the 
entered number followed by an underscore (_) character (e.g. 123_MainView) is shown. In case 
no such view exists an „Invalid view: XXX” message is shown 

4 - Activate view: Activates the first view which contains the previously assigned camera 
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5 - Activate large view: The previously assigned camera is shown in a large view 

6 - Show previous view 

7 - Show next view 

8 - Not used 

9 - Activate PTZ: In case the last assigned camera has PTZ capabilities, this button activates the 
PTZ function and the AXIS T8311 joystick will be assigned to this camera 

11 - Archive: Displays the archive view of the previously assigned camera 

10 - Administration: Displays the administration view of the previously assigned camera 

12 - Numbers: For entering digits in camera names or view names 

AXIS T8313 jog dial 

1-6: Not used 

7 - Previous/Next view: Changes to the previous or next view 

8 - Select view: The names of defined views appear on the screen upon turning the jog wheel. 

To change to the given view press the View (3) button within 3 seconds. 

• Archive player: 

AXIS T8313 keypad 

Not used 

AXIS T8313 jog dial 

1 - Not used 

2 - Marker button: Valid only when followed by pressing the Left (1) or Right (6) buttons. When 
you press the Left (1) button then the start (left) marker of the interval is positioned under the 

current position of the playback marker. Pressing the Right (6) button will modify the end time 

stamp. When the Play (4) button is pressed the video sequence for the new time interval will be 

downloaded and played back. 

4 - Play/Stop 

3,5 - Jump to the Beginning or End of the selected time interval 

7 - Not used 

8 - Move playback marker back and forth in the sample line 

• Examples: 

00123 (2) - Select the camera, whose name ends with „_00123” 

11 (3) - Select the view, whose name starts with „11_” 

23.9 SNMP Support (Simple Network Management Protocol) 

In Netavis Observer 4.5 SNMP support in Observer was enhanced so a broad variety of operating 

system and application events can be communicated to monitoring systems. Thereby failures such as 
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camera malfunctions can be detected and addressed even faster. Also events such as iCat detections 

can be forwarded accordingly. 

Note: As of Netavis Observer 4.7 SNMP support is included in the standard license. 

23.9.1 Configuration 

1. At the server's web page click on Customizer login to log into the Customizer area with the 
administration user admin. 

2. After login click on Download configuration files. 

3. Download the file server.site.snmp.SNMPMappings.sample.xml. 

Note: Here you can also download the file NETAVIS-MIB.txt which contains the 

NETAVIS MIB (Management Information Base). 

4. Edit the sample file according to the desired configuration: 

 

 

Element Description Version Options 

SNMPMappings Root element     

- Enabled "true" to enable / "false" to disable 
the SNMP configuration 

SNMPv1/2/3   

USMUser Required for authentication     

- SecurityName Security name used for generating 

SNMP notifications. 

SNMPv3   

- AuthProtocol  Authentication method SNMPv3 SHA, MD5 

- AuthPass  Authentication password 
(minimum 8 characters, also has 
to be filled in when SNMPv3 is not 

used) 

SNMPv3   

- PrivProtocol (Optional) Encryption standard SNMPv3 AES, DES 

- PrivPass (Optional) (minimum 8 characters, also has 
to be filled in when SNMPv3 is not 

used) 

SNMPv3   

Community SNMP community     

- Name Name of the community SNMPv1/2/3   

VACM SNMPv1 can be deactivated on 
demand 

    

- EnableV1 "true" to enable / "false" to disable 

SNMPv1 

SNMPv1   

Transport SNMP data     
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Element Description Version Options 

- Port Standard port of Netavis Observer 
for SNMP data 

SNMPv1/2/3   

Notification Notification options for SNMPv2/3     

- V2cIP IP address of the 
SNMP management station for the 

corresponding version 

SNMPv2   

- V3IP IP address of the 
SNMP management station for the 

corresponding version 

SNMPv3   

 

23.9.2 Activation 

Once the configuration file has been adapted, rename it to 
server.site.snmp.SNMPMappings.default.xml and upload it via the Customizer login. Afterwards the 

Observer server or at least the NETAVIS services have to be restarted for the SNMP agent to be 
activated. 

To receive the SNMP data sent by Observer a so-called SNMP management station software is needed. 

23.9.3 Available system information and Observer events 

The following system information and Observer events are available via SNMP: 

System information (available with SNMP Get / Walk via the NETAVIS-MIB): 

 

NETAVIS-MIB Name Description 

Host Table Entry 

o2HostID Unique identifier of the server. 

o2HostName Human readable name of the server. 

o2HostOSNameAndVersion Name and version of the Operating System running on the server. 

o2HostCPUIdle Percent of CPU idle time (the higher this value means the less work 
the CPU is doing). 

o2HostTotalMemory Size of the RAM in kBytes. 

o2HostUsedMemory Total number of RAM kBytes in use. 

o2HostTotalSwap Number of configured kBytes of swap space. 

o2HostUsedSwap Number of used kBytes of swap space. 

o2HostUptime The time (in UNIX seconds) since the NETAVIS server has been 
booted. 

Storage Table Entry 

o2StorageHostID Unique identifier of the server where this disk is connected to. 

o2StorageID Identifier which is valid only locally on the server. 

o2StoragePath For internal storage types it shows the device path of the partition 
where the storage is located (e.g. /dev/sda1). For external storage 
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NETAVIS-MIB Name Description 

types it shows the mount point or directory where the external 
device has been mounted. 

o2StorageTotal Total number of MBytes. 

o2StorageUsed Total number of used MBytes. 

o2StorageStatus Accessibility information. 

o2StorageType A storage can be attached to a server locally as a disk device or 

externally via SAN, NAS or any type of network mount (e.g. NFS). 

Video Platform 

o2VPID Unique identifier of the host within a distributed network. 

o2VPName Internal name of the video platform within the domain of servers. 

o2VPVersion Software version of the video platform. 

o2VPLicense Overall license information. 

o2VPStorageUtilization A percentage value telling how much of the available image archive 

has been filled up with images. 

o2VPUptime The time (in UNIX seconds) since the NETAVIS video platform has 
been started. 

User Table Entry 

o2UserName Login name of user. 

o2UserLoginStamp Unix stamp when the user has logged in. 

o2UserClientAddress Address of the login terminal. 

o2UserClientVersion Version number of the client software. 

o2UserSessionType The type of the connection via the user is connected to a server. 

Camera Table Entry 

o2CameraID Unique identifier of the camera. 

o2CameraHostID Identifier of the host where this camera is connected to. 

o2CameraName Name of the camera. 

o2CameraType Vendor and type of the camera. 

o2CameraAddress Address of the camera. 

o2CameraStatus Aggregated status information. 

o2CameraLastErrorStamp Unix time stamp of the last error. 

o2CameraLastErrorMessage Message from the camera or network for the last error event. 

o2CameraRecording Shows if a recording is scheduled to run on the camera at this point 

in time. 

o2CameraVideoAnalytics Shows if an iCat definition is scheduled to run on the camera at this 
point in time. 

o2CameraRequestedRecordingTime Length of the camera archive in hours. 

o2CameraArchiveLoadPerc Percentage telling how much of the image archive is filled up with 
images. 

Event Descriptor 
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NETAVIS-MIB Name Description 

o2EventName Short name of the event (i.e. name of concrete container class). 

o2EventNumber Netavis-internal unique identifier of the event. 

o2EventStamp Time stamp when the event has happened in seconds. 

o2EventCameraID Netavis-internal unique identifier of the camera (if event is not 
camera specific its value is zero). 

o2EventCameraName Name of the camera (can be empty if event is not camera specific). 

o2EventUserID Netavis-internal unique identifier of the user (only if event is user 
related, in other cases its value is zero). 

o2EventUserName Name of the user if event is user specific, otherwise empty. 

o2EventDescription Human-readable representation of the event. 

 

Observer events (available with SNMP Trap): 

 

Observer Event Description 

AgeGenderDetection Event generated when a face with age and gender estimation is 

detected.  

ArchiveAccess Event generated when archive is accessed. 

BaseDataChange Event generated when configuration data (system, users, cameras, 
iCat definitions, etc.) is changed. 

CameraAuthenticationFailure Event generated when a camera can't be accessed due to a wrong 
user / password configuration. 

CameraIOStateChange Event generated when a camera's I/O contacts are changed. 

CameraPTZChange Event generated when a camera's PTZ position changes. 

ConnectionLostToHost Event generated when the connection to the host is lost. 

ConnectionRestoredToHost Event generated when the connection to the host is restored. 

ConnectionToCameraLost Event generated when the connection to a camera is lost. 

ConnectionToCameraRestored Event generated when the connection to a camera is restored. 

CustomEvent Event generated when a CustomEvent occurs. 

DegradedImageSaving Event generated when the recordings are degraded. 

DiskSubsystemFailure Event generated when a hard drive has failed. 

FaceDetection Event generated when a face is detected. 

GUIControlChange Event generated when changes are made to the client's interface. 

ImageExportEvent Event generated when archive recordings are exported. 

InCameraDetection Event generated when an in-camera motion detection occurs. 

InverseTrafficEvent Event generated when Wrong Way Traffic is detected. 

MotionDetection Event generated when a motion detection occurs. 

PlateNumberRecognition Event generated when a number plate is detected. 

RecordingSwitchedOff Event generated when a recording is stopped. 

RecordingSwitchedOn Event generated when a recording is started. 
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Observer Event Description 

SMSSendError Event generated when an SMS notification can't be send. 

StoppedVehicleEvent Event generated when a Stopped Vehicle is detected. 

TrafficStateChange Event generated when a Traffic State change is detected. 

UserEventACK Event generated when a user acknowledges an event. 

UserLoggedIn Event generated when a user logs in. 

UserLoggedOut Event generated when a user logs out. 

VideoContentAlert Event generated when an iCat Object Tracking detection occurs. 

VideoSignalLost Event generated when the video signal from a camera is lost. 

VideoStreamAnnotation Event generated when a video stream annotation occurs. 
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limiting overall outgoing bandwidth of server  

113 

support for low bandwidth via Transcoding  

27 

C 

Calendar in archive  73 

Camera 

access rights for users  50 

duplicate existing camera with similar 

settings  40 

dynamic privacy mask  163 

groups  42 

moving in camera tree  43 

port mapping on video server  43 

privacy mask  157 

sabotage detection  153 

setup  31 

status  41 

status display (LNT)  140 

video analytics (iCat)  142 

Camera server (NCS)  117 

Camera tree 

drag and drop cameras  55 

how to work with it  55 

positioning in the window  17 

CIF  10 

Client 

installation directory for client components  

15 

introduction  11 

locally installed  12 

multi-window/multi-screen operation  17 

overview of components  20 

preferences  19, 20 

starting  12 

support for low-bandwidth connections  27 

Clone camera  40 

CPU load 

and streaming formats  8 

display of server CPU load  107 

for video analytics (iCat)  145 

Cropped view ports 

define which part to display  59 
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D 

Data integration with external applications  

193 

Data security  7 

Deleting windows  18 

Demo mode license  11 

Distributed upgrades of servers  122 

DivX exporting from recordings  80 

Documentation set  6 

Drag and drop 

camera from the camera tree to view ports  

55 

Duplicate existing camera  40 

Dynamic privacy mask (iCat)  163 

Dynamic views (view ports)  64 

E 

Email 

receiving on events and alarms  98 

Encryption 

AES encryption of video recordings  113 

general description  7 

HTTPS for camera connections  34 

HTTPS for client connections  12 

HTTPS for server-server connections  119 

Event triggers (iCat)  144, 150 

Events  92 

acknowledging  93 

automatic export of statistics data  198 

details  93 

Event list  92 

create a separate Event list window  17 

maximizing  17 

modifying layouts  17 

positioning in the window  17 

priorities  92 

sorting  92 

exporting event-related recordings  96 

HTML export  96 

in layout navigation  139 

notification via client GUI, email, SMS  98 

priorities  92 

remote servers  121 

searching in the event database  94 

short replay  93 

statistics  97 

statistics data automatic export  198 

user privileges for accessing and handling  92 

video analysis (iCat)  169 

Exiting the client  28 

Export of event statistics data  198 

Exporting archive recordings  79 

event-related  96 

External applications 

control via HTTP commands  194 

external archive, see NEA  83 

F 

Floating window components  17 

Four-eyes principle  44 

Four-eyes-principle  46 

G 

Getting started  29 

H 

H.264  7, See also MPEG 

HDTV 16/9 

aspect ratio in Online monitor  54 

Heat maps 

iCat Heat maps  166 

Heat maps (iCat)  166 

Holiday calendar  197 

HTML code for embedding streams in web 

pages  193 

HTTP commands for starting actions  194 

HTTPS encryption 

between servers  119 
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for camera connection  34 

for client connection  12 

general description  7 

I 

I/O contacts 

configuring I/O devices  199 

placing them on LNT layouts  131 

I/O devices 

configuring  199 

iCat  142 

considerations for setting up  144 

CPU load  145 

dynamic privacy mask  163 

event triggers  144, 150 

events  169 

Heat maps  166 

object bounding boxes  166 

object counting  150 

object markers  165 

object tracking region  144, 147 

people counting  150 

privacy mask  157 

sabotage detection  153 

SAFE export  81 

sensitivity setting  148 

Smart Tripwire(tm)  150 

starting and stopping objects  152 

video processing speed  145 

video streaming formats  144 

working with in Online monitor  165 

In-camera motion detection  89 

IP address 

of camera  33 

iPad  21 

iPhone  21 

J 

Joystick 

AXIS T8310 Control Board configuration  200 

Joystick control for PTZ cameras  104 

JPEG 

aspect ratio  10, 34 

exporting from archive  79 

image sizes and quality  10 

MJPEG vs. MPEG  7 

L 

Layout navigation  128 

editing mode  129 

I/O contacts  131 

installation  128 

navigation and operation  138 

zones  132 

Layout of windows 

modifying  17 

LDAP  53, 124 

License 

displaying current license  108 

license string  11 

Login 

secondary password  44 

the locally installed client  12 

Low-bandwidth connections with Transcoding  

27 

M 

Manual recording control in the Online 

monitor  59 

Matrix View function (VIP control)  195 

MJPEG  8 

versus MPEG streaming  9 

Mobile devices, PDAs  21 

Monitoring  203 

Motion detection  86 

in archive  81 

in-camera  89 

server-based  86 

Motion JPEG  8 

MPEG  7, 8 

versus MJPEG streaming  9 
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working with cams  64 

MPEG-4  7, See also MPEG 

Multi streaming (parallel video streams)  8 

Multi-screen operation  17 

positioning windows  18 

Multi-window operation  17 

MxPEG  7, See also MPEG 

N 

NCS camera server  117 

NEA external archive 

accessing archives at another server  85 

Displaying status  84 

recording on removable storage devices  83 

starting and stopping double recording  85 

NETAVIS_DIRECTORY environment variable for 
installed client components  15 

New system setup  29 

Notification on events and alarms  98 

NTSC  10 

NUS user server  117 

O 

Object bounding boxes (iCat)  166 

Object counting (iCat)  150 

Object markers (iCat)  165 

Object tracking region  144 

Online monitor  54 

Archive Access  64 

creating views  54 

defining views for new user  52 

dynamic control with the Matrix function (VIP 

control)  195 

manual recording control  59 

navigating in the  56 

view settings  57 

working with iCat  165 

zooming in a view port  59, 76 

Online Monitor 

dynamic control with iCat and motion 

detection  64 

Overlay painting  16 

P 

PAL  10 

pan, tilt, zoom  100 

Password 

changing  53 

PDAs (mobile devices)  21 

People counting (iCat)  150 

Playback of archive recordings  73 

Port mapping 

of analog cameras on video server  43 

Preferences of the client  20 

Priority 

of events  92 

sorting event list  92 

Privacy mask (iCat)  157 

Privileges of users  47 

Protect archive recordings against deletion  79 

PTZ (pan/tilt/zoom)  100 

automatic routes  105 

control with motion detection  88 

controlling camera  101 

joystick control  104 

routes  100 

user priority  46 

Q 

QCIF  10 

Quitting the client  28 

R 

Recording  72 

AES encryption of video recordings  113 

Audio playback  78 

calendar  73 
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DivX export  80 

exporting  79 

exporting event-related recordings  96 

holiday calendar  197 

manual recording control in the Online 

monitor  59 

motion detection in  81 

on removable storage devices, see NEA  83 

Playback  73 

programming  72 

protection against deletion  79, 114 

SAFE format export  80 

storage management  72 

synchronous playback of mutiple cameras  

78 

time zoomimg  77 

Release notes  6 

Remote servers 

events  121 

monitoring  121 

upgrading  122 

Restarting and rebooting  109 

Round tours  61 

RTSP streaming port  113 

S 

Sabotage detection (iCat)  153 

SAFE format archive export  80 

SAFE Player 

iCat information  81 

Playback  81 

Zooming  81 

Screen resolution 

minimum for running the client  11 

Secondary password 

for login  44 

Security  7 

Sensitivity setting (iCat)  148 

Server 

administrating  107 

information about running servers  107 

load display  107 

network 

camera server (NCS)  117 

user server (NUS)  117 

setting parameters  109 

Setup of a new system  29 

Smart guard function  61 

Smart Tripwire (iCat)  150 

Smartphones (mobile devices)  21 

SMS 

receiving on events and alarms  98 

Snapplet, embedding live video streams in 

web pages  193 

SNMP  203 

Statistics 

events  97 

Storage management in archive  72 

Streaming formats  7 

iCat video analytics  144 

Synchronous playback of mutiple cameras in 

archive  78 

T 

Time zone of server  110 

Time zoomimg in archive  77 

Transcoding for low-bandwidth connections  
27 

setting up  112 

Tripwire for object counting (iCat)  150 

U 

Upgrading 

remote servers  122 

URL control 

allowed IP addresses  112 

control from external applications  194 

User server (NUS)  117 

Users 
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Active Directory/LDAP  53, 124 

adding  44 

camera access rights  50 

copying view between  62 

Four-eyes-principle  46 

groups  52 

info about logged in  52 

managing  44 

privileges  47 

V 

VGA  10 

Video analytics  142, See iCat 

video annotations  193 

Video compression  7 

MPEG vs. MJPEG  7 

Transcoding for low bandwidth connections  

27 

Video walls  188 

configuring the control application  191 

controlling with Observer  190 

operating with the control application  192 

setup  188 

View ports 

creating  54 

define crop view  59 

dynamic event-based control  64 

zooming camera views  59, 76 

Views 

copying between users  62 

dynamic event-based control  64 

Online monitor  54 

optimizing big views after double click  57 

round tours  61 

settings  57 

VIP control (matrix view function)  195 

VWCA (video wall control application)  190 

W 

Web pages 

embedding live video streams  193 

Windows 

create a separate Event list window  17 

deleting  18 

modifying layouts  17 

Z 

Zones in layout navigation (LNT)  132 

Zooming 

in an Online monitor view port  59, 76 

in SAFE exports  81 

of PTZ cameras  103 

 


